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NOTICE

GCC reserves the right to modify the information contained in this user
manual at any time without prior notice; un-authorized modification, copying
distribution or display is prohibited. All comments, queries or suggestions
concerning this manual please consult with your local dealer.
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Safety Measures

Before you start installation, please read below information carefully to avoid potentially hazardous
situations.

General safety

Use the voltage of the power source is identical to the voltage of the machine to prevent any damage
or failure.

Make sure that the plug is fully inserted in the power outlet. Do not use outlet that is loose.
Do not touch the machine during a lightning storm.

Do not overload the power cord.

Do not place heavy objects on, or damage the power cord or plug.

Do not forcibly bend or pull the power cord.

Do not allow the machine / AC adapter / power plug to get wet, for example, by handling them with
wet hands or spilling beverages onto them.

Disconnect the AC adapter and stop using the device if you notice abnormal odor, heat, discoloration,
deformation or anything unusual while using it.

Operating precaution

Avoid environments where the machine is exposed to high levels of dust, temperature (temperature
exceeding 30°C or 85°F) or humidity (humidity exceeding 75% or where the ambient temperature is
near the dew point).

Keep the working area stable and avoid sever vibration.

Do not use or store the product is exposed to direct sunlight, water or oil splashes, salty air or
saltwater, dust or humidity, flammable gas and strong air current.

Select a location that is large enough to accommodate the machine.

Do not touch the paper sheets and moving parts of this machine during operation. Also be careful to
make sure that clothing and hair do not get caught.

Do not apply force or object weights on the moving arm.

Be sure to grasp the plug, not the cable, when disconnecting the power supply from an electric form
an electric socket.
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[Important Information]

e For safety concern, please always hold the cutter firmly from the bottom while moving it. Do not
move the cutter by clasping the depression area on both sides.

O (Correct)
Hold from the bottom

e Do not shake or drop the blade holder, a blade tip can fly out.

e During an operation, do not touch any of the moving parts of this machine (such as the carriage).
Also be careful to make sure that clothing and hair do not get caught.

e Always connect the power cable to a grounded outlet.

e Always use the accessory power cable which is provided. Do not wire the power cable so that it
becomes bent or caught between objects.

e Do not connect the power cable to branching outlet to which other machines are also connected, or
use an extension cable. There is danger of overheating and of mis-operation of the machine.

o Keep the tools away from children where they can reach.
e Always put the pinch rollers within the white marks.
[ Note)

The following situations will automatically turn on the buzzer alarm and rings for 3 seconds:

1. Fail to load the media into cutter for three consecutive loading.
2. Paper jam after sizing

3. Paper feed errors when running out paper

4. Motor crashed

5. Fail to detect the registration mark
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Warning
AFJ (Jaguar)

o Never press the top release grip and pull the bottom release grip at the same time as the pictures
shown below:

O (CORRECT) X (INCORRECT)

Press down Press down

Note:

In case the grips clipped together due to
the wrong operation, please use a pair of
tweezers to pull out the stop bar when

pressing down the top release grip. Keep

the stop bar outside then release the grips
as the right figure.

Pull up bottom to
release grip

Warning

ENABLE
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GCC...

Necessary work space

Prepare a working table that accommodates your Jaguar V 61 LX with auto feeder. The required working
table should be larger than 1,050 mm in width, 842 mm in length and 420 mm in height.

Prepare three outlets for your Jaguar V 61LX, auto feeder and your computer.

1080mm

)

A

T ] et

792mm

9350mm

o1

%0

700mm .
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Chapter 1 General Information

1.1 Introduction

In combination of a cutter and an auto sheet feeder, AFR-24S provides the advantage of creasing
function with dual tool holder up to 600gsm cutting force and 1,530 mm/s cutting speed in the digital sheet
feed solution that can crease and cut at one time sheet by sheet instead of manually operation to
optimized process with versatility capability for short run production that simplifies your operation through
automatic working procedure and create maximum profit in sampling, folding carton packaging,
customization cards, labels and stickers.

1.2 Package Items
The package of the cutter and Auto Feeder content the items listed below, please check carefully. If you
find any item missing, please consult your local dealer for further assistance.

Machine Standard Item Quantity

1. Cutting Plotter 1 unit

2. Flexible Media Support System Package
2 x Roll Media Flange

2 x Roll Holder

4 x Roll Holder Guide Bushes

2 x Roll Holder Support

1 x M6 L-shape hexagon screw driver

1 x Installation Guide for Roll Holder 1 set
1 x M5 L-shape hexagon screw driver
2 x Desktop Support Brackets

4 x Plastic Foot

4 x M4 screws

12 x M6 screws

1 x M4 L-shape hexagon screw driver

10



Gccw AFJ-24S User Manual

3. Accessories

1 x AC power Cord

1 x User’'s Compact Disk

1 x data cable (USB cable: 3m)

1 x Blade Holder Assembly (Installed in tool carriage of the cutting plotter)
1 x Blade (Installed in Blade Holder)

1 x Safe Blade

1 x Cutting Pad for Vinyl cutting

1 x Tweezers

1 x Promise Card

1 x Ethernet cable

1 set

Item Q'ty Photo

Auto Feeder 1 unit

Auto Feeder Accessories

Media collection tray 1 set L
]

Left & Right connecting {

Thumb screw 2 pcs ﬂ

Screw 4 pcs ‘

Power cable 1 pc ‘

11




GCC...

AFJ-24S User Manual

RS232 cable 1 pc
Installation guide 1 copy %
Media blocks 2 pcs

TR
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1.3 Machine overview
1.3.1 Auto Feeder overview

Blower

Media pick

Serial Interface
Connector
(RS232Q)
Media block
Media stack
Item Function

Serial Interface

Used to connect a feeder to a cutter through a serial interface

Connector (RS232C) (RS232) cable

Media block Adjust the media to a proper position.

Media tray Stack the media for later use.

Blower Blow air to separate the media and avoid double feeding.
Media pick Separate the media to avoid double feeding while loading

sheet media to a cutter.

13
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Suction cup

Power switch

Power port

Media collection tray

Item Function
Power port A socket for power cable.
Power switch Switch the Auto feeder on and off.

Adjustable media
collection tray

Collect the cut media after completing the job

Stretchable stand

Extend the stand to reach the ground to support the media

collection tray

14
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1.3.2 Cutter overview

-

Power Port

Fuse

Power Switch

Item Function
Power Switch On when switches to [I]; Off to [O]
Fuse 3 Amp
Power Port A socket for power cable.

USB Connector

Ethernet Connector

Serial Interface
Connector (RS232C)

Item Function

Serial Interface Used to connect the cutting plotter to a computer through a
Connector (RS232C) serial interface (RS5232) cable.

Ethernet Connector Used to connect your cutting plotter to a local area network

Used to connect the cutting plotter to a computer through a

USB Connector USB cable

15
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1.3.3 Appearance of Cutter

Grid Drums - move the
media back and forth
during operation.

Platen - provides the
surface for holding and
supporting media while
performing cutting.

Alignment Rulers -
media can be aligned
with the clear guide line
marks.

Lever -

Raise or lower the
pinch rollers.

Pinch Rollers -

Hold the media during
cutting.

Tool Carriage - performs the
cutting with the installed blade

and pen with AAS module.

Control panel - consists of 14
control keys and 1 LED and 1 LCM
showing messages and menus.

Cutting Pad - provides
the protection of blade
when the blade is
cutting.

16
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Chapter 2 Installation

The following instruction will lead you how to install and operate in the regular plotter (RXII-61 Creasing)
and AFR separately.

2.1 Connecting your GCC cutter

The cutting plotter communicates with a computer through a USB (Universal Serial Bus), a Serial port
(RS-232C) or Ethernet. The following section shows you how to connect the cutting plotter to a host
computer and how to set up the computer/cutting plotter interconnection.

Note:

1. When USB connection is enabled, serial port will be disabled automatically.

2.1.1 USB Connection
1. Turn on the machine.

2. Connect the USB connector to the machine and then USB driver will be installed automatically. It
will take a few minutes to find the device. Please DO NOT disconnect the USB cable until the
installation has completed.

3. You can double click the USB icon on the taskbar to make sure the USB device is detected

*ML Your device is ready to use % X
~' Device driver software installed successfully.

2.1.1.1 Driver Installation

Use the USB One-click Installation for quick driver installation. Follow the simple steps below for driver
setup.

v' If you are using Windows 7 and above as your operating system, make sure
you log in using the “Administrator” account.

IR Visit GCC website and go to “SUPPORT” page to download the user manual, driver and software
(https://lwww.gccworldnew.com/download.php).

ABOUT  APPLICATIONS ~ PRODUCTS ~ SHOWCASE  SUPPORT ~ CONTACT  CAREERS

KCWV\- S

Innovation wi¢ « #om

Buyer's Guide

Tech Support
GCC Club

17
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HTE You may use search function or directly click the product category to choose the model you want.

Download Area v

Download Area

enter keywords to search Q SEARCH

Or browse by machine model

Vinyl Cutter Laser Engraver Laser Cutter

§

Laser Marker UV Inkjet Printer Digital Finishing Equipment

18
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Digital Finishing Equipment Digital Finishing Equipment ~

DFS LabelExpress DecalExpress DecalExpress-ECO

AFJ-24S AFR-24S JV-240UV

Download the driver according to the type of connection.

Software 4
Product Brochure 4
o= F]
Title Size Download

Cutter COM Driver_V2.21-03 1.2MB Download
Cutter ETH Driver_V2.21-03 1.2MB Download
Cutter USB Driver_V2.21-03 1.2MB Download
User Manual 7*

19
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S1CTeE Unzip the file and double clip the driver.exe to start installing the Driver and AAS plug-in.

|| nstalling
RN

- Curent

Capyina file:
L\ Aepstem3ZigootemphaASPIug\Microsoft VCS0.CRT \msveman.di

Al

Time Remaining 1 minte 0 seconds

[ L]

iee Installation

<ok | om

X If you were Windows 7 and above users, please click on the red words to instruct you how to
disable Windows Update to allow success driver installation. And then click OK to next step.

[ -._

Windows 7 and above users please fol

step by step instructic

to disable Windows Llpdate to allow su
driver installation.

Tl o ama

X Please make sure the cutting plotter is powered on and connected to the USB device, and then
click OK to next step.

Flease make sure the cutting plotteris powered on Please make sure the cutting plotter is powered on
and cannected to the USE device. and connected to the USB device

o] o ]

EEXE Confirm to close all running application programs before you start installing the driver, and then
click OK.

e

Itis strongly recommended that all running application programs
are dosed before you start instaling the driver.

Lo ]

[ 20 L
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B1CTek: If you want to install AASII VBA on CorelDRAW and Adobe lllusatrator, exit CoreDRAW and
Adobe lllusatrator program, and then click on“Install.”

% occ stiaie 22 L

Welcome to the installer for AAS Il VB¢
CorelDRAW version 11 1213141516 17
Adobe lllustrator CS3 CS4 CS5 CS6

It is strongly recommended that you e
CorelDRAW and lllustrator program be
continuing

HTE Check Install Message to confirm CorelDRAW and Al version and then click OK.
[T

| corel Message
Install CorelDRAW 17.0 GCCAASTI Draw.gms successful

AI Message
AT Plug-in not find

Note:

(1) If the driver is being installed for a second time, the user will be prompted as to whether a second
copy of the driver installation is required.

GCC Driver Installation [

The RXII-1325 driver installed
Do you want to add an attachment?

(2) If the user selects yes, a second copy of the driver will be installed.

GCC Driver Installation i _@

Add RXI-1325_1 Printer driver Successfully

(3) For users who have upgraded Adobe lllustrator or CoreDRAW, please go to the AAS Installer page
in the Printer Properties window and click “Install” to access the latest version of GCC AAS Plug-in.

21
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: —

| General | Shaing | Fois | Advanced | Color | Secuity | options
| | AAS Installer

Pen Paper

GCC AAS Installer

Press the "Install" button to begin the
installation process

e

2.1.1.2 Driver Un-installation

You have to remove previous version driver installed on your PC system completely before you can install
the latest version successfully. Please refer to below steps.

EX] Go to Control Panel\Hardware and Sound\Devices and Printers window. Right click the printer and
select “Remove device.”

. @ » Control Panel » Hardware and Sound » Devices and Printers w | 43 [l Search Devices and Printers pel
Add a device Add a printer See what's printing » Manage default printers Print server properties 2 =l - @
b Devices (2)

4 Printers and Faxes (11)

*
4F gqe i Adobe PDF Bullzip PDF Fax e y |icrosoft XPS
_KYOCERA Printer >cument Writer
ES20250 KX on Printing preferences 3
gpprinter Printer properties 4
2

Delete print queue

i / Create shortcut
Q’ _‘g’ T2
y:

l@ﬁz OneNota RXT-1015 Remove device

./ Are you sure you want to remove this device?

=

RA¥II-1325

22 L
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¥ After removing the unit, click on any printer on the page and select “Print server properties.” (For
Win 7 and above) or right click on blank space and then select “Print server properties.” (For Windows

XP)

57 % » Control Panel » Hardware and Sound » Devices and Printers - L

Add a device Add a printer See what's printing Manage default printers Print server me\a:has Remove device = - @ |

& Devices (2) I

l| « Printers and Faxes (10) |

AF B HH Adobe PDF Bullzip PDF Fax Graphtec CEG000 i-Craft Microsoft XPS
_KYOCERA Printer Document Writer
F$-2025D KX on
gpprinter
MUTOH_YC-1300 RXI-1015 {BiZE OneNote
2010

BICTe ! Select “Driver” page

e T
— |

Forms |F‘orts IDﬁvaﬁl.S'ec:_rityIM\rancedl

Forms on: MARKET-EILEENC

Delete |
10:14 S —

11x17 ——
11:47 Save Form |

Farrm narme: 1011

Create a new form

Define a new form by editing the existing name and
measurerments, Then click Save Form,

Form description (measurements)

Units: @ Metric (2) English

Paper size: Printer area margins:

Width: Left Top:
Height: Right: Bottom:

’ @ Change Form Settings ]

l Close I| Cancel

[z L
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Y Select the model and click on “Remove”.

e L

d

MARKET-EILEENC

Installed printer drivers:

| Forms I Parts || Drivers ||Secunty | M\ranced|
| S |

MName Processor
Adobe PDF Converter xB6
Bullzip PDF Printer 4
Bullzip PDF Printer xB6
Graphtec CEG000 *B6
HP Color Laserlet 2800 5...
i-Craft *B6
Microsoft enhanced Poi...  x86
Microsoft XPS Documen...
MUTOH_VC-1300

RXII-1015

RXI-1325

RXI-1325_1

- User Mode
- User Mode
- User Mode
- User Mode
- User Mode
- User Mode
- User Mode
- User Mode
- User Mode
- User Mode
- User Mode
- User Mode

[

Add... I [ h Remove..

Properties

’ @ Change Driver Settings ]

K Select “Remove driver and driver package” and click OK.

T

Do you want to remove the driver(s) only, or remove
the driver(s) and driver package(s) from your system?

(Z) Remove driver only.

@ Remove driver and driver package.

Cancel

HTXE Click Yes and then click “Delete” and “OK,” and the driver installed on PC is completely removed.

£

Deleting this printer driver package will
remove it from the system. Are you sure
you want to delete RXII-1325_17

Yes ,\_]l [ No

[ 24 1
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Driver package information collected. Driver package deleted.

The following driver(s) will be deleted: - §| Driver RXII-1325_1 was removed.

RXII-1325_1 (x86)

2.1.2 RS-232 Connection
B Connecting to the RS-232 (Serial) Port

1. For IBM PC, PS/2 users or compatibles, connect the RS-232C cable to the serial
connector of the assigned serial port (COM1 or COM2) of your host computer.

2. Set up the communication parameters (Baud Rate and Data Bits/Parity) to match the setting of
software package, refer to chapter 3 — “Misc” key description.

Caution!! Please turn off the plotter before plugging the RS-232C cable

2.1.3 Ethernet Connection
A) Networking Connectivity Setup

T ¥ Connect the LAN port and Ethernet port on GCC cutting plotter with RJ45 Ethernet cable, and
turn on the machine.

25
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¥ Press On/Off line and then MISC button on your control panel.

POWER

SPEED FORCE OFFSET

O O O

TOOL SELECT DATA CLEAR CUT TEST

(BT T

PAUSE / RESUME ENTER

O O

BICTe g Go to the DHCP page and select Enable through the up and down arrow keys, then press Enter.
— S—

X The IP Address will be shown on the screen automatically. Please make notes of it.

B) Ethernet Connectivity Setup

There are two ways to output your plot through Ethernet. If you output your plot through GreatCut, please
follow the instruction I. Output through GreatCut; if you output your plot through Adobe lllustrator or
CorelDRAW, please follow the instruction Il. Output through the Ethernet Driver.

I. Output through GreatCut]

Instruction of Ethernet settings for GreatCut:

26
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TRl Open GreatCut and create a new file and cutting line.

== GreatCut 3 - [-Crof = B job ] -
5o sz031 )
= 20 100 0 00 20 0 0 50 %0 70 %0 %0 001
Ex )| se e I &
B I -
3 0 —
By
s 0 —
A= % —
o m—
s
1 o
o0 —
g i 3
3 0 —
e —
] (3] b m—
0. —
e 0 —
= 0, m—
0 —
o0 m—
3 0 —
o —
s o m—
o m—
s
1 o m—
o m—
Wl s snssesanpdir e s to e p et i e R ne e e me s aae e s sves st -3
] 0 I—
[ = e I

¥ Go to Output Devices under Settings.

b *]

= GreatCut 3 - [I-CraftiE & E.jol
® File Edit J

Miscellaneous... Ctrl+)

Standard Settings

Mouse...
Color Palette 3 I}

Output Devices...

Working Area... Qutput Parameters...

Register / Jog Marks...
Filter...
Unit of Measurement L3 RIP...

Rulers... Shift+1

Profile...

—

Shift+F7

Choose Language...

I

S1CT R Select a model at Driver in Setup Device window
Setup Device [EER

Commar:
Device name Driver:
GCCRxA01S GCC R¥1015 -
8e 7] Riun as Plot Sever (137 GCC Puma SP 60 i
Device Types: SCCRA-1325
Local Forts: )
GCCRX-1835 D
oM/ ) [s¢Plesses| BCCRX-61
X . GCC Sable SB-60
USE / Fireire Devices: GCC SignPal LYNX 5-1325 il
use/ -
FirgWw/ire
TCP /1P

TCR/IP @ 192 . 167 . 100 . 170 Pert 9100 -
Spooler

Spooler | 777 OneMate 2010

P2 —



GCC...

AFJ-24S User Manual

Y Input the IP address you had acquired from the control panel to the TCP/IP. Click OK to complete

settings.

Setup Device

(2 it

Commar

Device name

GCC Rx-1015

Device Types:

Local Ports

8= [| Bun as Plot Server (192.168.100.137)

Diriver:

GCC Rx-1015 -

COM/S

pr @ [<< Please select »>

= l [ Settings...

USE / FireWire Devices:

USE/
Firehie

TCP/IP,
TCR/IP @ 192
S pooler

Spooler ©

27 OneMote 2010

167 . 101 . 170 Part 9100 -

Setup - Output Devices

Current Qutput Device

BCC RX-1015

Driver: GCC RX-61
File: C\Program Files\GCC\GreatCut S\cutter\GCcRXECD
Port: 192.167.101.170

Wode: [Cut -

Hsteriat:[Foi -

Defautt Settings

[Tl Keep reference point ‘Weed border: 200 mm
[ wait after segment [} Overlap:  0.00 mm
Sort before output Copies spacing: ~ 0.00 mm
[Pt to file Segment spacing:  0.00 mm
[T] Read out automaticaly Stackspacing:  0.00 mm

[] Output only took-assigned layers [ No tooltips.

Enable output for objects larger than page size

oK S [ cancer | [ nmoy

[ 0K ;\J[ Cancal ]

AT Go to Output under File to check the settings.

Output to device GCC RX-1015 B~
) Output
E Device: [GCCRXATIS - Number of outpts: 1 Output only tookassigned layers
New... Ctrl+N L1 Boum e
[1] ] Sort before output
~ o e B .
Qpen.. CrlsL 1 Elriotto e
M save ChrlsS Copies spacing:  0.00 mm
Manage Profies Seqment spacing:  0.00 mm (] Wat after segment
Save As... Shift+Ctrl+S
0 100
mm !
N S 5= by Email- Parameter vaiue
——— Pressure [g] B
Import... Ctrl+1 E 1 108
aterit it (] e
] 3 Length (rm) 2000000
b -
Figest ot Cutoft ofr
= AutoCutDist [rm) s
&y print... Ctrl+P step count !
A ouit Ctr+Q
o
8
™ Accuracy: (Nomal______v]
] I orgn: [Newoign _~]
e | Ojects: Allobicts -
: | |
g o
&7 4
| %
— . Fesirmiem ]

Complete the driver installation process and your GCC Cutting Plotter is now allowed to network.

Note: If you want to add new local device, please go to Output Devices under Settings, and press the
button on the right of Current Output Device and select Add local device (if the device has been
installed but you wanted to output through another device, please select Change to set the IP

address of another device).
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Current Output Device

GCC RX-1015 Add local device...

Driver: GCC RX-61

File: C:\Program Files\GCC\GreatCut J\cutter\GeeRX ECD Change...

Delete

Port: 192.168.101.170

Mode: [Cut -

Waterial: [ Foil v]

Default Settings

[] keep reference point Weed border: 200 mm
|| watt after segment [ Overiap: 000 mm
Sort before output Copies spacing: 0.00 mm
[T Piot ta file Segment spacing:  0.00 mm
[”] Read out automatically Stackspacing:  0.00 mm

D Output only tool-assigned layers D No tooltips

Enable output for objects larger than page size

l. Output through Ethernet Driver]

Connect to Plot Manager...

ETE Connect Ethernet cable to PC and install Cutter Ethernet driver. Then click OK to continue.

IP Address Acquisition

Control Panel
MISC = DHCP = Enable

Flease acquire the IP Address of your PC followir
step by step instruction

rouwill be requested to enter this address on the
Confiquration pace in the following stens.

HT ¥ Enter the IP Address shown on the control panel and select the model. (Please refer part 1

instruction.)

-

TCP/IP Configuration

This setup allows you to configure your TCP/IP port

IP Address: 192 ] 168 . 1

Model: RXI-1325 -
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S1CTeR] The driver is installed. You can output from Al or CoreIDRAW directly now.

-

GCC Dnver Installation

. The RKI-1325 driver installed
;:I___\_, Do you want to add an attachme

2.1.4 Data Transmitting
There are two options to transmit the data from the computer to the cutting plotter:

Option 1: With proper interface settings, the data can be transmitted from your application software
package to the cutting plotters directly.

Option 2: Most cutting software packages are able to emulate HP-GL or HP-GL/2 commands. As long as
the file is HP-GL or HP-GL/2 format, the cutting plotter can output the data precisely.

2.1.5 Printer Sever Shared Setting
In “A-PC”, set the printer driver as a shared printer, then use B-PC to connect A-PC’s printer driver via
Intranet.

A-PC B-PC

et .

A

USB or COM Port = \_“_‘w
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ETTE] Set A-PC’s printer driver as a shared printer (Right-click on printer icon, choose “Printer
properties”. Click “Sharing” tab then check “Share this printer.”)

| Gen | Sharing | Pa | Advanced I Color Managemert I Security I Option

./ Youcan share this printer with other users on your network. 1
| f A ¥  printerwill not be available when the computer is sleeping or
? 2 43 off.
gA — £
See what's printing
Benc :
—_— Set as default printer
[7] Share this printer
Printing preferences I -1
Printer perEl’tlES [¥] Render print jobs on client computers
Create shortcut [ List in the directory
i Troubleshoot Dicers:
- I this printer is shared with users running different versions of
E Remove device Windows, you may want to install additional drivers, so that the
users do not have to find the print driver when they connect to th
la gua shared printer.
Properties : . .
Additional Drivers...

¥ Click “Advanced” tab, then choose “Print directly to the printer” option.

Bengal-680 Properties

General | Sharing I lorts MVE[+Ed |Co|or Management ISecmty I Opti

@ Always available

) Available from 12:00 AM ~ Ta 12:00 AM
Priority: 1 =
Diriver: [Eengal—ﬁo v“ Mew

£ Speslprint-dacumantesapengram finishes printing faster

—

Start printing after last pgge is spooled

(@ Start printing immediately

@ Print directly to the printer‘;

["THold mismatched documents

BiETe] Send a job from A-PC to the machine to check if A-PC is connected to the machine.

¥ CorelDRAW 11

S| CorlDEAW X4 (2

L P IR

Expert 24 LI

Try to send a job to
check if the port is
working.

VI S
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Y Activate A-PC’s Printer Driver from B-PC’s Network.

4 € Network T
i (M8 ADMIN-ANITAY! "JJ Bengsl-6
i (B ADMIN-ELAIN

b (8 ADMIN-HR I::> W
& 8 ADMIN-JULLA = Jaguarl¥
> {8 ALBERTTHINK @.

b (8 CBA030003

b (8 CBADS0033
b (M CBADSO019

LomE s s e s

HTE Right-click on the printer icon, and select “Connect” to A-PC’s printer.

7 =
. 0 Connect...

i Create shorteut
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2.2 Auto feeder installation

1. Assemble the right and left connecting brackets on both side of the auto feeder with screws to fix
the auto feeder to Jaguar V/RXII.
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4. Push the side brackets to closely lean against the cutter, and then tighten up the screws.

5. Loose the screw on the rear platen.
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7. Assemble the stretchable stands

8. Hang the media collection tray onto the connecting holder and tighten it up with hand screw.

I —
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9. Put down the stretchable stands on both side reach the ground, then the installation is completed.
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2.3 Install the magnetic media separator

The function of a magnetic media separator is to prevent sheet media from double feeding while loading
sheet media to a cutter.

A magnetic media separator contains a magnet which is used to attach the media separator to a feeder.
Users can move the magnetic media separators to a proper position whenever needed.
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2.4 Blade and Blade Holder Installation

2.4.1 Blade Installation

Insert a blade into the bottom of the blade holder and remove the blade by pushing the pin. Make sure
that your fingers are away from the blade tip.

Pin

Adjustment depth knob

Outward ring

K] Install blade.

S1CTe! Adjust the blade tip to suitable length by screwing “Blade tip adjustment screw” clockwise or
count-clockwise.

|

Tips:

“The proper length” means the blade’s length is adjusted 0.1mm more
than film’s thickness. That is, if the thickness of film is 0.5mm, then

blade’s length is properly adjusted 0.6mm and it can completely cut
through the film layer yet avoid penetrating the backing.
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2.4.2 Blade Holder Installation

EJTX] Loosen thumb screw and insert the blade holder into extension holder

il
/-\‘"!HWJJ

\
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Y Use the reversing steps to remove the blade holder.

HTE Eject the blade. Push “Blade eject pin” to eject blade when the blade needs to be replaced.

Caution
The blade will lose its sharpness after a period of usage; the cutting quality might be affected.

By increasing the cutting force, it might do the trick. However, once the blade is worn out and no longer
provides a reliable cutting, you should replace a new one. The blade is consumable and must be replaced
as often as necessary to maintain the cutting quality. The quality of the blade deeply affects cutting quality.
So be sure to use a high quality blade to ensure good cutting results.
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2.5 Automatic Blade Length Detection
The photos show a new blade holder with a scale and a carriage with a mark. This blade holder detects
blade length automatically and shows how the knob needs to be turned on the LCM.

There are 10 units on the scale; each unit equals to 0.05 mm, allowing you to adjust the blade length for
0.00mm-5.00mm.

Follow the steps below to adjust the length of the blade:
1. Keep the blade tip within the blade holder before you start adjusting.
2. Align one of the scales on the blade holder to the mark on the carriage

3. Select “Blade Length Adjust” under “CUT TEST” on the LCM, and enter the blade length wished in
“Set Length”; test the blade holder first and then test the blade length by pressing ENTER.

Note: Keep the blade holder at the same position when you perform blade holder and blade length tests.

4. When blade holder and blade length tests are finished, the screen will show you to what degree (the
unit of the value following “CW” or “CCW” is “circle”) and in which direction [CW (clockwise) or CCW
(counterclockwise)] you should turn the adjustment knob.

e.g. Turn CW 5 means to turn the knob for 5 units clock-wisely.

5. The screen will show “Adjustment completes” when the value on the screen is 0, the blade length is
perfect and no more adjustment needs to be made. Press “Enter” now to complete the process and
you may start cutting at this point.

20
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2.6 Software Installation
2.6.1 GreatCut Installation

YT ¥ Visit GreatCut online registration page http://gccvoucher.eurosystems.lu/, enter your voucher code

provided when purchasing GreatCut and click “Go on!”

Please visit GCC website to download software.
https://www.gccworld.com/download.php

GreatCut

© Register your product with voucher code online
within 3 months after receiving your cutting plotter
to avoid voucher code expiring.

http://gccvoucher.eurosystems.lu/
G reo t © Get your activation code from email to activate
( i ' GreatCut after completing registration online.
/4

© If you lost your voucher code after registration,
You can retrieve your original voucher code from

GCC Club: http://club.gccworld.com

Sure Cuts A Lot
© After completing installation of SCAL, enter license
code into SCAL to complete activation.

|
Great Computer Corp. Software Voucher Code “c Greol: GJt
L 74
T

Please enter your voucher code completely and accurately as it stands on the voucher.

Voucher Code [KGCC-XX00X-HX00XH0MK-X00] |

Go Onl =
In case of problems or guesti ou can reach our technical support over tech.support@gcc.com.tw.

[Homepage Great Computer Corp. |

¥ Click “Request” to go to registration page.

Great Computer Corp. Software Voucher Code xc Gre—uft GJt

You are halding in your hands a software voucher for a full license of GreatCut 3
In order to receive the free of charge license code and download GreatCut 3, please use the following button:

License code for new full license Request
[Homepage Great Computer Corp. ] N

S1CTeR Fill in the required information and click “Request license code.”

Software Download GreatCut 3

Great Gut

Software Registration

Last name, first name: [Ejlzen

] | Required fields
Company:
Street: 4F-1, No. 236, Fude 2nd Rd X\_ml Dist !
PO box:
City: [New Taipei City ]
State/Prov.: | (only US and Canada) v
Zip (postcode): 22151 ]
Country: | Taiwan v 1
Phone: 386265166892 ]
Fax: |
ellail address: |a|lesn chen@gce.comw !

Imgortant; Pay af

Request license code > | \
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Y The registration is completed; you should receive two emails, one is registration confirmation with
activation link and another is your license data with .ecf file.

Registration Successful

Thank you, that you decided for GreatCut 3

An email with further information for GreatCut 3 was sent to the given email address (eileen.chen@gcc.com.tw). Please be
patient, as it may last up fo 30 minutes until you can receive this email.

If you don't receive an email, please fill out the form on gccvoucher eurosystemns lu again with a working email address

[Home Great Computer Corp. |

ETE Check your email to see if you receive the activation link and click the link that will direct you the
link for GreatCut download.

SEE- tech support@ goc com. tw
- eileen chen@gec com.tw

IE: GreatCut 3 - Activation Link

Dear Customer,

thank vou, that yvou decided for GreatCut 3.
Please click the following activation link or enter it in vour web browser:

hitp://sccvoucher_eurosvstems_lu/activate dml?id=128461259209629vulFOOaiK eRkhlgg

After clicking the link, vou immediatelv will get download links and license data for G*realCm‘?\
If vou have questions, vou can reach our support over tech.support@gcc.com.tw.

Best regards
Great Computer Corp.

TG Visit GCC website and go to “SUPPORT” page to download the user manual, driver and software
(https://www.gccworldnew.com/download.php).

x&% —

Innovation L/ ’ o ABOUT APPLICATIONS PRODUCTS SHOWCASE SUPPORT CONTACT CAREERS
With & Human Touch

Buyer's Guide

Tech Support
GCC Club

Online Video
Download Area

Product Termination Policy
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Or browse by machine model

Laser Marker UV Inkjet Printer

Digital Finishing Equipment

Digital Finishing Equipment

Digital Finishing Equipment «

DFS LabelExpress

DecailExpress DecalExpress-ECO

AFJ-24S AFR-24$

JV-240U0V

Title

GreatCut 4 for Windows (V.17.0.20.21868)

Sure Cuts A Lot 5 for Windows 64 bit (v5_044GCC)

Sure Cuts A Lot 5 for Windows 32 bit (v5_044GCC)

Sure Cuts A Lot 5 for MAC (v5_044GCC)

Size

294MB

73.6MB

55.7MB

36.2MB

Download

Download

Download

Download

Download
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Choose Destination Location

InstallSicid ! T Bk ' Cancel

B1CTek: Select “Typical” and click “Next”.

Note: You may select custom setup to install additional drivers.

Instaldl " | <Back Het> Fom——

K Select the folder and click Next.

Default program folder in the start menu is GCC\GreatCut 3.

Select Program Folder
1 folder

Administiative Tools

£5U5 Uty

Bullzip

Catalyst Control Center

CorslD R/ Graphics Suite X7
Craft Edge

Express Gate

Giames
Googe Eatth Fro

IristallShield I cBack || Net> Cancel |
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TR GreatCut is installing.

Setup Status

| <Bsok ﬂ Finish | | Cancal r

HEE Before you launch GreatCut, open the .ecf attached to the license data email to install your

license data to GreatCut so that you don’t need to fill in your information again.

FHE: RCE-ONLINE =directdownload @eurosystems. Ius
W eileen chen@gre com by

Sl

=

=& GreatCut 3 - Receipt and License code

4 :E | [|GC16P-1867 ecf (273 B)

GCC.... Geeat Gut

1. Please print this eMail.

2. License data for GreatCut 3 1

-
Live Update: =
The following license code will be activated by copying or saving the att

use.

For a possibly necessary manual input. here the license data (green) again| Licencze installed su CCESSFLI”!{

Company / Name: GCC

eMail: gileen chen@gcc.com tw
Code: GCI16P-

Number of Licenses: 1

Serial No.: GC16P-1867
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EITREE If the license do not install successfully, you will need to fill in your license data manually. You
can find the details of your license data from the email.

License data:

Note

Please fill out the fields of the license data exacthy as you
xeceived it

Company { name

[l

eMail.

Ikeira lee@ goc.commtw

Code:
|EGCC-EXEEE-EXEME-KEEEE-KEEEL
Bystern information PIN
|3666223320-0-9-1-57- MARKE T-KEIR AZ

Coxa

Sa= | RCS-ONLINE =dirsctiownload @snrosystems hus
U= | eilsenchen@pec.comty
Elba

S 2015/2/25 G

GreatCut 3 - Receipt and License code
PR | | GC16P-1867.ecf (273 B)

The following license code will be activated by copying or saving the attached file to the computer and starting it via double click. Thus the
activation is done fully automatic and GreatCut 3 is ready to use.

For a possibly necessary manual input, here the license data (green) again in plain text:

Company / Name: GCC
Mail: eileen.chen@gcc.com.tw
Code: GC16P-
Number of Licenses: 1
Serial No.: GC16P-1867

HTEL] GreatCut is ready to use now.

GreatCut 3

GreatC:
Version

Copyright ¢ Eur
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2.6.2 Sure Cuts A Lot Installation (Optional Item)
2.6.2.1 Auto Installation

e Visit GCC website and go to “SUPPORT” page to download the software
(https://www.gccworldnew.com/download.php). The software is compatible with Windows 7 and
above and Macintosh OSX 10.6 and above.

“&M S

Innovation with & Homen Tevch

ABOUT APPLICATIONS PRODUCTS SHOWCASE SUPPORT CONTACT CAREERS

Buyer's Guide

Tech Support
GCC Club

Or browse by machine model

Laser Marker UV Inkjet Printer Digital Finishing Equipment

| Digital Finishing Equipment Digtal Finishing Equipment »

DFS LabelExpress DecalExpress DecalExpress-ECO

[ as L



GCC...

AFJ-24S User Manual

AFJ-24S AFR-24S

Title

GreatCut 4 for Windows (V.17.0.20.21868)

Sure Cuts A Lot 5 for Windows 64 bit (v5_044GCC)

Sure Cuts A Lot 5 for Windows 32 bit (v5_044GCC)

Sure Cuts A Lot 5 for MAC (v5_044GCC)

JV-240U0V

Size Download
294MB Download
73.6MB Download
55.7MB Download
36.2MB Download

ET¥] Download “Sure Cuts A Lot” to start the installation.

1G]] Press Next to continue.

ﬁ' Setup - Sure Cuts A Lot 5

Welcome to the
Setup Wizard

This will install Sure Cuts AL

u’{h% Itis recommended that you
\a Y—, continuing.

Click Next to continue, or Ci

Y Select “I accept the agreement” and press “Next.”

15 Setup - Sure Cuts A Lot 4 \
License Agreement

Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms o
agreement before continuing with the installation.

Craft Edge Inc
End User License Agreement

Please read this License Agreement carefully before proceeding. This Agre
licenses Software to you [either an individual or single entity] from CraftE
contains warrant and liability disclaimers. By installng, copying or otherwis:
this Software, you are confirming that you have read and understand this
Agreement and agree to be bound by the terms of this Agreement. If you

this Agreement, you should notinstall or use this
[Software.

@) 1 accept the agreement \

§5) Setup - Sure Cuts A Lot 4

Information

Please read the following important information before continuing.

When you are ready to continue with Setup, dick MNext.

Craft Edge
Sure Cuts A Lot 4.0 Read Me

1. General Information

Thank you for choosing Sure Cuts A Lot. Sure Cuts A Lot is an extremely e
program to cut virtually any shape with your electronic cutting machine. Cu
TrueType fonts, SVG files, images, & even draw your shapes giving you er
possibilities!

- Works with your installed TrueType & OpenType fonts on your computer
- Works with Bosskut Gazelle, Black Cat Cougar/Lynx, Craftwell eCraft, Pa
Inpsiration, Silhouette SD/CAMEQ Portrait, Silver Bullet, USCutter, & more
- Import various files formats, including SVG & PDF

- Drawing tools to draw and edit sahpes

~
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K Use the default folder (suggested) or select a folder you want to install the Sure Cuts A Lot and
press “Next.”

ﬁ! Setup - Sure Cuts A Lot 5

Select Destination Location
Where should Sure Cuts A Lot 5 be installed?

Setup will install Sure Cuts A Lot 5into the follo

To continue, click Next. If you would like to select a diffe

TG Tick “Create a desktop icon” if you want to create a shortcut on your desktop, and tick “Associated

scut4 extension” to associate the scut4 extension file with Sure Cuts A Lot software. Then press
“Next” to start the installation.

ﬁ! Setup - Sure Cuts A Lot 5

Select Additional Tasks

Which addlh'onal tasks should be performed?

Select the fadditional tasks you would like Setup to pert
Lot 5, ther dick Mext.

Addimonal icons:

Create a desktop icon

File extensions:
Associate "scutS” extension

ﬁ?_?ﬂ Setup - Sure Cuts A Lot 5
ﬁl Setup - Sure Cuts A Lot 5

Installing

Recdy/ i1 = Please wait while Setup installs Sure Cuts A Lot 5 on you

Setup iz now ready to begin installing Sure Cuts A Lot

Extracting files...
Click Install to continue with the installation, or dick Bz : :
T T ! C:\Program Files\Craft Edge'\Sure Cuts A Lot SYcudt. dat

Destination location: -

C:\Program Files\Craft Edge'\Sure Cuts A Lot 5

Additional tasks:
Additional icons:
Create a desktop icon

File extensions:
Assodate "scutS” extension
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S Tick “Launch Sure Cuts A Lot” but Don’t tick “Install USB Driver”’, and then press “Finish” to

compete installation.

] E=E u

=

@ Setup - Sure Cuts A Lot 5

Completing the !
Setup Wizard

Setup has finished installing &
computer. The application mz

u’{)e " installed icons.
\’\0 Click Finish to exit Setup.

Launch Sure Cuts A Lot

Run Sure Cuts A Lot.

Version 5022
Copyright © 2019 Gl Edmed
All R:g]mj&h‘n_\.l

ETE Press “Activate...”to activate Sure Cuts A Lot. Please make sure it is connected to the internet.

Sure Cuts A Lot 5 Demo Mode

"Sure Cuts A Lot 57 will run in Demo Mai
with a valid Serial Mumber,
In Demo Mode:

- The software will cut horizontal lir
DEMQ watermark.

-You dgan browse gnd purchase de
but wilf to download to
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TR Put your name in the Name column and enter the 25-letter software key to the Serial column and

press “OK” to complete the activation.

Please visit GCC website to download software.
https://www.gccworld.com/download.php

GreatCut

(] Register your product with voucher code online
within 3 months after receiving your cutting plotter
to avoid voucher code expiring.
http://gccvoucher.eurosystems.lu/

© Get your activation code from email to activate
GreatCut after completing registration online.

© If you lost your voucher code after registration,
You can retrieve your original voucher code from
GCC Club: http://club.gccworld.com

Sure Cuts A Lot
© After completing installation of SCAL, enter license
code into SCAL to complete activation.

Activate Sure Cuts Alot5

Pleaze enter wour Name and Serial. /

——
—————

Warne:

Serial:

L |
Please enter wour Name and Serial.
— =
Activation...

Thank you for activating the software.

If you need to move the software to a new oc
Deactivate under the Help menu (Requires ar

ETEE] Launch Sure Cuts A Lot, select “My Cutter” under “Cutter” and select “Manage Cutters.”

|4 Sure Cuts A Lot 4 u_

File Edit Object Path Layer Page

Effects Tedt View [ Cutter| Window Help

Mat Size

Preview

Mat Orientation 3

Ctrl+Shift+P

Cut with GLC

My Cutter

[] 1 H 1 4 5 6 7 H
Lo bewa b b bvwn b b a Lo I

Cutter Settings..

Tablet Connection...

=

-




GCC...

AFJ-24S User Manual

HTEF] Select Company/ Brand as “GCC” and the model you want to output, and then click the “Add to

list” button and “Done.”

| i+ Manage My Cutters

Cutter

GCC i-Craft
GEC

4 | i

Remaove

Cutters you currently have added are listed below. To add anc
to add another Brand/Model.

Add a Cutter
Company fE

I

<— Add

Note If you use a trial version to output graphics, meaning you do not enter the software key to
activate the Sure Cuts A Lot mentioned above, there will be two extra lines cut through the design,
therefore, make sure the Sure Cuts A Lot software is activated before implementing cutting jobs.

2.6.2.2 Manually Activate Software

If the computer connected to cutter doesn’t have internet connection to accomplish above software

activation process, you can use “Activate manually” function alternatively to enter the “Activation Code” to

start the usage of Sure Cuts A Lot. Meanwhile, you need to find another computer that has internet
access to obtain the “Activation Code” in advance following below instructions.

EJTE] Check the "Activate manually" checkbox and you should see the Site Code and Activation Code
fields appear. The Site Code field will be pre-filled in and cannot be changed.

Activate Sure Cuts A Lot 5.

Pleass enter your Name, Sertal and Actvaton Co

—
Wame: ||
| Serial. | [
Site Code:

Artivation Code: ||

[62320-43329-96117-T111
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Please visit GCC website to download software.
https://www.gccworld.com/download.php

GreatCut

© Register your product with voucher code online
within 3 months after receiving your cutting plotter
to avoid voucher code expiring.
http://gccvoucher.eurosystems.lu/

© Get your activation code from email to activate
GreatCut after completing registration online.

© If you lost your voucher code after registration,
you can retrieve your original voucher code from
GCC Club: http://club.gceworld.com

Sure Cuts A Lot

© After completing installation of SCAL, enter license

code into SCAL to complete activation.

3 sure cuts e VDUCher c°de E

Activate "Sure Cuts A Lot"

Important: You only need to do the following if you are having trouble activating from
within "Sure Cuts A Lot” or do not have an Internet connection on the computer you are
trying to activate on.

You must activate in order to use the full version of the software. Generally, you will just
need to choose Activate.. from the Help menu in Sure Cuts A Lot and enter your name and
serial number. The software will try to activate automatically and you can disregard this
web page. Do not use this web page if you have not installed the software yet or have not
purchased.

If you view the About box in Sure Cuts A Lot and it shows your name and serial number,
the software is activated aok.

1f you have problems activating automatically, you must use this web page and generate
an Activation Code. The Name and Serial information is obtained from your purchase
confirmation e-mail. The Site Code is obtained by running the program and choosing
"Activate..” and checking the "Activate Manually” option.

Name k
Please enter your full name

Serial 71184-04510

Must enter with the dashes (example: 12345-12345-12345-12345-
12345)

Site Code POOOCE-MOCEX-X000C- X000

Generate Activation Code |
After entering in your Name, Serial, and the Site Code, click the Generate Activation Code
button to create your Activation Code. Copy and paste the value back into the "Activation”
dialog box in the application to activate your copy.

If you experience problems generating your Activation Code, please see our FAQ.

¥ Visit http://www.craftedge.com/activation/surecutsalot via an internet connected computer. Enter
your name, serial (software key shows on the voucher code card) and site code.

Click on the "Generate Activation Code" button and your activation code will be shown in the
Activation Code field.

Y Copy and paste the activation code back into the activation dialog box of Sure Cuts A Lot program

and hit ok.
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2.6.2.3 Re-install Sure Cuts A Lot Software

If you change a new computer, you may need to deactivate your Sure Cuts A Lot software and re-install it
on your new device.

Go to “Deactivate...” under Help and press Yes to confirm, then follow the installation procedure and use
the same code to activate it on another computer.

4 Sure Cuts A Lot 5: Untitled-1

File Edit Object Path Layer Effects Text View Cutter Window Help

!'r?\[{; ﬁ About Sure C

Help

Page

Online Forum

Online Video

Install Diriver..

Support

40 50 &0 70 80 30 1001101201:301501 SHE0T701 801902002 10220

Register Prod
cleck for Ups

Language

I

i Are you sure you want to deactivate the software?

Deactivating will allow you to re-install on a different cc
(Requires an Internet connection)

[ss L
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2.7 Desktop Flexible Media Support System (machine only)

The following installation of desktop flexible media support system is only used in the machine individually
without assembling with auto feeder.

Put the 4 Plastic Foot under the Roll Holder Support and insert the M4 screw into the hole of Plastic Foot
and tighten them with the M4 L-shape screw driver. (Figure 2-13)

Roll Holder Support

M6 screws

Desktop Support
Brackets

M4 screws

M
Figure 2-13 _ 6 screws
Figure 2-14

Position the Desktop Support Brackets beside the Roll Holder Support and insert M6 screws into
the Roll Holder Support and tighten them with M6 L-shape screw driver. (Refer to Figure 2-14).

Step 3|

Put the bottom of machine in lateral, and position the Roll Holder Assembly beside the bottom of the
machine. Then, insert the M6 screws into the holes of Roll Holder support assembly and tighten them with
M6 L-shape screwdriver. Like Figure 2-15.

M6 SCREWS

&g\\ Screw holes

Roll Holder Assembly {a

Figure 2-15 Roll Holders  Figure 2-16

56



GCC...

AFJ-24S User Manual

Place the two roll holders into the holes of Roll Holder Support (Figure 2-16).

Step 5|
The complete Desktop Media Support System will be shown as in Figure 2-17.
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2.8 Instruction of Damper Roller (machine only)

Turn the wheel as instructed below to adjust damping. The bigger the number is, the stronger the
damping. The volume symbol sticker indicates the damping level (Figure 2-18,19).

Figure 2-18

Figure 2-19
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Chapter 3 The Control Panel

This chapter describes the button operations with the LCM menu flowcharts of Jaguar V. When the

cutting plotter is ready for use as described in Chapter 1 & 2, all functions are under default parameters

3.1 The LCD Panel

e N

POWER @
SPEED FORCE OFFSET @ @

OO O \2

ON/OFF
MISC TOOL SELECT ~ DATA CLEAR CUT TEST LINE PAUSE /RESUME ~ ENTER
\_ /
Key Function
LCD Screen To display functions and error messages.
Power LED To indicate the power status (light up: power on; light off: power off)

Four Arrow Keys To move position, select function, or change setting.

ENTER To set item or register the immediately preceding input value.

PAUSE/RESUME To temporarily halt cutting process or to continue

ON/OFF LINE To switch modes, stop cutting job, or abort changes of settings.
OFFSET To adjust the value of blade’s offset.

FORCE To adjust the value of cutting force.

SPEED To adjust the value of cutting speed and quality.

CUT TEST To perform cutting tests on different media.

DATA CLEAR To clear up buffer memory.

TOOL SELECT To select tools.

MISC To set up functions.
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3.2 Menu in On-line Mode

Power On  Jaguar V in processing

Cutter
LCM Version- - -

Jaguar V
Firmware: Copyright:

:

Place Media And Then
Lower Down The Lever

.

Roll Edge Single | se A V D toselect
A Kev V Kev D Kev

.

Sizing Media Width
Lever Up To Abort

i

Sizing Media Length
Lever Up To Abort

Top i
menil
S--m- Fememee O------
Lememm Woemmeme T1M
Sending data [PAUSE]
Pause Setup Resume
—>
FORCE
[ ! | Force: 80 gf Use % to select; [ENTER] to enable the setting
OK: ENTER
[SPEED] key] Speed: 72cmis /A
select:-<\> ok entER V
OFFSET .
r ] o| Offset: 0.275 mm A AAS Speed: Medium A
N: ONLINE OK:ENTER YV Select:4 [> OK: ENTER \
[DATA CLEAR] Clear Data Memory A Up Accel.: Medium A
> OK: ENTER V Select:q D OK: ENTER V
[TOOL SELECT] UP Speed: normal
.| 1S:72  F:80 0:0.275M AN pq D %
Select: <|[> OK:ENTER V Select: OK:ENTER
Quality: 72 cm/s
Set Smoothing Cut yq D %
> Select:q [> OK: ENTER Select: OK: ENTER

OverCut: 0.00mm AN
Select:<]|[> OK:ENTER V

A 4

Pouncing 0mm yAN
Select:<|[> OK:ENTER V

Set Tangential Mode
7| Select:<|[> OK:ENTER
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3.3 Menu in Off-line Mode

Press [ON/OFF LINE] to switch to the offline mode

| Offline For System Setup

—>

Recut number: 0-99

>

Copy number: 1-999

Test Blade Holder
OK: ENTER

4

Test Blade Length
OK: ENTER

v
Turn CW O Turn
N: ONLINE OK: ENTER

v

Adjustment completes

OK: ENTER

I » Ratio: 100%, 200%, 300%, 400%

—» Pattern: Cross, Arrow

[ ]
<[>Av > AV move origin M
X Y
SPEED .
[ : » Speed: 72cmis A Speed: 3~153 with an increment of 3 (cm/s)
Select:<|[> OK:ENTER V
R AAS Speed: Medium A\ High, Medium, Low
"| select:<|[> OK ENTER V
| Quality: Normal /A Draft, Fair, Normal, Fine, Small Letter
7| select<][> OK:ENTER V
»| UpAccel.: Medium /| High, Medium, Low
Select:<|[> OK:ENTER V
» UP Speed: 72cmis /\| UP Speed: 3~153 with an increment of 3 (cm/s)
Select:<][> OK:ENTER V¥
[FORCE] _
Force: 80gf /\| 5~600 with an increment of 5(gram force)
OK:ENTER V
[OFFSET] (| Offset 0.275mm - A | 4.000~1.000 with an increment of 0.025 (mm)
> OK: ENTER v
[DATA CLEAR] .| Clear Data Memory
N: ONLINE OK: ENTER
[CUT TEST]
» Square Cut Recut #1 JAN
Select<][>  OK:ENTER Select<|[> OK: ENTER V4
Copy #1 A
Redo Jobs in Memory Select<| [> OK: ENTER \V4
—»| Select<|[>  OK:ENTER
Repeat AAS Job After sending AAS job
| Select<|[>  OK:ENTER 9An
Blade Length Adjust .| SetLength 0.00mm | |
—] Selectﬁ [> OK: ENTER d Change:Av OK: ENTER
Ratio Setting Ratio: 100%
| select<][>  OK:ENTER Change: Ay OK: ENTER
Pattern Setting | Pattern: Arrow
—»| Select<|[>  OK: ENTER > Change: AV OK: ENTER
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18:72 F:80 0:0275M A

select-<> ok:enTER V

Set Smoothing Cut
Select:<|[> OK: ENTER

\ 4

| Offline For System Setup

A 4

OverCut: 0.00mm A _OverCut: 0.00~1.00mm with an
increment of 0.05mm
select-<|> ok:ENTER V

A 4

[TOOL SELECT]

Set Tangential Mode
Select:<|[> OK: ENTER

Pouncing: 0~200mm with an
Pouncing 0 mm increment of 1mm

Select:-<|> Ok: ENTER

A 4

<>

Panel Setup Cancel Restore
Select:q [> OK: ENTER Change: OK: ENTER

A 4

A4

Factory Default ? Sure to Restore
Select:q [> OK: ENTER Change: OK: ENTER

A 4
Y

A 4

Auto Unrolled Media Enabled, Disabled

Select:q [> OK: ENTER OFF

Chanae:<I*AV OK: ENTER

\4

A 4

Section Cut .| ON

select:-<|[> Ok: ENTER Chanae:<I>AV OK: ENTER

5-1000mm with an increment of 5mm

Die/Kiss Cut: AVQ [>

Length: 9.0/ 0.2 mm

Die/Kiss Cut: ON
select:<|> OK:ENTER

A 4

<>

A 4

Die/Kiss Cut: Av<] [>

Rear Paper Sensor Force: 450g 459
Select-<|> ok: ENTER Enabled, Disabled

Adjust Paper
select:<{[> ok: ENTER

A4

+40mm with an increment of 0.5mm

[MISC]
Vacuum

select<|[> ok: ENTER

Enabled, Disabled

v

DHCP

Enabled, Disabled
select:=<|> ok: ENTER nabled, Disable

IP Address

IP Add t, Submask set,
select<|> ok: ENTER ress set, Submask se

Gateway set

MAC Address
00:CF:52:72:03:01

First Back To Origin

Enabled, Disabled
select=<][> ok: ENTER nabled, Disable

AAS Copy
select-<|[> Ok: ENTER

\4

Enabled, Disabled

I AAS Detect Mode Forward Direction, Auto Detection, Reverse Direction
Selectzq [> OK: ENTER

AAS Offset
Select:Q [> OK: ENTER
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\4

Paper Saving Mode
Select:<] [> OK: ENTER

\4

Set communication

Select:q [> OK: ENTER

A4

Firmware X.X.XX

FPGA: xx.XX

A4

Select Language
Select:Q [> OK: ENTER

\4

Select Unit
Select:Q [> OK: ENTER

A4

Scale Length
Select:q [> OK: ENTER

A4

Scale Width
Select:q [> OK: ENTER

A4

Image Scale Length
Select:<] [> OK: ENTER

A4

Image Scale Width
Select:Q [> OK: ENTER

Both Expanded Mode, Length Expanded Mode,
Width Expanded Mode, Both Un€xpanded

English, Francais, Turkce, Polski, Japanese,
Deutsch, Italian, Espanol

Metric (cm/g), Unit (inch/ g),
Unit (cm/ oz), English (inch/ 0z)
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3.4 Menu ltems

Menu or Key Function Setting Default
--- POWER ---
To indicate the power status.
[ Arrow Keys ]
1. To move the tool carriage position on X or Y axis.
2. To select functions or change values of settings.
[ ENTER ]
1. The displayed parameters will be saved automatically.
2. To set a new origin at the present tool carriage position.
In “offline” mode, moving the tool carriage to desired
position by [Arrow Keys], then press [ENTER] key to set a
new origin. While moving with the parameters of XY-axes
displayed, press [MISC] key will enable fine-tune
movement; press [MISC] key again to disable the function.
[ PAUSE/RESUME ]
To temporarily halt the cutting process.
To resume the process by press [Pause/Resume] key again.
[ ONLINE/OFFLINE ]
1. To switch between online mode and offline mode.
2. To stop the cutting job or abort the change of setting.
Once press this key, the cutting job will be terminated
immediately and cannot be resumed.
[ OFFSET ]
To set or modify the distance between the blade tip and the|0.000~1.000mm [0.275mm
center axis.
[ FORCE ]
To set or modify the value of tool force. 5~600gram; 80 gram
For Jaguar V_R, when the cutting force exceeds 450g, the |2 gram/per step
maximum cutting speed would be 15cm/sec and the cutting
quality would be Small Letter Mode (0.2g) and while the
cutting force is 300g-449g, the maximum cutting speed
would be 30 cm/sec and the cutting quality would be Fine
Mode (0.5g)
[ SPEED ]
Speed To set or modify tool speed at horizontal moving. 3~153cm/sec; 72cm/sec
3cm/sec per step
Quality To set or modify cutting quality. Draft, Fair, Normal
While cutting small letter, set as “Small letter”. Normal, Fine,
While cutting in high speed, set as “Draft”. Small Letter
For normal operation, set as “Normal”.
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on the computer side.

Please be noted that this feature is mainly applied to the
Single paper mode; please ensure a new piece of material
you wish to apply this feature on is loaded and the origin
repositioned to the first registration mark before starting.
When the first AAS job repeat completes, the user will be
offered the choice of “Repeat AAS Job Again”, please
press ”"Online/Offline” to return to the main menu.

This option will appear after finishing reading all registration
marks.

Up Speed To set or modify tool speed while the tool move from 3~153cm/sec; 72cm/sec
endpoint to next start point at horizontal moving. 3cm/sec per step
Up Accel. To set or modify tool acceleration levels while the tool move|High, Medium, |[Medium
from endpoint to next start point at horizontal moving. Low
AAS Speed To set or modify AAS detecting speed. High, Medium, |[Medium
Low
[ CUT TEST ]
Square Cut To perform a cutting test at present blade position.
For more information, please refer to “4.3 Adjusting the
Cutting Force and Offset” to adjust blade force and cutting
speed.
Redo Jobs in  |To redo the cut test jobs saved in memory by recutting or Recut (number of |Recut
Memory producing cut test copies. Recut number: 0 means limitless. If{jobs: 0-99)
you want to set number as 0, you should set that between
repowering the cutter and putting down the lever. Copy (number of
jobs: 1-999)
Repeat AAS Job| To repeat AAS jobs automatically without having to operate

300%, 400%

Pattern Setting| To provide two patterns for cut test “Arrow” and “Arrow”
Note: It is recommended to select “Cross” if you are working|  Cross” patterns |Note: the
on thick pieces of materials. default

pattern for
Jaguar V_R
is “Cross”

Ratio Setting To adjust the size of the pattern 100%, 200%, 100%
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Blade Length Please see 2.5 Automatic Blade Length Adjustment for 0.00mm-5.00mm [0.00mm
Adjust further details.
To adjust the length of the blade
Note:
5. Keep your blade length as 0 before you start adjusting.
6. Test the blade holder first and then test the blade length
by pressing ENTER.
7. Keep the blade holder at the same position when you
perform blade holder and blade length tests.
8. When blade holder and blade length tests are finished,
the screen will show you to what degree (the unit of the
value following “CW” or “CCW” is “circle”) and in which
direction [CW (clockwise) or CCW (counterclockwise)] you
should turn the adjustment knob.
EG, Turn CW 5 is telling you that you should turn the knob
for 5 units clock-wisely.
The value on the screen will be 0.0 when the blade length is
perfect and no more adjustment needs to be made. You may
start cutting at this point.
[ DATA CLEAR ]
To clear up buffer memory.
[ TOOL SELECT ]
Set Smoothing | To enable smooth-cutting function. Enable
Cut
Over Cut To generate an overcut to facilitate weeding. 0.00mm-1.00mm |0.00mm
0.05mm/per step
Set Tangential | To enable the emulated tangential-cutting mode for thicker Enable
Mode media types and small letter cuts.
Note: while the Offset value setting at 0.000 mm, “Set
Tangential Mode” will automatically be disabled.
Pouncing To make perforated patterns. 0~200mm Omm
* In order to use this function, Pouncing tool must be
installed.
* Before start pouncing, place pouncing strip on top of the
cutting pad to protect the cutting pad.
* Set the value as 0 mm to disable the pouncing mode.
* Pouncing tool is an optional item.
Panel Setup Accept setup command: Accept
To accept commands of the Force, Speed, Cutting Quality, setup
and Offset only via software. command

Control panel only:

To accept commands of the Force, Speed, Cutting Quality,
and Offset only via control panel of the cutter.

Factory Default

To turn all parameters of the menu items to factory-default
settings.

66




GCC...

AFJ-24S User Manual

[ MISC ]

Auto Unrolled
Media

To avoid paper jam and motor crash by automatically unroll
media (50cm and up) before cutting while enabled.

* Auto-unroll only effects on roll/edge media.

* Using Single mode to size media will disable this function
automatically.

* If the length of the rolled media is less than 2 meters or the
weight is light, it is recommended to set this mode
disabled.

Enable

Section Cut

To divide a long plot into sections and perform the cutting
job section by section.

Input a value between 50mm - 2000mm to determine the
length of each section.

ON:

50 - 2000mm,
5mm /per step

OFF

OFF

Rear Paper
Sensor

To detect if the rear paper sensor is covered to determine
the following process; when it is enabled, the cutter will
detect if the material has covered the rear paper sensor
under the Roll and Edge mode; when disabled, the rear
paper sensor will not be functioning.

Note: Rear paper sensor only functions under “Roll” and
“Edge” mode.

Enable
Disable

Enable

Adjust Paper

To define the position the feeder will load a paper sheet
from the stack to the work area.

If the value of Adjust paper is bigger, the distance of sheet
feeding from the stack to work area will be longer.

-40.0 - 40.0mm,
0.5mm /per step

29.0mm

DHCP

Shows your IP address for TCP/IP Configuration

Disable

IP Address

Shows the IP Address of your cutting plotter.

MAC Address

Shows the MAC Address of your cutting plotter.

Vacuum

To help improve tracking and cutting accuracy by turning on
the fans. If you turn off the vacuum system, the fans
will remain inactive during cutting or plotting.

Enable

First Back to
Origin

To enable the carriage back to the previous origin; when
“Enable” is selected, the carriage will not go back to the
previous origin, while the selection of “Disable” allows the
carriage to do so.

Enable
Disable

Enable

AAS Copy

To enable the AAS copy. When “Enable” is selected, the AAS
module will continue to read the registration mark to contour
cut. Users can set distance between images and AAS copy
times in this function. The range of distance is 0-500mm, and
the range of times is 0-1000.

Enable
Disable

Enable

AAS Detect
mode

To detect media loading direction.

Auto detection: detect the direction of loaded media
automatically

Reverse direction: when loading the media upside down.
Forward direction: when loading the media in order.

Auto detection,
reverse direction,
forward direction

Auto
detection

AAS Offset

To set or modify AAS offset value.
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You can refer to “5.3 Printer Test” for more details.

procedure as follows:
1. Press the [LEFT ARROW] to choose the Numerator and

select 500.0 mm,

2. Cut the length by sending a graph file,

3. Measure the length then use the [RIGHT ARROW] key to
choose the Denominator, then

4. Press [UP ARROW /DOWN ARROW] to change the values of
the actual length.

Paper Saving To save media by four different modes: Length
Mode 1. Length expanded mode 2. Width expanded mode expanded
3. Both expanded mode 4. Both unexpanded mode mode
Set To build up the communication between host computer and
Communication | cutter.
Baud Rate is to determine the speed of data transmission.
Data Bits refers to the size of one block of data.
Parity is used to check if data was revived correctly or not.
9600, n, 7, 1, p 9600pbs, 7 Bits with NO Parity
9600, 0, 7,1, p 9600pbs, 7 Bits with ODD Parity
9600, e,7,1, p 9600pbs, 7 Bits with EVEN Parity
9600, n, 8, 1, p 9600pbs, 8 Bits with NO Parity
9600, o, 8, 1, p 9600pbs, 8 Bits with ODD Parity
9600, e, 8, 1, p 9600pbs, 8 Bits with EVEN Parity
19200, n, 7, 1, p  19200pbs, 7 Bits with NO Parity
19200, 0, 7,1, p  19200pbs, 7 Bits with ODD Parity
19200, e, 7,1, p  19200pbs, 7 Bits with EVEN Parity
19200, n, 8,1, p  19200pbs, 8 Bits with NO Parity
19200, 0, 8, 1, p  19200pbs, 8 Bits with ODD Parity
19200, e, 8,1, p  19200pbs, 8 Bits with EVEN Parity
Firmware To display the version number of Firmware and FPGA code.
Version
Select To select displayed languages on LCM panel in English, English
Language Spanish, Italian, Deutsch, Portuguese, Polish, Turkish or
Eranch
Select Units Provide two-unit systems for users convenient. cm/s; inch/oz; Metric
cm/oz; inch/gram
Image Scale To adjust the image scale of media length and width that 500/500
Length may cause by the thickness of the media. mm
The Numerator is the ideal length, and the Denominator is
the actual length measured from the resultant.
Image Scale For example, cutting a line with 500.0 mm length. The
Width

Scale Length

Scale Width

Fixed scaling, for maintenance only.
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Chapter 4 Operation

4.1 How To Load The Sheet Media Into The Auto Feeder

Kl Place the sheet media flat on the stack of the feeder and adjust the pinch roller to proper position
according the media size.

NOTE :
1. Make sure the sheet media is flat to avoid any fail to load into machine for the curved media

2. A laminated media is requested while using in the auto feeder. Otherwise, it may probably fail
to be adsorbed by suction cup due to the air leaking.

¥ Put the L-type media blocks to touch the rear edge of the sheet media.
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ST Adjust the pinch roller to proper position according to the media size. The alignment label
provides a quick view of the suggested position of pinch rollers for different media sizes.

Suggested Pinch Roller Position
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YA Power on the cutter.

SICIKJ Press “ENTER” key to start media width sizing.

( s POWER
SPEED FORCE OFFSET @ : @
ON/OFF
MISC TOOL SELECT ~ DATA CLEAR CUT TEST LINE PAUSE / RESUME

KN Go to “MISC” menu, use arrow left/right keys to select “Adjust Paper” and press “ENTER” key.
Set the “Adjust Paper” to 22.5mm and press “ENTER” key to confirm.

-

POWER

SPEED FORCE OFFSET @

MISC

|

ON/OFF
CUT TEST LINE

O O

TOOL SELECT ~ DATA CLEAR

PAUSE / RESUME

~ Offline For System Setup

[MISC]
22.5 mm

Adjust Paper

Select: < [> OK: ENTER

ENTER
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( )
Note: “Adjust paper” is to calibrate position of media front edge after sizing.

If the value of Adjust paper is bigger, the distance of the

media front edge will be closer to cutting blade.

\.

HEELN Use arrow left/right keys to select “AAS copy” and press “ENTER” key .

POWER @
SPEED FORCE OFFSET @ &

O O O \J

ON/OFF
MISC TOOL SELECT DATA CLEAR CUT TEST LINE PAUSE / RESUME ENTER

O O

SEEEl Then use arrow up/down keys to define the repeated value (value = 0~ 500) and press
“ENTER” key.

M Send the job from your computer and the cutter with feeder will perform the automated cutting
process.
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4.1.1 Automatic Working Procedure

1. Pick up the media from tray to load it into the cutter

NOTE:

Blowers installed on both side of media tray will automatic turn on while the media is ready to be
picked up to separate the media. You can control the air volume by turning off the fans according to
the media type.

2. AAS Il will detect the registration mark after sizing the media
|
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3. Start the cuttinh job

NOTE: It is suggested to use die cut/ kiss cut function instead of regular cutting in order to achieve
good quality output on paper box application.

4. Collecting the media once completing the job
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4.2How To Load The Sheet Media Into Machine Without Auto Feeder

To load the media properly, please follow the procedures listed below:

Use the lever on the upper right side of the cutting plotter to raise or lower down pinch rollers. Pull the
lever forward until it makes a clicking sound then the pinch rollers are raised.

Lever

Load your media on the platen and slide it under the pinch rollers from either the front side or the backside.
The alignment rulers on the platen extension will help you to adjust the media precisely.

Note:

Be sure that the media must cover
the paper sensors on the platen
when loading the media. At least one

of the two paper sensors should be

covered. Once the media covers the 3 (' b
sensor, the cutting plotter will size the j’i/ )
media width and length Paper sensors \\J\ ~

automatically.

Step 3

Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must be positioned
above the grid drum. The white marks on the top trail will remind you where the grid drums are.

White marks
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m

Push the lever backward to lower down the pinch rollers.

Turn on the power, the tool carriage will measure the size of the media automatically. And the plotting
cutter begins to work.

Note:
1. Always adjust the position with the pinch roller raised.
2. Move the pinch roller by applying force at the rear portion of the pinch roller support.

3. Do not move it by holding its front rubber roller.

(X)

Incorrect

Note:

Please pull up the bottom of all pinch rollers (Figure 4-5) before the lever is pushed backwards to
ensure accurate media width detection.

Pull up bottom to release grip

ENABLE I

76



Gccw AFJ-24S User Manual

4,3 Cutting Force and Offset Adjustment

Before sending your designs for cutting, you may perform a “cut test” to generate satisfactory cutting
results. The “Cut Test” should be repeated until the appropriate cutting conditions for the media are
discovered.

After sizing the media, press [CUT TEST] button to select the “square cut”, and press [ENTER KEY] to
confirm.

The default cutting force and offset value of the cutting test are 80gf and 0.275mm respectively. Press
[ARROW KEY] to move the tool carriage to the position where you like. Then, press the [ENTER KEY] to
perform Cut Test.

Note: At the same time, the new origin is also set at the cutting test position.

When the cutting test is completed, a pattern appears. Peel off the pattern to see if it can be easily
separated from the media base. If yes, the setup tool force is appropriate. If not or cut through the back
paper, press [FORCE KEY] to adjust the tool force until an optimum force is obtained.

t
OK:Entn:1“

Press ENTER_KEY

cout te s t M
Y ¢

i Press ENTER_KEY

S quare Cou
Select <>

If the pattern appears to be BB or CC layout,
press [OFFSET KEY] to adjust the offset value
until AA pattern discovered.

’%v<> Mo v e

AA BB CC

Press SPEED_KEY,
FORCE_KEY,

OFFSET_KEY to setup

Continous Square Cul‘ or
N:ON/JOFFLINE OK:Enter Press arrow keys to
i Press ENTER KEY desired position for next
square cut
T\\ Press
e A
- kR >
3mm 3mm
/
[ / Wlachine ]
l / {"‘ {"‘ {"1‘ ]
PN LN L
b = s
i Y‘ Lo\ L,
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4.4How to Cut 3mm Letters

To obtain good quality output, narrow media is recommended. However, if wide media is used, you
should:

1. Position two pinch rollers as close as possible to both edges of the cutting area.
2. Make sure the loaded media is held flat with equal tension across the platen.
3. Suggested operation settings:

Tool force: 55 gf. (or depending on the material)

Cutting speed: 45-50 cm/sec

Tool up speed: 45-60 cm/sec

Smooth cut: Disable

Quality: Small Letter

4.5When Completing the Cutting Job

After completing the cutting job, raise the sheet-loading lever, and then remove the material or you can
use the cutoff function.

Cutoff Manually:

You can cut off the finished job by the Safe Blade (a standard accessory) along the knife guide.
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4.6Jaguar V Print Driver setting

4.6.1 Jaguar V Print Driver setting > Option Page

r,‘%J Jaguar V-132LX Properties

-
| General | Shaing | Pots | Advanced | Color Management
Option | Paper | AAS In:
Setting File Function
Pen Speed 72 omls [ =
1 ¥
El [ Load
Pen Force 20 aq [ ==
P |:| n figinal
Offzet 0275 mm [ Save To Defau
] = b [ Delete
Custom Media :
Guality Small Letter - ]
Image Scaling
LS 5000 /4 5000 mm
4 (] P
i 5000/ 5000 mm
1 =] b

|Jze Plotter Setting
Drefault :
[ Back to Home ; T
eflective film.Ja:
[] &45; Origin using printer zetting Virj}ll.Ja’-‘«d ,
o indow_tint.JA4
@ A 200 mim interyals
() By Registration Marks
[7] Die Cut

Setting: You can adjust the following settings, depending on your application or results you would like to
achieve.

Quality:
[Slower speeds / higher quality - Faster speeds / lower quality]

The Cutting Quality setting function allows you to adjust and balance vector mode’s quality and speed
settings based on your specific job. Draft Mode offers the highest output speed, sacrificing quality.
Whereas Small letter Mode offers the highest quality, sacrificing output speed. Keep in mind that speed
and quality are usually at a tradeoff.

Use Plotter Setting:

The parameter settings will be set according to those set from the control panel.
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Back to home:

The carriage will return to the original position when this option is selected.

Section Cutting:

Users can output long picture by section cutting which could make cutting more stable and get superior
cutting quality. Users can set the section by registration marks or input the value manually. When cutting
plotter finishing cutting in section 1, it will continue to cut in section 2. The picture is shown as below:

r T 1

350 Section 4
500 Section 3
X |eensanneeee]
500 Section 2
500 Section 1

L 1 -
Y

File Function:

The file function section allows users to set the parameters of Speed, Force, Offset and Quality for later
use. This section is useful when performing repeated jobs on a variety of objects, allowing you to save
your frequently used cutter parameters and load them in the future.

* SAVE: This function will save current print driver parameter settings to a file under the specified location
on your computer. (Saved parameter setting files will be tagged with the Jaguar V series extension)

* LOAD: This function allows you to load previously saved print driver parameters.

* ORIGINAL: This function will load the print driver’s original factory parameter settings.
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* SAVE TO DEFAULT: This function allows you to save your current print driver parameters as the default
startup settings.

* DELETE: This function will delete the file you select from the Custom Media section, whereas the
settings in Default section cannot be deleted. Please note the delete function only removes the list
shown in Custom Media section, it does not remove the file from your hard drive, if you wish to
completely remove the file from your hard disk, you will have to manually delete the file from your
operating system.

» Custom Media: This section lists the files for the parameter settings that you have recently created and
worked. You can save more than 50 files to simplify your cutting job.

« Default: This section contains the reference settings that are applicable with the verified materials to
achieve the best cutting results. Please note that the setting value might need to be adjusted according
to different suppliers of materials.

* Die Cut

The Die Cut function must be activated with the Kiss Cut function to avoid the falling of cut-through
materials and material jam beneath the carriage. Die Cut helps you to cut through the backing of the
material while Kiss Cut cuts through only the top layer but not the backing. This will leave only tiny bits of
the backing attached to the top layer, creating complete individual patterns with backing sheets

I Cutting line B|a

Top layer

Vinyl

Backing sheet
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To activate the Die Cut function, go to “Option”, tick “Die Cut”, and enter the amount you wish for the
“Length” and “Force” of both Die Cut and Kiss Cut, then click “OK”.

- | V-132LX Propert 3
i Jaguar rope 5 -
| General I Sharing I Parts I Advanced | Colar Management
Option | Paper AAS In:
Setting File Function
Pen Speed 72  omisz [ e
I [ 3
—l [ Load
- : [ Original
DOlffset 0275 mm [ Save ToDefau
1 (] r [ Delete
[ Cugtom Media :
Guality Small Letter - ]
Image Scaling
| o 5000 4 5000 mm
1 (o '
¥ 5000 /4 5000 mm
{ (el ' Note:
The length setting for th tting line of Di
[7] Usze Platter Setting e. e. gih setling for fhe cutling fine o ©
| Default : Cut is in the range of 0-2000mm whereas
Reflective_film.JA that of Kiss Cut is 0-100mm.
[] 245 Origin using printer setting Wikl i
[F Section Cutting Windom_tint.Jad
| @ Ar 200 mm intervals
By Reqistration Markz
| Diie Cut

When the job is completed and you untick the Die Cut function, you will be able to adjust the pen speed,
pen force, and offset in the section on the top following normal operating procedures.

Note:

1. The extension of the blade has to be set to cut through both the top layer and the backing in the very
beginning. You then adjust the tool force for the best cutting performance.

2. Once the Die Cut function is activated, it will perform on all the line segments on the object.
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4.6.2 Jaguar V Print Driver setting > Paper Page

-

o= Jaguar V-1321X Propirt‘l-e;i - -

General I Sharing I Ports | Advanced | Caolor Managemenit
Option | Faper BAS Iy
Paper Size Unit
E' 640,00 i @ Metric: [rmm)
» 1320000 - ) Imnperial [inch)
Wergion Mo,

Jaguar V1320
Copyright (] Great Computer Co,
All Rights Reserved.

v 2.07-

GCC..

[ wawocowoldeom |

Paper Size (Paper Page) [DEFAULT SETTING: Y = the width of machine; X will be automatically set to
be twice the length of Y]

The paper size represents your total work area. The X value represents the length and the

Y value represents the width. The paper size should be set as the same as your image so you can get a
better cutting quality.

Unit (Paper Page) [DEFAULT SETTING: Metric (mm)]

Here you can set your preferred measurement standard in which you would like to use with the Jaguar V
print driver. You can choose between metric or imperial standards.
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4.6.3 Jaguar V Print Driver setting > Paper Feeder Page

r = Bl
o Jaguar V-61LX Pmm Bl Sl u

General | Shaina | Pots | Advanced | ColorManagement [ Securty |
Option Paper AAS Installer Paper Feeder

Repeat count : ||"|
P3(XY): W M
P4 (X.Y): ID.DDD ID.DDD

Ki+) 4+ X(-)
Y

[Nl
AAAAAA

N

] O Q) (O) (O
L | . ) .. _Fl1

i R e PO .|

34’7 jPZ

Printing line

‘/// Cutting line

¥ [+ Value)
¥ (+ Value)

DBU —lPl

The setting in Paper Feeder Page works when 2-point positioning registration mark setting is applied in a
cutting file. Please refer to A-4 Add Two Point Registration Marks section or A-5 Add Two Point
Registration Marks section.

* Repeat count: to define the number of copies desired in one cutting job

* P3 (X,Y) / P4 (X,Y): to set offset X and Y value (Horizontal line is defined as Y and vertical is defined as
X when facing the cutting plotter).

When the actual cutting line and the printed line need to be changed towards the direction of P1 mark,
then simply add the negative value of the offset. If the direction is from the opposite of the P1 mark, then
enter positive values for the offset. This method applies to both X and Y axes
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4.7Reference Parameter setting for different materials

The following reference parameter is used on GCC verified materials shown in the table.

Personalized/ Wall

Material stickers Vehicle stickers Window decoration Window tint
Blade red red red red / yellow
Blade tip length (mm) 0.28 0.27 0.25 0.09
Force (g) 105 85 95 70
Speed (cm/sec) 72 60 65 72
Offset (mm) 0.25 0.25 0.25 0.25

Recommend model

RX, Jaguar, Puma,

RX, Jaguar, Puma,

RX, Jaguar, Puma,

RX, Jaguar, Puma,

EX, AR EX, AR EX, AR EX, AR
Material Stencil Reflective film Flock Cardboard
Blade red / green green green green
Blade tip length (mm) 0.3 0.5 0.3 0.3
Force (g) 180 380 135 165
Speed (cm/sec) 15 3 30 30
Offset (mm) 0.25/0.5 0.5 0.5 0.5

Recommend model

RX, Jaguar, Puma,

RX, Jaguar, Puma,

RX, Jaguar, Puma,

RX, Jaguar, Puma,

EX, AR EX EX, AR EX, AR
Material Magnets Protective tint Rhinestone Sandblast mask
Blade green green green blue
Blade tip length (mm) 0.8 0.3 0.8 0.27
Force (g) 580 320 190 85
Speed (cm/sec) 3 3 15 60
Offset (mm) 0.5 0.5 0.5 0.25

RX, Jaguar, Puma,

Recommend model RX, Jaguar RX, Jaguar, Puma RX, Jaguar, Puma,

EX

EX, AR

Material Small text (vinyl)
Blade black
Blade tip length (mm) 0.27

thick: 150
Forea () thin: 90
Speed (cm/sec) 9
Offset (mm) 0.175

Recommend model

RX, Jaguar, Puma
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Chapter 5 Automatic-Aligning System

Please note that this chapter is only an instruction to AASII; for step-by-step instructions, please refer to
the following chapters: A-4 CorelDRAW Plug-in , A-5 lllustrator Plug-In, A-6 GreatCut Plug-In.

5.1Introduction

The RX Il series cutting plotters feature a standard Automatic-Aligning System (AAS Il) to guarantee
precise contour cutting quality by detecting the registration marks printed around the graphic.

Notice

B Avoid any kind of light source horizontally illuminating the AAS module.

B DO NOT take off the cover of AAS module while in operation.

- PROHIBITED
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5.2 AAS Contour Cutting System

The AAS system has one calibration procedures to ensure maximum accuracy of AAS operation. To
operate the AAS you need to learn about the method of media feeding firstly. (Refer to 4.2 How to load
the sheet media into machine in P. 77)

5.2.1 Notice for Registration Marks

The first registration mark is designed to be different in order to identify the origin for AAS
auto-detection. The following precaution must be aware for registration marks to be read
automatically.

» Type of media
» Registration mark pattern
» Reading range required for detection the registration marks

» Position for registration marks and medium

The registration marks have to be:

» Created by cutting software like GreatCut, SCAL, lllustrator Plug-In or CoreDRAW
plug-in, SignPal.

» Color: black color (printing quality of registration marks is essential; incorrect,

misaligned colors, blurry or smeared printout might leading to inaccurate cutting

result)
Length Thickness Margin
Range 5~50mm 1~2mm 0~50 mm
Optimized Setting 25 mm 1mm 5 mm

The cutter cannot detect the marks while:
» Cutter carriage is not located near the outside area of first mark before detecting

(See the picture in page103 for auto-detecting area of first mark.)
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» Medium thickness is more than 0.8mm

» Transparent medium is used

» Non-monochrome drawing. The marks can’t be read if it is printed on colored
medium

» Dirty or creased medium surface

5.2.2 AAS Il on Jaguar series

There are four types of AAS Il mark patterns: 2-Point Positioning (Feeder Mode only), 4-Point Positioning,

Segmental Positioning, and Multiple Copies.

Note that before print out your designs by inkjet printers, the registration marks have to be created on your
graphic designs by cutting software like GreatCut, SCAL, SignPal or GCC CorelDraw plug-in. Hand-made

marks or drawings won'’t be reorganized by GCC cutting plotters.

For more details about registration mark setting in cutting software, please refer to the software setting in

Appendix”

1. 2-Point Positioning (Feeder mode only)

This provides simply mode that enable to shorten the time of detecting the registration mark.

AAS || Reg. Mark Setting

|I¥ Add Registration

2" mark 1** mark

™ 4-Point Positioning

Mo il |
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4-Point Positioning

This is the basic mark pattern that AAS Il will auto detect four registration marks and contour cut
images inside those marks.

m  Command: Esc.D1;(XDist);(YDist):

m  Layout: 4 registration marks at the 4 corners around the design

]
L

Segmental Positioning

In addition to 4 original points, the intermediate registration marks are added on both X axis and Y
axis to help contour cut accurately, especially for cutting large images.

m Command: Esc.D2;(XDist);(YDist);(XStep);(YStep):

m Layout:

In-between distance on X: 200~600mm, default 300mm

In-between distance on Y: 200-600mm, default 300mm

B High Precision Long Picture Cutting
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® The object will be output following the section pattern based on the Segmental Positioning
parameters.

® Cutting sequence: Section1-> Section 2-> Section 3- > Section 4

3. Multiple Copies

The function is used to duplicate images to let you cut quantities of images at a time. The AAS |l

sensor will automatically scan registration marks for each individual image to ensure the contour
cutting precision.

m Command: Esc.D3;(XCopies);(YCopies);(Space):

m Layout:
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5.2.3 Automatic Distinction of the Plot Direction

For the convenience of users, RX |l series automatically detects the feeding direction of the material
when performing contour cutting. Figure 5-1 shows the Registration Mark detection sequence when
the material is fed in the standard way (1->2->3->4) while Figure 5-2 is how RX Il series detects
registration marks (3->4->1->2) when the material is reversely fed. RX Il series is able to detect
registration marks and performs contour cutting however users feed the media.

Direction detection steps:

(Please see Figure 5-2)
a. Detects the position of the 3rd Registration Mark
b. Proceeds to the 4th Registration Mark to detect the direction

(The direction detection procedure will be performed by the detection of 4th Registration Mark)

d. The information is reflected in the driver and recalculated before output
e. The registration mark detection and object output process is implemented

(Registration Mark detection
sequence: 3->4->1->2)

r J U M
3 4 1 2
) ] 4 3
(| | C J

Standard Media Fedding Direction 1->2->3->4

Figure 5-1

Reversed Media Fedding Direction 3->4->1->2

Figure 5-2
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5.3 Printer Test

Before performing AAS contour cutting, it's recommended to print out a test file to make sure the
AAS Il cutting accuracy. Please visit GCC website and go to Download Area to download the test
files.

https://www.gccworld.com/download.php?act=view&id=20

x‘ Company Applications Products Technology Support Contact Link @ Q@

Software »
Product Brochure »
Driver »
User Manual »
e 7]
Title Size Download
Cutter AAS Offset Test Files 3.0MB Download
cutter Clipart Library (AE file) 1107kB Download

There are two testing files for AASII:
1. AASII_X Y _ Offset_Caberation_A4 .eps (A4 size)
2. AAS II_X_Y_Offset_Caberation_600_600 .eps (Default setting, it is recommended for testing)

B Print out the testing graphic. ( Please use high precision printer)
B Load the graphic to RX Il series and sent the file to test the cutting job

M [f there are any adjustments to be made, you can change the offset value by

following the steps:

p» Measure the offset values from the printed line and the actual cutting line.

p Enter the AAS Offset under MISC function for the values you just measured,
then press Enter

p Test the cutting again
Bl AAS Il offset X and Y value is defined as following:

» Horizontal line is defined as X and vertical is defined as Y (when facing the
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cutting plotter)
» When the actual cutting line and the printed line need to be changed towards

the direction of origin mark, then simply add the negat of the offset.
If the direction is from the opposite of the origin mark, then enter positive
values for the offset (see the following figures). This method applies to both

X and Y axes.

« Media feeding direction « Media feeding direction

X (+ Value)
Y (- Value)

X (+ Value)
Y (+ Value)

L N U

Origin

I

|

|

I

I

t

I

I

I

I \

\ Printing line

Cutting line

Origin

Cutting line

[

Y (- Value)

— __
X (- Value) I

I X (- Value)
: Y (+ Value)
Ve L] |
Cutting line ‘\
Origin Printing line — Cutting line
Orlgln Printing line

Note:

] Before adjusting the AAS Il settings, please proceed scaling for width and
length.

[ | The blade offset value isn’t set for this test graphic, please set it according
to the blade you use.

B If you have any question, please contact us or your local distributor for
assistance.
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5.4Registration Mark Offset Range

Please correctly load your media (refer to the alignment ruler on the platen) to make sure the registration
marks are successfully detected. Deviation exceeds the range below will lead to detection failure.

Registration Mark Length range: 5 ~ 50 mm
L (Registration Mark Length)

S (Deviation of Registration Mark) Ist Mark

L
Deviation range : <8<
g

Registration Mark Length range: Smm < L < 50mm

5.5 Contour Cutting

For accurate contour cutting with AAS function, please proceed the following steps:

X Creating Graphics

m Create the graphic that you want to print and cut in your software.

&, BABY
& IN CAR

m Create a contour for cutting around the graphic.

& BABY
o IN CAR

TIPS1: Leave some space between the graphic and contour line.

TIPS2: Create the contour in a separate layer and assign a different color for it.

m Add registration marks around the graphic.

Note:

The Multiple Copies function is also available. It automatically copy the graphic and
registration marks.
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¥ Placing the Registration Marks

B The AAS Layout Instruction:

10 mm(0.39 in)
30 mm(1.181n) 10 mm(0.39 in) Track of Pinch Roller (grey sfip)

10 mm(0.3% in)

5mm(0.2in)

o 2namark AAS Il Layout Instruction 3rd Mark

Standard media verification:

/ Oracle white-color vinyl (651)
25 mm 5mm(0.2 in) / Grafityp white-color vinyl
(0.98in) / 5V white-color viny!

20 mm B
(0.79in) Mark size .
/ Length: 25 mm(0.98 in) .
/ Thickness: 1 mm(0,04 in) \ dBOPrrvm(SS).inS ‘T)@d ,
margin between mark & graph: 5 mm(0.2 in) Widih expanded mode or
8oth unexpanded mode)
X Distance (between 2nd & 3rd marks):
/ Maximum: 600 mm(23.62in) 50 mm(1.97 in)
/ Minimum: 70 mm(2.76 in) (depends on graphic design) lunder ;ggg;zoegnrgof\ggfe/
Y Distance (between 1st & 2nd marks):
/ Maximum: 1770 mm(69.69 in) (depends on media & cutfer)
/ Minimum: 70 mm(2.76 in) (depends on graphic design)

Repeatability: less than 0.3 mm(0.01 in)
WORKABLE AREA
(light grey blocks)
th Mark
Ist Mark
Origin

Auto-detecting area Track of Pinch Roller (grey stip) 30 mm(1.18 in)
(crey tiangie]

N\

* Auto-detection function on the 15t mark covers the grey area
m  Suggested 30mm margin on both left and right sides of media sheet.

m  Suggested 20~30mm margin on top of media sheet, and at least 50mm margin on the
bottom edge to prevent sheets dropping or any error occurred while media sizing.

* Auto-detection function on the 15 mark covers the grey area
m  Suggested 30mm margin on both left and right sides of media sheet.

m  Suggested 20~30mm margin on top of media sheet, and at least 50mm margin on the
bottom edge to prevent sheets dropping or any error occurred while media sizing.
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m Print the graphic and the marks with your printer

5

(Scaling = 100%).

m When printing on a roll media, make sure the orientation as following:

Y Load the printout onto cutter

m The Origin Mark is different from the rest registration marks. Please make sure the media is
fed with correct direction.

HTE Cutthe Contour

m Send out the command from software to perform the contour cutting job.

5.6Tips for AAS

For getting better results of contour cutting, there are some tips below for your reference.
m  Keep light sources simple and avoid illuminating from the sides of cutter.

m  Before operating AAS, change the maximum paper size in RX |l series driver
property.

¥ Find the RX Il model in the “Printer & Fax” folder of your PC.
¥ Open the Properties window and select the “Paper” tab.

HE Change the maximum Paper Size of X to 1200mm.

B Adjust the cutting speed to between 300~600mm/sec.

B Avoid the registration marks locating on the tracks of pinch rollers.

B Make sure the edge of the media is not bent up when detecting 5.7registration
marks.
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Chapter 6 Maintenance

This chapter explains the basic maintenance (i.e. cleaning the cutting plotter) required for the cutting
plotter. Except for the procedures mentioned below, all other maintenance must be performed by a
qualified service technician.

6.1Cleaning the Cutting Plotter

Cleaning the machine properly and regularly will ensure optimal performance out of your machine.

Cleaning Precaution !

e Unplug the cutting plotter before cleaning it
in order to prevent electrical shock.

Hl” ® Never use solvents, abrasive cleaners or
strong detergents for cleaning. They may
damage the surface of the cutting plotter and
the moving parts.

Recommended Methoc

e Gently wipe the cutting plotter surface with a lint-free cloth. If necessary, with a damp
cloth immersed in water or alcohol. Dry and wipe any remaining residue off a soft,
lint-free cloth.

e Wipe all dust and dirt from the tool carriage rails.

e Use a vacuum cleaner to empty any accumulated dirt and media residue beneath the

pinch roller housing.

e Clean the platen, paper sensors and pinch rollers with a damp cloth immersed in water or

alcohol, and dry with a soft, lint-free cloth.

e Wipe dust and dirt from the stand.
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6.2Cleaning the Grid Drum

1. Turn off the cutting plotter, and move the tool carriage away from the area needed to be
cleaned.

2. Raise the pinch rollers and move them away from the grid drum for cleaning.

3. Use a bristle brush (a toothbrush is acceptable) to remove dust from the drum surface.
Rotate the drum manually while cleaning. Refer to Figure 6-1.

...............

/

Figure 6-1

6.3Cleaning the Pinch Rollers

1. If the pinch rollers require a thorough cleaning, use a lint-free cloth or cotton swab to
wipe away the accumulated dust from the rubber portion of the pinch rollers. To
prevent the pinch rollers from rotating while cleaning, use your finger to hold the
pinch rollers to prevent them from rotation

2. To remove the deeply-embedded or persistent dust, use the lint-free cloth or
cotton swab moistened with rubbing alcohol.

Note: The daily maintenance of your cutting plotter is very important. Be sure to clean up
the grid drum and pinch rollers regularly for better cutting accuracy and output quality.
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Chapter 7 Trouble Shooting

Trouble Shooting

This chapter is to help you correct some common problems you may come across. Prior to getting into the
details of this chapter, please be sure that your application environment is compatible with the cutting
plotter.

Note:

Before having your cutting plotter serviced, please make
certain that the malfunction is in your cutting plotter, not the

result of an interface problem or a malfunction in your
computer or a software problem.

Why is the cutting plotter not functioning?

Possible Causes:

7.1Non-Operational Problems

Check the following first:
B Does the AC power cord plug in properly?
B Does the AC power cord connected to the power connector properly?

B Does the power LED still illuminate?
Solutions:

If the LCM is able to display the message, the cutting plotter should be in a normal condition.
Switch off the cutting plotter and turn it on again to see if the problem still existing.

If the LCM is not able to display any message, contact the technician from your dealer.
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7.20perational Problems

Some mechanical problems or failure during operation will cause some problems. The error messages
shown on the LCM present the problem first, and followed by recommended actions. If the problem still
exists after the recommended actions have been done, have your cutting plotter serviced.

This message indicates that there might be a

Error, Check Media problem on the X axis. Check if the drum is working
Or Drum or X Motor well and if the media is well loaded. Correct the
problem and re-power on to reboot system.

This message indicates that there might be an
Error, Check Media obstruction to carriage relating to a problem on the Y
Or Y Motor axis. Correct the problem and re-power on to
reboot system.

This message indicates that the blade up/down sensor
malfunction. Re-power on to re-boot system. If the
Sensor or VC Motor problem still exists, find a serviceman.

Error, Check Carriage

This message indicates that the cutting exceeds the
cutting limit. Reload larger media or re-scale the plot
Data In Buffer to a smaller size; then press the key followed by the
display of LCM to continue.

Graph Was Clipped.
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7.3Cutting Plotter/Computer Communication Problems

The messages showed below present problems in relation to cutting plotter/computer communication.

Communication Error
Setup: MISC. key

Is the connection cable connected to
the cutting plotter and computer

properly?
|
|
Yes : No
v
Has the interface setting been Refer to Chapter 2 -
done correctly? Connecting your cutting
plotter.
|
Yes : No
|
v

Try the communication between
your cutting plotter and computer.
If it still does not work, have your
cutting plotter serviced.

Note:

Refer to the “MISC” key in Chapter
3 - Description of Operation for the
port setup.

The computer also needs to set up compatible communication

parameters to the cutting plotter set up.

HP-GL/2 Cmd. Error

If your cutting plotter cannot recognize the
HP-GL/2 or HP-GL commands, please check the
HP-GL/2 or HP-GL commands applied to your
cutting plotter are used properly.
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7.4Software Problems

Check the following first:

Does your software package indicate that it will work with your
computer and cutting plotter?

Does your software support HP-GL and HP-GL/2 drivers?

(* check the configuration settings of your software.)

Yes

Does the cutting plotter interface
match the requirements of your

software?
|
Yes : No
|
v
Does your Refer to Chapter 2 -
software Connecting your

recommend using
a different cable?

cutting plotter.

Most well-known cutting software in the
world has drivers for our cutting
plotters. If not, use software that has
HP-GL and HP-GL/2 emulation
supports and you can chose the
following three drivers:

® A3 size: HP7475A
® A1 size: HP7580A

° AO size: HP Draf Pro Exl or
HP Draf Master

Yes l

Try using the Does the software
recommended vendor provide a
cable. sample file?

Yes

«——

Re-power on the cutting
plotter and try to send
the file again.

Do something about the error
message display on LCM, or
consult your software vendor.

102



Gccw AFJ-24S User Manual

7.5Cutting Quality Problems

Note: The daily maintenance of your cutting plotter is very important. Be sure to
clean up the grid drum and pinch rollers regularly for better cutting accuracy and
output quality.

Is the blade installed correctly and the blade holder
fastened securely?

|
l I No
Yes !
v
Is the blade dull or Refer to Chapter 2.4
chipped? “ Blade Installation”
[
|
Yes : No
|
v
Replace Is tool force set up
with a new properly? (The default for
blade tool force is 80 gf)
[
|
Yes : No
|
v
Is the tool offset set up Adjust the tool force to obtain an
properly? optimum blade force. Refer to
Chapter 4.3 “Cutting Force and Offset
Adjustment”
|
I No
Yes I
|
|
v
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blade?

Is there any dirt adhered to the Adjust the tool offset to

obtain an optimum value.

Yes

I
I
I
:No
I

h 4

Remove the blade
and clean it.

Please contact your dealer for technician
support.
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A-1 Specification

AFJ

Item Description

Automatic Finishing system (Cutter with auto feeder unit)

Supported media A4 (297 x 210 mm), SRA4 (320 x 235 mm), A3 (297 x 420 mm), SRA3 (320 x 450 mm), B3 (500 x 353
size mm), B2 (500 x 707 mm)

Interface USB 2.0 (Full Speed), Serial (RS-232C) and Ethernet

Power source 100 to 240 V AC (It is required three power outlet.)

. Temperature: 15 to 30°C/60°F~86°F
Operating

environment Humidity: 25 to 75 % RH (non-condensing)

Dimensions (cutter

with feeder) Approx. 950 (W) x 1,080 (D) x 780 (H) mm

Weight Approx. 40 kg (Cutter unit: 18 kg, Auto feeder unit: 22 kg)
Cutting speed Max. 1,530 mm/s (at 45° direction)

Acceleration Max. 4.2 G

Cutting force Max. 600 g

Interface USB 2.0 (Full Speed), Serial (RS-232C) and Ethernet

Power source 100 to 240 V AC

Power consumption Max. 251.8 watts

Auto feeder unit

Width: 279 to 500 mm, Length: 210 to 700 mm
Supported media
Up to 350 g/m?

250 Sheets @150 g/m? or up to 50 mm height

Capacity of supply

tray (It varies by the material, thickness and condition of media.)
Interface Serial (RS-232C)

Power source AC adapter, 100 to 240 V AC, Approx. 60 VA at output power

e Compatible with Windows 7 and above & MAC OS X 10.6 and above. (*Purchasing serial number for “Sure
Cuts A Lot” software to work with Mac 0S.)

e GCC reserves the right to change the specifications at any time without notice.

Specification A-1
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Blade Specification

For cutting thick fluorescent and window tint film. Also for cutting
detailed work in standard vinyl.

265019700G
The blade is 45° with Red Cap, 0.25 mm blade offset, and 2.5

mm blade diameter.

L P——————

For cutting reflective vinyl, cardboard, sandblast, flock, and
stencil sharp edge.

265017540G
The blade is 60° with Green Cap, 0.50 mm blade offset, and 2.5

mm blade diameter.

Qo ————

For cutting thin sandblast mask and stencil. The blade with
sharp angle and special design, allowing it to maneuver around
sharp corners.

The blade is 60° with Blue Cap, 0.25 mm blade offset, and 2.5
mm blade diameter.

I —————

For cutting small text and fine detail. Sharp blade with smallest
offset.

265017550G

265017560G
The blade is 50° with Black Cap, 0.175 mm blade offset, and

2.5 mm blade diameter.

(S —————————— g

For thin and delicate media such as window tint.

265017530G
The blade is 25° with Yellow Cap, 0.25 mm blade offset, and

2.5 mm blade diameter.

Blade Specification A-2
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About the Tool

A generic term referring to the blade that cuts the sheet, the pen that does plotting, and the
LED bombsight (option) used for pointing to the reference point.
OFFSET is the distance that the blade tip is displaced from the centerline of the blade.

< Blade

<+«— Central line

Blade tip —

|
i
i
M

4_
offset

Protrusion Length of the Blade

Thickness of
the media (t1)
Protrusion length

of the blade -

Thickness of the C o 5 fe m— m— — s
base paper (t 2) Y

|‘

Length of protrusion = t1 + t 2/ 2, but for your convenience you may just make it about
0.3mm ~ 0.5mm beyond the blade holder tip.

Blade Specification A-2
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CorelDRAW Output Instruction

The following is an example of how to output the file with CoreDRAW.

User Instructions

1. Open CorelDRAW, finish editing all the files you wish to plot and select all the images
at once.

2. Select “Outline Pen” to adjust the outline for cutting.

4 CorclDRAW X4 - [Graphicl]

[ El Edit ¥iew Lawont Amngs Effect DBitmaps Tewt Tabk  Took  Window Help

CEES Kk b Won B -@ e §oww-EH R A (B @ o \
u

ST pe .‘ QP |7 g B [0 ek ST = m - B
wilezam | oo [ & 2 | af o | Plegstm || =fon ||,
[ T T S phssotam || too |° | ®
: ¥ Createfload e Merge to acum e b P AR e
40 20 ] 20 4‘0 Bﬂ‘ 80 100 120 130

Lo 180 B 220 230 =0

D &

£
2&0

BPap ® 98

POO D Fr LRSS
a0

ekkk

B

L L L ]
& « .
4l anl
=4[ Outline Pen T2
W @ Oule Color ShifieF12 ] 5 . A .

& &
[ 54X

Wone
Heirline
12pt

3. Adjust the value of pen width to 0.001 mm and click “OK” to save your input.

Arroms

AT { e
_|.|_||_|1 i~ | | millimeters w
| |

1|
|
e A (o2

’ s ] Calligraphe:
Stretch: Mib <
Edit Style... [ton & ey
& 23|
. e [ Tall 2
Miter Limit: 5.0 2 ] Anale:
| ; =
Corners Line caps iD'D 3 |

® ® = [
O A (B —

— — _ [[JeehindFfil
CorelDRAW Output A-3
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4. Select “ File — Print” to output the file to your cutters.

Help

I |

CHrbs EI @EI Dnu Units: | millmeters v

Sloamm 2] %

[ CorelDRAW EA - [Graphicl]
B

Window

100% v | Snapto -+ &=

File | Edit ¥isw Leyout Arsage  Bffects  Ditmaps
PO New Chl+N|Vﬁﬂdh = -F
. 48 New From Template .. f
; [ P Open.

| B Clos

VB Closal

R Seve Ctels

i B Seveds. ChilShifths

[E \;ﬂ Save As Template...

{b‘ Revert

-iz|(_‘ Aeguire Image »
Q, ot Dmport... Ctil

= G Expost.. Chl+E

Y4 Cg Export For Office

‘& Send To 4
L [ Evint. Cul+D

O EantMag y
) &, PrintPreview

1y, f PrintSetup.

E ﬂ% Prepare For Service Burean. ..

[] @ Publish To FDF

[ Publish Page To ConcepiShare

); Publish To The Heb >
8, Document Properties.

@,‘ Open Recent »
* [ Ext AlE

5. Choose the correct model you have installed.

GG

General |La\;0ut il Separations || Prepress || Misc || 2= Mo Issues|

Destination

O CUrren. pays

Pages:

Twpe: Jaguar I¥ 183
Skatus: Ready
where: GCCUSED:
Commenk:

Prink range

@ Zurrent docurment D Docurnents

Selection

Ewen & Cdd

Copies

Mumber of copies:

CHIGEGH

ore: | ESTTERY | [ ocpere: .

Use PPD

Print to File m

ik

CorelDRAW Output
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6. Choose the “Layout page” and click the “Reposition images to: — Bottom left corner”.
Please note that you must put your image at the bottom left corner.

General La':-"D@eparatians || Prepress || Misc || =t Mo Issuesl

Image position and size
) A= in document

O Fit to page
@ Reposition images to: Center of page i
Center of page
E] Settings for Page 1: Top center
i s Left center
Position: Size: Right center
¥l 35,91 m v & | W |138, 15 (BOtkom center
; Top left corner
¥i [169.07 [ EREINS M Tap right corner

Bottom left corner
Boktam right corner

Cuskom
| ||_: | 7o O Page WL

[ IPrirt kled pages

Tile overlap:

[]Eleed limit:

7. Go back to the General page and check that your image is at the bottom left corner. Click
“Print” and get a wonderful cutting image.

zeneral |La\,-'|:|u|: |: Separations || Prepress " Misc " == Mo Issues|
Destination
Marmne: Jaguar‘ IV 183 w | Properties, .,
Twpe: Jaguar IV 153 Lsg PPD
Skatus: Ready
Where: GCCUSED:
Camment: I_l:— [B
Print range Copies
(¥ Current document () Documents Murber of copies: 1 £
CJ Current page Seleckion

Pages: |i | Ilrili .H .H Collate
Even & Cdd

CorelDRAW Output A-3
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CorelDRAW Plug-In Instruction

AASII VBA Installer is applicable for CoreDRAW Version 13, 14, 15, 16, 17, 18

Installation
Please refer to Step 8 in Chapter 2.1.1.1 Driver Installation to install AAS plug-in for
CorelDRAW.

Run CorelDRAW AAS Plug-in

m Run CorelDRAW to edit your graphics and select all images at once when you wish to
plot.

M Select “Tools->Macros—>Run Macro.” Then select Global Macros
(GCCAASII_Draw13.gms) under the “Macros in” manual, and press “Run”.

EHle Edt View Layout Object Effects Bitmaps Text Table Window  Help

FrE-dd LRV R4 B [ [1] & opto e | G B
| Dzstomm [~ - /635 mm
B Decom mm 12 6% mm =
CEE S G omm
A Untitled-1 Object Manager
L}
o —— R E E - : : AU [agleg e , ‘:of
¢ Alt+F11 E (] Page 1 H
P R @ oMl Guides =
— @ @l Clone Layer 3
VSTA Editor. Alteshift+F12 @b &Ml Mark Layer Kl

8 Start Recording

saiadolg Pal0 1O

B8 Record Temporary Macro  Ctrl+shift+R

anauEIa pue Wb [

oM B /N2> ROOCN O4#

4 ~
] T of 1 @ \ page1 « o THW
» o XN

(138 a71818) B O now & [l o 60 50 (000000} 0200 mm

CorelDRAW Plug-In A-4
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-
Run Macro

tacro name:

tacrosz i | Globalbdacros (GCCA ARSI Diraw gms) v]

| T

Select whether you would like to add the registration marks by page size or “Draw
working area” to create a red line frame along with the registration mark to prevent the
printed image falling out of the boundary, and click on “Apply”.

Note: “Add Registration Mark by Object” will be the default selection if you click on
the image whereas “Add Registration Mark by page size” will be the default one
when the blank area on the page is clicked.

AASII Mark Setting V2.11-07 X

[+ Add Registration Mark by page size

[ Draw working area

" 2-Point Positioning (Feeder model only)
@ 4-Point Positioning

Length(mm): 10 (5~50)
Thicknessfmm): [ 1 (1~2)
Margin{mm): 1] (0~50)

" Segmental Positioning

X Step(mm): 500 (50 -600)
Y Step(mm): 500 (200 - 600)

C Multiple Copies
No. of X Copies: | 1 (1-50)
No. of Y Copies: [ 1 (1-50)

I copies with outline

Apply | ‘Cancel |

CorelDRAW Plug-In A-4
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A CorelbRaw X8 (64-8it) - Untitied-1
Fle Edit View Layout Object FEffects Bitmaps Test Table Tools Window Help

FE-ad D~ B M s
5 L | Szsromm

102200 mm
L B8 & -° f
Y A Untitled-1

F- g s0mm somm

v G seen v & -

-] A = | B[635mm .-
Units: millimeters v | 40r 0.254 mm "
- 0o Bl o -1 %635 mm d

&)

boedMBOL /N2> BRBO0OCHN O

FEREETR
» 2 X

(261361,286803) ¥

@\ Pagel <

B X nene

m Now you can print out the image file with registration marks.

You can also add a Hot Icon for the AAS Plug-in

Object Manager

iorman n 2 Page 1
T Ly

Bl (] Page1
® & i Ml Guides
@ g Ml valid Area Layer
@ gl Clone Layer
@ o Il Merk Layer
@b Ml Layer 1
E (] Master Page

JabeUE PRG0

saniadoid Pal0 10

o FEE

anaumsia pue ubiy 1

& [l R 6050 2000000) 0200 mm

Select “Tools> Options> Workspace—> Customization> Commands—> Macros—>
GCCMadual.GCC_AAS_Plug_In" and Click OK.

Options
Workspace e
- General
Display

General | Shortcut Keys | Appeara

Tooltip Help:

- Edit @
. PawerClip Frame

- Snap to Objects
Warnings

‘B ConverterStart

‘B CorelMacros.CreateColorS...
‘B CorelMscros.PageNumber...
VBA e EECH

Save
Wizard
PowerTRACE Ia

Plug-Ins

Text

Toolbox

[} Customization

Currently Available On:

Command Bars
Commands
Color Palette
Document
Global

i CorelDRAW X7 (54-Bit) - Untitled-1
File  Edit

i =

View Layout Arrange

= Eles"
I=H1en

’Letter

-~ T

[:6 WelcomeSlreen " mitled-1
a -

e L L

X

CorelDRAW Plug-In
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Add Registration Mark by page size

If you tick “Add Registration Mark by page size” as shown in the figure below and click “Apply”,
your registration marks will be created automatically (please see Figure A3-1).

Note:

1. The length setting will be in the range of 5-25mm
according to your page size.

2. Please DO NOT make any changes to the “Origin”
section when you choose to add registration marks by
page size as indicated below otherwise the position of
the marks will be changed (please see Figure A3-2).

Options

- Warnings
- VBA
Save

Plug-Ins
- Text
- Toolbox

—|- Document
General

.. Page Size

- Layout

- Label

- Guidelines
... Rulers

- Save

- PowerTRACE

= Customization

Snap to Objects »

Rulers

Mudge

Nudge: .01 — Supernudge: |2 | x0.0
inches Micro nudge:  0.010in/

Same units for Duplicate distance, Mudge and Rulers

- Background

Units
inches
3 [¥] Same units for Horizontal and Vertical rulers
Origin Tick divisions:
Herizontal: 0.0 inches 8 : per tic
Vertical: 0.0 inches [7] Show fraction
Show Rulers Edit

-

AAS T Reg. Mark Setting v1.02-01

|I¥ Add Registration Mark by page size
fl‘“ Ad
4

Length ] 11 mm

Thickness ] 1 mim
Margin ] a mm

(o =
X Step 300 fc:

Y StEFI 300 Lo

" Multiple Copies
Mo. of ¥ Copies ] 1
Mo. of ¥ Copies 1 1

Figure A3-1

Figure A3-2

The system will create the 4 marks on the 4 corners of the page as shown in the picture below
wherever you move your image.

Figure A3-3

CorelDRAW Plug-In

A-4
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Workable area
It allows users to edit and cut graphics in the area outside the registration marks when adding
registration marks by page.

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on
left and right sides and 4.5mm extended from the registration mark on top side. On the bottom
side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent
sheets dropping or any error occurred while media sizing.

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the
left side, 9mm extended from the registration mark on the right side and 11mm extended from
the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm
margin from the edge of media sheet to prevent sheets dropping or any error occurred while
media sizing.

Print
General | Color I Composite I Layout | Prepress | lxz* Mo Issues
Destination
Printer: l\\gpprinter2\4F_E'—HE_H—FH_KYOCERA FS-2025D KX v] ’ Preferences...
Page: ’Match arientation (Landscape) '] Use PPD L Left sic
Status: Default printer; Ready
Location: 192.168.100.246
Comment: [C] Print to file : X '
Cide - |
Print range Copies Top :IdE!: gy = L -
@ Current document () Documents Number of copies: il = : )
() Current page Selection E ( ) A £
1 : Ly peR s
Pages: 3 Iﬂ Collate 1 o g
Even & Odd (D Right ¢
[T] Print as bitrnap: 300 | dpi 0 Igln}

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled.
If you select “Single” mode, the media sheet will not be able to be moved back and
hence fail to be detected by front paper sensor.

CorelDRAW Plug-In

A-4
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Add Registration Mark by Object

If you tick “Add Registration Mark by Object”, you will be offered three options of registration
marks as shown below. 4-Point Positioning

' ®
AAS T Reg. Mark Setting v1.02-01

(™ °
[+ Add Registration Mark by Object

{* 4-Pgint Position

Length 1 o5 mm
Thickness 1 mm
L e ——

Margin 1 0 i

(™ Segmental Positioning
F [ J

xstep[ 5op | o
H"Stepl 500 Hee

" Multiple Copies

1 Mo, of X Copies 1 1
[
1 Mo. of ¥ Copies 1 1 o

Figure A3-4

Length: The length of marks

- Range: 5mm~50mm

- Optimized Setting: 25mm

Thickness: The line thickness of marks

- Range: Tmm~2mm

- Optimized Setting: 1mm

Margin: The distance between marks and images
- Range: 0Omm~50mm

- Optimized Setting: 5mm

Segmental Positioning

X Step: The distance of intermediate position on the X axis
Y Step: The distance of intermediate position on the Y axis
- Range: 200mm~600mm

- Optimized Setting: Less than 500mm

Multiple Copies

No. of X Copies: The numbers of copies on X axis

No. of Y Copies: The numbers of copies on Y axis

- Range: 1~50. (The more copies you make, the more time
is needed for data transmission.)

- Numbers of X Copies * Numbers of Y Copies = The total
amount of image copies

Copies with outline: To show outlines of image graphics

Note: The values entered in the “4-Point Positioning” section (length, thickness and
margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies”.

CorelDRAW Plug-In
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4-Point Positioning

AAS T Reg. Mark Setting v1.02-01

4-Point Positioning

® Length: The length of marks
™ add Registration Mark by pag

==

m

- Range: 5mm~50mm

Iv Add Registration Mark by Objgct > Optimized Setting: 25mm
% 4-Point Position @  Thickness: The line thickness of marks
Length ITmm - Range: Tmm~2mm
Thickness | 1 mm - Optimized Setting: 1Tmm
Margin In_mm ®  Margin: The distance between marks and images

- Range: 0mm~50mm
™ Segmental Positioning

xstep[ 500 -
Ystep[ 500

I
I ™ Multiple Copies
|

- Optimized Setting: 5mm

Mo. of X Copies I 1 Figure A3-5

Mo. of ¥ Copies | 1

The system will create the 4 marks as shown in the picture below.

Y CorelDRAW X7 (64-Bit) - Untitled-2

File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

B R B b-0- H AhB 0% - B P8 [ seeTo- M E | B -
(54 02970 mm [ =1 [l . [ = %, 50mm [r]l] =1

(] " ) 5 2100 e | B (51| o | = i) | # 02mm B |o05on | [

=R§'W ome 5¢ Untitled-2

o B

Sogegs | pos

R

s
100,
4

=) E
] )
A o] ),
&
,(‘ 1 L

Figure A3-6
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Note:

1. To save your materials, in addition to amending object margins, you can also adjust the
length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see
table 1 for suggestions based on different material sizes). The smaller the size is, the
smaller the distance between the object and the registration marks is (see the figures

below).
— =

' Flgure A3-7

L F

s
/ / CArea to be cut

i Figure A3-8

Page size Suggested mark length
(unit: mm) (unit: mm)

A6 (105 x 148) 5

A5 (148 x 210) 8

A4 (210 x 297) 11

A3 (297 x 420) 16

A2 (420 x 594) 23

A1 (594 x 841) and above 25%

Table 1

*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so
please make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the
previous setting will be applied.

CorelDRAW Plug-In A-4
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Segmental Positioning

rMS]IREg. g s T For precise cutting quality, it is suggested to select “Segmental
Positioning” when you are working on an extra long or

large-sized image to increase cutting accuracy.

[T Add Registration Mark by page size
v Add Registration Mark by Object

" 4-Point Position

Length Izs mm o
Sakeas ii_ Segmental Positioning

Margin I 0 mm

* Segmental Positioning

® X Step: The distance of intermediate position on the X axis
——» ® Y Step: The distance of intermediate position on the Y axis
- Range: 200mm~600mm

x5tep| 200 mm - Optimized Setting: Less than 500mm

Y Step 200 pedl

" Multiple Copies

Mo. of X Copies I 1 Figure A3-9
Mo. of ¥ Copies | 1

The system will create the as shown in the picture below

Y CorelDRAW X7 (64-Bit) - Untitled-2
File Edit View Lasyout Object Effects Bitmaps Text Table Tools Wind

gy e g e s ‘Sgﬁ’,piental Positioning
e T e[ PN / )

Iy | Welcome 5¢ Untitled-1 Untitled-2

g ) ] ) 50 ) 10 , I 0 ) 250 ) 300 / 30 ) 0 =

K

“PIQ AAEQ nEEO

Sopgpegs | pos

et i)
50

100

vo O

N

Figure A3-10

Segmental Positioning will be applied to Multiple Copies when the object to be copied is of large
size (with the length or width over 200mm) to increase the accuracy of registration mark
detection.

CorelDRAW Plug-In A-4
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Multiple Copies

It is suggested to select “Multiple Copies” when you would like to make several copies of one

image on your material to increase cutting accuracy.

-
AAS I Reg. Mark Setting v1.02-01

v add Registration Mark by Object

r---_'i_x'f._'.i".:Z" ark. Dy pade size

" 4-Paint Position

Length I 25 mm
'I Thickness I 1 mm
Margin I 0 mim

[ " Segmental Positioning

xstep| 5pp |
' YStepI 500 mm

* Multiple Copies

Mo, of X Copies I 4
Mo, of ¥ Copies | 3

Multiple Copies

®  No. of X Copies: The numbers of copies on X axis

® No. of Y Copies: The numbers of copies on Y axis

- Range: 1~50. (The more copies you make, the more time is
needed for data transmission.)

- Numbers of X Copies * Numbers of Y Copies = The total
amount of image copies

® Copies with outline : To show outlines of image graphics

Figure A3-11

The system will create the as shown in the picture below.

orelDRA (64-Bit) - Untitled-1

File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

[ =T~ =" B b- - H o A B oa0x ~ ® || i@ | snepTo~ M E -

— < - 0 [0 [ b | vmis[milimets =] & 01mm (5 gf2o™m 2t G

[\E‘ ‘Welcome S¢ Unt'rt\ez?f Untit\ezrill - . . —

“" E\— S e it iy il e e e el arere e faler Tt it S

C T T T

L it bl b @

Wy o ‘fi“ ¥ 3

3

S Y axis . | | L]

o, L | L L

$‘ &) L - 4= L

AR | | | L
L8 —>

. t A

&g L . W < 1

‘l [oXaks ] |
Figure A3-12
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Contour cutting through CorelDraw
m Position the paper with registration marks printed by your printer on the GCC cutter.
M Select “Files>Print”.

o CorelDRAW X7 (64-Bit) - Untitled-4
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help
New... Chrl+N - H O # B u% - | i& || snapTo - W@ £ 3 -

Mew from Template... w50
EE 3 = 0 mm ][«

Open Recent * led-2  Untitled-3  Untitled-4

n 3

ClEs e fee e e e o e e o A et T S el e e i e

Close All

Save.. Ctrl+S
Save As.. Ctrl+Shift+5

Fno @a

Save as Template...

Acguire Image » I
ﬂ Search Content
-
gt Import.. Ctrl+1
Gy Export.. Ctrl+E b
Export For 3 ﬁ
Send Te 4 E
J_ U al
e  Publish to PDF
& Ppublish Page to ConceptShare... 12
| Print.. ctip | £
Print Merge 3 f
LEJ. Print Preview... 5
%i% Collect For Qutput... o
BT Rarimen + Deanertice

Figure A3-13
Note: if you use CorelDraw X5 and later, you must follow the steps below.

m Click the “color” page and go to the “Color conversions performed by:” and then select
the model name of you cutter (please refer to Figure A3-14).

S S R SN W I FUR I RN FIP R R I S P ). 0 RS

8 (] Page 1

pe — m—s = S = DMl Clonz Layer
General | Color | Compaste | Layout | Prepress | ez Mo Issues | 8 ® o @Il Mark Layer

i i

@ Print composite

=

(3 Print separations

(@) Use document color settings

roof settings

Color corversions performed by:

8 *— ¢l Layer 1
[ Rectangle

Correct colors using color profile: |tDocument) sRGB IECE1966-2.1 v| Bl | Master Page

* @ Sl Coos

i

alich * G Ml Dsiop
Rendering intent: | Relative colormetric v ~2@ Ond

100

iy Tne color setings and preview avadable i tis diaog bos are st For the Windows Graphic
device printer that you selected on the General tab.

2 [ eocpreven | [] [pit ) [ concel | [ mway ][ teb

POEPAF SO HPOODF L RTE
; " 7 200 g e 3

0

8

2 = o

TBEU O 1af1 B Pagel ] v (@)W N Fi A3-14
(-128.179, 316,087 ) b & XI Igure -
Document colar profiles; RG8: sREB IECE1966-2,1; CHYK: Japan Color 2001 Costed; Grayscale: Dot Gain 15% b Y |
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M Go to the “Layout” page and select Bottom left corner at “Reposition images to”.

Fle  Edit ¥iew Loyout Amenge Effeots Bitwops Text Table Tooks  Window Help

BECE B 6-0 - P T @ [y e £
21000 mm -A@ . = @
T 24 ©otlmm 2
i g 50 100 200 250

10 E 120

ks Print

| General | Color | Composite | Lavout | prepress | (2 Holssues |

=

Image postion and size

fi- © Asin document
OFitto page
Include marks and calibration hars
A @ Reposttion images to;

(7] Settings for Page 1:
Position: Size: Seale factar:

: x [L21adw (o] W [117.291v «| [100 (¥ 2
= y: 65502 v [« | F |111.381¥ & 100 % B

5 i

[Crirt tiled pages

7 [Cpleed lmit:

Tmposition layout: s in document (Full Page)

= PHinE Preview Print, [ canes

CEEPRFAAND NP 00O RT(H

L

BB W 4 10f1 kM B Pagel HES
(-128.179,316.087 ) b
Dacument color profiles: RGE: sRGE IECA1966-2.1; CMYK: Japan Color 2001 Coated; Grayscale: Dot Gain 15% P

9

limesers

< [T N T N | [ e

=

m!}ﬁ
LD

Click “Print’.

Figure A3-15
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lllustrator Plug-In Instruction

AASII VBA Installer is applicable for Adobe lllustrator Version CS4, CS5, CS6, CC.
Installation
Please refer to Step 8 in Chapter 2.1.1.1 Driver Installation to install AAS plug-in for Adobe

Illustrator.

Printer Setting

m Go to Control Panel, right click on the printer and select Printer Properties to open
the Printer Properties page

— — -
. Sy SR
\' |E';3 v Control Panel » Hardware and Sound » Devices and Printers »
Add a device Add a printer See what's printing Manage default printers Print server properties Remove device

4 Devices (2)

MARKET-EILEEMN USB OPTICAL
MNB MOUSE

4 Printers and Faxes (9)

AF e =R AF EE_=H Adobe PDF Bullzip PDF Fax i-Craft Microsoft XPS |
_SHPAR _KYOCERA Printer Document Writer
AR-M450 PCLE F5-2025D KX on
on gpprinter2 gpprinter2

lllustrator Plug-In A-5
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M Go to the Advanced page and make sure the “Enable advanced printing features”
box is unchecked.

r —
sy RXT-1325 Properties

Fen | Paper I AAS In
General Sharing | Ports Advanced ﬂ Color Management I Secu

i@ Always available

) Available from 12:00 AM o 1o 17:00 AM
Priority: 1 : '
Driver: RAT-1325 v || New Driver

@ Spool print documents so program finishes printing faster

(") Start printing after last page is spooled
i@ Start printing immediately

() Print directly to the printer

[T Held mismatched documents
[ Print spooled documents first

[ Keep printed documents

[ Enable advanced printing features I

| Printing Defaults... || Print Processor... || Separator Page...

lllustrator Plug-In A-5
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User Instructions

M Open lllustrator.

M Edit your image and create a contour line (Note: you must have the line width set as

0.001mm).

I°F Transform
=, Afign

Ty Pathfinder

m Click on the image and a

File Edit

New from Template...
Open...
Open Recent Files

Browse in Bridge...

Close

Save

Save As...

Save a Copy...

Save as Template...
Save for Web...

Save Selected Slices...

Revert

Place...

Save for Microsoft Office...

Export..

Scripts

Document Setup..
Document Color Mode

File Infa...
Print...

Exit

Wind Help B -

Sl — rsom B+ corons [

iew
Ctrl+N
Shift+Ctrl+N
Ctrl+0

Alt+Ctrl+0

Ctrl+W
Ctrl+S
Shift+Ctrl+S
Alt+Crl+5

Alt+Shift+ Ctrl+S

F12

Alt+Crl+P

Alt+Shift+ Ctrl+1
Ctrl+P

Ctrl+Q

pp

3

3

Contour line

/

ly the AAS function (File>Scripts=>_AASII_Plug_In).

ExportDocsAsFlach
Flex Skins
ImageTracing
SaveDocsAsPDF
SaveDocsAsSVG

_AASI Plug Tn N

Other Script... Ctrl+F12

lllustrator Plug-In
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M Select the registration marks needed

File  Edi

Make by Page size

¥ 4-Point Poisitioning |

tenathémt: RN (io~s50)
Thidess(mm): i
wargn(o): O (oms0)

Segmental Poisitioning |

xsepm): IR (00~600)
¥ Step(mm): B (z00~s00)

Muiltiple Copies |

No. of X Copies: {1~50)
No. of Y Copies: (150

Copies with outine

M Four types of registration marks are introduced here: 2-Point Positioning, 4-Point
Positioning, Segmental Positioning and Multiple Copies.

AASII_Reg_Mar

[~ Mezkeb

[ 2-Point Pc

4-Point Pc

Thickness(
Margin(mn

Segnienta

[~ Multiple C

m Confirm the registration marks (the 4-Point Position mark is used as an illustration in the
following steps).
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Note:
The values entered in the “4-Point Positioning” section (length, thickness and margin)
will still be applied when you tick “Segmental Positioning” or “Multiple Copies.”

M contour.ai® @ 100% (CMYK/Preview) =

I°F Transform
| Align

Py Pathfinder

$EEM contour.ai* @ 100% (CMYK/Preview) *

T} Transform

|=  Atign

Fiy Pathfinder

lllustrator Plug-In A-5
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B Hit “Edit Artboards”.
Document Setup

Bleed and View Options

Units: | Points

Show Images In Qutline Mode
Highlight Substituted Fonts
Highlight Substituted Glyphs

Transparency
Grid Size: Medium -
Grid Colors; [ Light

Simulate Colored Paper

Preset: [Medium Resolutio..) = Custom...

Type Options
+ Use Typoagrapher's Quotes
Language: Enaglish: USA
Double Quotes: | #” ¥ Single Quotes:

Position
Superscrip

Subscript: [

m Click on “Presets — Fit Artboard to Artwork bounds”.

lllustrator Plug-In A-5
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File

Arthoard

view)

Fit to Artwork Bounds

m Please move your mouse to the tool bar on the left when step 9 is finished and then

click “Selection Tool”.

File Edit Object Type Select Effect
[ o8

Arthoard Presets: Custom v

$HEE M contour.ai* @ 100% (CMYK/Preview) x

§ Selection Teol (V)

1 - Transform

| Align

By Pathfinder

B This will take you back to the edit mode.

Window Help

Name:

lllustrator Plug-In A-5
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File Edit Ob Hep [ [EE-

FiFEM contour.ai* @ 100% (CMYK/Preview) >

T Teansform
|=, Align

By Pathfinder

J Type Select Effect
New... Ctrl+N
MNew from Template... Shift+Ctrl+MN
Open... Ctrl+ 0
Open Recent Files
Browse in Bridge... Alt+Ctrl+0

Close Ctrl+W
Save Ctrl+5
Save As... Shift+Ctrl+5
Save a Copy... Alt+Ctrl+5
Save as Template...

Save for Web... Alt+Shift+Ctrl+5
Save Selected Slices..,

Revert
Place...

Save for Microsoft Office...
Export...

Scripts

Document Setup... Alt+Ctrl+P

M Place the printed file on the cutter, lower the pinch rollers and then position the carriage
at the origin of the registration marks.

M Send the file to the cutter.

lllustrator Plug-In A-5
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Edit Object Type
New...

MNew from Template...

Shift+Ctrl+MN

m Select the cutter model, position the object in the bottom left corner.

Open... Ctrl+0O
Open Recent Files 3
Browse in Bridge... Alt+Ctrl+ O
Close Ctrl+W
Save Ctrl+5
Save As... Shift+Ctrl+5
Save a Copy... Alt+Ctrl+5
Save as Template...

Save for Web... Alt+Shift+Ctrl+5
Save Selected Slices...

Revert F12
Place...

Save for Microsoft Office...

Export...

Scripts »
Docurmnent Setup... Alt+Ctrl+P
Document Color Mode 3
File Info... Alt+Shift+ Ctrl+1
Print... Ctrl+P
Exit Ctrl+Q

D E
wiorm [l & 5ot ound |8

lllustrator Plug-In
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M Your job is now completed.

Print Preset: Custom

Printer: | RXII-1325

Copies: B

Artboards:

Ignore Artboards

Defined by Driver

Orientation:

Options
Print Lay
Placemen

Scaling: Do Not Scale

Add Registration Mark by page size

v Skip Blank Artb

lllustrator Plug-In
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If you want to create registration mark by page size, select the object, go to “Scripts” under
“File” and select “_AASII_Plug_In"

File Edit Object Type Select Effect View Window B mE-

MNew... Ctrl+MN
-

Mew from Template... Shift+Ctrl+N
S PSR - ai* @ 74% (CMYK/Preview)

Open Recent Files 4
Browse in Bridge... Alt+Ctrl+0

Ctrl+W
Ctrl+5
Shift+Ctrl+5
Save a Copy... Alt+Ctrl+5

Close

Save

Save As...

Save as Template...

Save for Web...

Alt+Shift+Ctrl+5

Save Selected Slices...

F12

Revert

Place...

Save for Microsoft Office...
Export...

Scripts Pl ExportDocsAsFlash
Flex Skins

Marimmmant St A4l D

Select “Add the registration marks by page size” and "Draw working area” to create a red line

frame along with the registration mark to prevent the printed image falling out of the boundary,
and click on “Apply”.

AASII Mark Setting V2.11-07 =

Add Registration Mark by page size

Draw working area

.2 @ 74% (CMYK/Preview) * [~ 2-Point Poisitioning (Feeder model only)

4-Point Poisitioning

Length{mm):

IF Transform

=, Afign

By Pathfinder

lllustrator Plug-In A-5
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HwNxv g

.
P®
»
D/.
&,
&
()
B
¥ |
%
Lalt,
2

»
@,
j;
°
¥ Q
B

Note:
The length setting will be in the range of 10-50mm according to your page size.

Workable area
It allows users to edit and cut graphics in the area outside the registration marks when adding
registration marks by page.

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on
left and right sides and 4.5mm extended from the registration mark on top side. On the bottom
side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent
sheets dropping or any error occurred while media sizing.

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the
left side, 9mm extended from the registration mark on the right side and 11mm extended from
the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm
margin from the edge of media sheet to prevent sheets dropping or any error occurred while
media sizing.

lllustrator Plug-In A-5
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Print Preset: |Cust0m B | B
Brinter | Jaguarlv-101 ~

FPD:

General
e Caopies: Colate [CReverse Crder
Output @l [ignare Artboards
araphics -
Color Management Ranoge: | | Skip Blank Artboards
Advanced )
Surnrnaty — Media

¢ Driver Transyerse

et Heoht EEL[E]

— Dptions
Placermert: x |U pt | At |D ot |

(% Do Mot Scale
(JFit to Page  (483.8058%)

O Custom Scale: W ] H:

O Tie Full Pages Querlap: | 0t
Scale: W B H:
Tile Range: | |
44 1oFLi)
Print Layers: |\fisible & Printable Layers V|
[ print ][ cancel ] [ Done |

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. If
you select “Single” mode, the media sheet will not be able to be moved back and hence
fail to be detected by front paper sensor.

Add Registration Mark by Object

If you add registration mark by Object, you will be offered three options of registration marks.

Firstly, select the graphic which you want to add registration mark on and go to “Scripts” under
“File” and select “_AASII_Plug_In".

lllustrator Plug-In A-5
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Edit Object

Type

New...

Mew from Template...

Open Recent Files

Close

Save

Save As...

Save a Copy...
Save as Template...
Save for Web...
Save Selected Slices...

Revert
Place...

Save for Microsoft Office...
Export...

GreatCut 3

Ctrl+N
Shift+Ctrl+N
Open... Ctrl+0

Browse in Bridge... Alt+Ctrl+ 0

Ctrl+W
Ctrl+5
Shift+Ctrl+5
Alt+Ctrl+5

Alt+Shift+Ctrl+5

Scripts

ExportDocsAsFlash

Document Setup... Alt+Ctrl+P

Make sure to untick “Make by page size” and choose one of the registration mark types

whichever is suitable.

Make by Page size

¥ 4-Point Poisitioning |

Length(mm):

I (10~50)
Thickness{mm): (1~32)
O (o~s0)

Segmental Poisitioning .

Margin(mm):

¥ Step(mm):

¥ Step(mm):

Multiple Copies |

Mo. of X Copies:
Mo. of ¥ Copies:

ECHM (200~600)
ECH (200-~600)

Make by Page size
W 4-Point Poisitioning |
oot R o

Thickness(mm): _ (1~7)
Margin{mm}: _ (050

Segmental Poisitioning |

xstep(om): VRSN (500~600)
vsepom):  ETIEN (200~600)

Multiple Copies |

No. of X Copies: _ (1~50)
Mo. of ¥ Copies: _ (1~50)

Three types of registration marks

4-Point Positioning

4-Point Positioning

/® Length: The length of marks

- Range: 5Smm~50mm
- Optimized Setting: 25mm

® Thickness: The line thickness of marks
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The system will create the 4 marks as shown in the picture below.

BN .2 @ 74% (CMYK/Preview) x

T Transform

=, Afign

Py Pathfinder

Note:

1. To save your materials, in addition to amending object margins, you can also adjust the
length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see
table 1 for suggestions based on different material sizes). The smaller the size is, the
smaller the distance between the object and the registration marks is (see the figures
below).

lllustrator Plug-In A-5
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Area to be cut

Page size Suggested mark length
(unit: mm) (unit: mm)

A6 (105 x 148) 5

A5 (148 x 210) 8

A4 (210 x 297) 11

A3 (297 x 420) 16

A2 (420 x 594) 23

A1 (594 x 841) and above 25%

Table 1

*25mm is the suggested value for the registration mark length

2. The size of the registration marks would affect the accuracy of registration mark detection so
please make sure the amount you enter is reasonable.

3. If you change the paper size, you will have to reset the registration marks otherwise the
previous setting will be applied.

Segmental Positioning
For precise cutting quality, it is suggested to select “Segmental Positioning” when you are
working on an extra long or large-sized image to increase cutting accuracy.

lllustrator Plug-In A-5
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' Make by Page size

Segmental Positioning

4-Point Poisitioning | ® X Step: The distance of intermediate position on the X
axis
Length{mm): {1050} ; ; i iti
I ® Y Step: The distance of intermediate position on the Y
e T axis
Margin{mmy}:
u - Range: 200mm~600mm
N e P | - Optimized Setting: Less than 500mm
xstepm):  ETHENN (200~600)
Ystepm):  ETIEEN (200~600)
The system will create the marks as shown in the picture below. Segmental Positioning

Peoof 04 85

% Untitled-2*

Multiple Copies
It is suggested to select “Multiple Copies” when you would like to make several copies of one
image on your material to increase cutting accuracy.
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Make by Page size

4-Point Poisitioning |

Multiple Copies
Lengthmm): — ECHEEN (10~50) ® No. of X Copies: The numbers of copies on X axis
Thidnessmm): - [ (1.7 ® No. of Y Copies: The numbers of copies on Y axis
Margingr): — CHEE o500 - Range: 1~50. (The more copies you make, the

more time is needed for data transmission.)
- Numbers of X Copies * Numbers of Y Copies =

Segmental Poisitioning |

xsep(mm):  EEJ (zo0~s00) The total amount of image copies
N — I 200-c00) ® Copies with outline : To show outlines of image
graphics
¥ Multiple Copies | ® Margin: Space between marks; must be 0 or = 20,

no negative numbers allowed

Mo. of X Copies: _ (1~50)
Mo. of Y Copies: _ {1~50)

The system will create the as shown in the picture below.

® SptRound [hd - sv= - Document Sstup

lllustrator Plug-In A-5
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GreatCut Plug-In Instruction

The user manual of GreatCut software is available on GCC website download area.
https://www.gccworld.com/download.php?act=view&id=20

x‘ Company Applications Products Technology Support Contact Link ® e~ Q
-

Tech Support

Download Area

Product Termination Policy

Out of Warranty Service

Download Area 24

Download Area

enter keywords to search Q, SEARCH

Or browse by machine model

Vinyl Cutter Laser Engraver Laser Cutter

GreatCut Plug-In A-6
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Download Area v

I VinYI Cutter Vinyl Cutter v

e
ot

Expertll A i-Craft™ 2.0 AR-24 Expert Il

Puma IV Jaguar V [ Jaguar V (PPF) RX Il / RX Il (Creasing)

Title Size Download
Jaguar v User Manual (V1.0) 18.8MB Download
Jaguar V PPF User Manual (V4.0) Download
Jaguar V PPF User Manual Simplified Chinese (V3.0) 265MB Download
Jaguar V User Manual Simplified Chinese (V11.0) 15.8MB Download
GreatCut 4 User Manual_English 3.4MB Download
GreatCut 4 User Manual_French 43MB Down!ocdm

GreatCut Plug-In A-6
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GCC AASII System
Below is a step-by-step instruction of using the AAS function in GreatCut software through
CorelDRAW and Adobe lllustrator.

Edit your image in CoreIDRAW

4-Point Positioning
M Create a new file in CorelDRAW and click on the Create contour icon on the GreatCut
toolbar (it would appear automatically once CoreIDRAW is open).

ﬂ CorelDRAW X8 (64-Bit) - Untitled-1
Eile  Edit View Layout Object Effects Bitrmaps Text Table Tools Window  Help

Ch-@& FaBig O B OLHF e | m S sk & ]
148,506 mm W 231,184 mm 100.0 | % ; oo

Q i s 1S T - N

Eﬂ Ve 112961 mm : 173.286 mm 1000 |% ll O 0.0 E'i‘ =] I=J L_I_Ll % G % I:I D % @ .

Z|HE e PO 4

i\‘ Createcontour[

A S i

0

SN |BOZ | >» 000X |G O

M Complete contour line settings (including contour offset value) and press Calculate to
confirm.

GreatCut Plug-In A-6
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Contour Line x
Find Contour Calar
MaHimum ” Scale Z -
< >
Background Tol - > Change...
recognition olerance 4
ACCUrACY: ey high [slower) w

[] Keep interior elements Contour offset is the distance

Distance and Line Guidance Estended... between the object and the

v

Contour offset: contour line.
Cancel
Correr Marmal
Calculate
Contour lines will be added to the images.
2 CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help
FE-dd By 5 5~ B[ [ Er s ~ ® iz BE 7| snapTo v {3 [ Launch ~
%:[148.253 mm wa| 236402 mm | (1000 |% ; . = ,
B V. 113399 mm fl78a05mm 1000 % B O[00 S | 000 e A =D &

A, BB w4 e ODFNL A
Q“ ' Untitle_d-1

I Ia“. R i ."l”. S

100

o

SN BUG > 00N GO

Tips: Vector object to create round outline

GreatCut Plug-In A-6



GCC.. Appendix

In general for vector objects you will get better results with the outline function. You will

see the difference between "Normal" and "Round" in sharp corners. The picture is shown
as below:

&

Normal Round

1. Click the “Create outline” to create contours in a freely definable distance around text
objects.

Outline ‘L P
777777777777777777777777777777777777777777777777777 Offeet: S0 = [~ Automatic welding

GreatCut 3 x [~ Delete original
8 15 e : Copies: 1 . .
B E o e D]}"ﬁ 5 * [ Ignore inner objects
|

" Outline " Do not modify corners
{* Inline " Ccut corners
" Outline & Inline F{uund COrmers
Pt Target I
elete objects -
T 200 mm |Tolerance -E- . ~

2. Select “Round corners” and set the value of “offset” and “tolerance.”
Offset is the value for the distance of the inline and outline from the original object.

The field tolerance indicates in which offset from the corner dot is cut respectively
rounded.

m Press the Settings icon on the GreatCut toolbar.

GreatCut Plug-In A-6
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E CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

Co-ddb Blos B O] [ & |52 ~ ® 2 B |2 SnapTo v {3 [F] Launch ~
Si[297.0 v .. | w50 —
Al - E 210.0:: .. O o Rl Units millimeters = a8 0.1mm | 2 ‘?‘:'S.O Z: ==

h, & B o= o4 m%":'uz%
4, & Untitled-1 Settings
2 w . 'E"'. P fic 50 2

M R o e

dr et s

N BLOg P 000G LA

y 7 )
(-13.108,212.803) b D

m Press the button on the right of Jog marks.

Settings .
Eurosystems Software: Great_D_rt 4 =
N
Jog marks: |G[I:{Nl5 Iy ( ) |
N
Export Path: | |

Mame of layer for Jog Marks: |HEQITIEN'|'C |

Name of layer for Outline: |0Lft|iﬂE |

Output Parameters ..

Show always contour and outline settings
During the cut process only transfer "Regmark” and "Outling” layer
Create new file while cutting [ ]

Open output dialog while cutting [

Cor

MAdjust the size, object margin and line thickness of your registration marks in the

GreatCut Plug-In A-6
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Setup-Jog Marks window and click OK.

Setup - Register Marks X 4-Point Positioning
. _ ® Size: The length of marks
Type |GCC (AAS ) v - Range: 5Smm~50mm

- Optimized Setting: 25mm
® Object margin: The distance

@ Align to selection

O Align to working area

Size 25.00 m
Object Margin mm

Line thickness 1.00

between marks and images
- Range: Omm~50mm
- Optimized Setting: 5Smm

Outzide corners

Qutput marks (or by pressing Ctrl)

s 21000 | mm [ Line thickness: the line thickness
Max. ¥ distance mm Target layer | . I V| of marks
- Range: 1mm~2mm
Cancel - Optimized Setting: 1mm

m Ensure the three items below are selected and click OK.
Settings .

Eurosystems Software: | GreatCut 4 w

Jogmarks: | GCC (AAS 1) |

Export Path: | |

Mame of layer for Jog Marks: |HEQITIEN'k |

Name of layer for Outline: |0Lft|il‘IE |

Output Parameters ..

Show always contour and outline settings

During the cut process only transfer "Regmark” and "Outling” layer

Create new file while cutting [/]

Open output dialog while cutting [

Cor

SiCTel Click the Set Jog Marks icon on the GreatCut toolbar.

GreatCut Plug-In A-6
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E CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Teols Window Help

il R - B - MMM ox <M B e O Lk -
a4 - Fomm o O (o) [ L Unis[milmetes <] @ 01mm [2] @iomm s

M 5.0 mm
Rl GO S S -4

i L
Set Jog Marks |

Ilil]_

sl e N s e e allia e

SN BLDZ

The system will create the 4 marks as shown in the picture below.

E CorelDRAW X8 (84-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

- CRIOR B WM % v m SB[ s & F e -
/4200 = . T =7 | he|50 e
A3 hd 10/2970 z: =5 D [} q_h [|u[| Units:| millimeters  + 1@» 0.1 mm = Q: 5.D$: sz ]:(.

R, B w4 e’ 0F DL 4
Q“ F 3 U_nt_itled-1

B

250

aatlith

R

et

PN BOgg > 000 GO

Note:
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1. To save your materials, in addition to amending object margins, you can also adjust the
length of the registration marks (5mm minimum) when you apply the above function(see
table 1 for suggestions based on different material sizes). The smaller the size is, the smaller
the distance between the object and the registration marks is (see the figures below).

B

r

Page size Suggested mark length
(unit: mm) (unit: mm)

A6 (105 x 148) 5

A5 (148 x 210) 8

A4 (210 x 297) 11

A3 (297 x 420) 16

A2 (420 x 594) 23

A1 (594 x 841) and above 25*

Table 1

*25mm is the suggested value for the registration mark length

Area to be cut

2. The size of the registration marks would affect the accuracy of registration mark detection so
please make sure the amount you enter is reasonable.

Output

GreatCut Plug-In
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M Select both the entire object (including registration marks and the contour line) and press
the Cut icon on the GreatCut toolbar.

ﬂ CorelDRAW X8 (B4-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

E-dd F Bl 5~ B D[ [ ~ W B§ 7| sneplo » O ] Launch ~

B EEm | e, ok o w g W DREBETG 4 [ 8w
A B OB than’mgﬂ Es

¢ A Untitled-1 T

& S .‘—C—tl. L L L e i
i

Q

B,

Al

D]

[k

)

Bl

Al

bl

N

B

Ca)

P

M The system will activate GreatCut automatically and import the registration marks and
contour line to GreatCut.

)

P

)

P

)

loas2a2222220022022022322222

W+=+ W: 295.40 mmx H: 237.41 mm, Objects: 1 +++
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Sl o] Select Output under File.

= GreatCut 4 - [(untitled - 1) %]

100

200

Assign_

200 400

500 600 700

New... Ctrl+N

| §§ Open.. Crl+L
Save Ctrl+S
Save As... Shift+Ctrl+5

il 5end by Email...
Import. Ctrl+|
Export.. Ctrl+E

™ Output.. s
Quit Ctrl+Q

g ]

24

o ]

=}

|

g ]

=

B e s

B

(0

[olsa

it to device GC
Output
Device: | GCC Jaguar WV LX 61 ~
IindE' Cut with AAS w

Output Profile: | Foil

Manage Profiles .

T~

Number of outputs:
MNumber of copies:
Stack spacing:
Weed border:

Copies spacing:

Output only tool-assigned layers
|:| Keep reference point
[ Piot to file
Enable tool tips

|:| Wait after segment

Save settings

‘arameter

Complete the settings of AAS

AAS Offzet origin X [mm] 0.00 Oﬁfset Pressure Speed
AAS Offset origin Y [mm] 0.00 ’ ’ ’
ekl 15 Material width and so on.
Speed [cmis] 50
Material width [mm] 20843 S oo
Length [mm] 32018 o Ophons:
Number of cutputs in X-direction 1
Number of cutputs in Y-direction 1
Distance between copies [mm] 10.00
Step count 1
Accuracy: | Normal w
Origin:  MWew origin |
Objects: | All obiects e
Job wil be segmented! Test drive
Preview... Output Read material Cancel

GreatCut Plug-In

A-6
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B Click output and the object will be sent to GCC Cutting Plotter.

Output

Device: | GCC Jaguar W L 61

Mode: | Cut with AAS

Output Profile: | Foil

Manage Profiles ..

MNumber of cutputs:

Number of copies:
Stack spacing:

Weed border:

Copies spacing: mm

Parameter

AAS Offset origin X [mm]

AAS Offset origin ' [mm]
Pressure [g]

Speed [cmis]

Material width [mm]

Length [mm]

Number of cutputs in X-direction
Number of cutputs in Y-direction
Distance between copies [mm]
Step count

Value
0.00
0.00

15
50
20843
32018

10.00

Preview...

Job will be segmented!

Output

Read material

X

Output only tool-assigned layers
[ Keep reference point
[[]Piot to file
Enable tool tips

|:| Wait after segment

Save settings

Sort before output

Actual Setting:

Sort Options.

Accuracy: | Mormal w

Origin:  Mew origin |
Objects: | All obiects ~

Test drive

Cancel

GreatCut Plug-In
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Note: The difference amount Number of outputs, Number of copies, and Step count in the

Output window.

Output
Device: | GCC Jaguar W LX 61 v Number of outputs: 1 Output only tocl-assigned layers
Number of copies: 1 D Keep reference point
Mode: | Cut with AAS w - [IPiot to file
Stack spacing: 0.00 {mm
] Enable tool tips
Cutput Profile: | Foil e oy A
Copies spacing: mm |:| Wait after segment
Manage Profiles ... Save settings
Parameter Value Sort before output
AAS Offzet origin X [mm] 0.00 .
AAS Offset origin ' [mm] 0.00 Actual Setting: IU
Pres=zure [g] 15 L
Speed [cm/s] 50
Material width [mm] 208.43 R
Length [mm] 12018 ort Options.
Number of outputs in X-direction 1

Number of outputs in v-direction

j een copies [mm] 10.00
l Step count 1

Accuracy: | Mormal w
Origin: | New origin B
Objectz: | All objects w
Job wil be segmented! Test drive
Preview... Output Read material Cancel

1. When Number of outputs is set as 2, the square and the triangle will be cut 1 time
and then the square and the triangle will be cut 1 time at next position.

2. When Number of copies is set as 2, the square and the triangle will be cut 2 times at
the same position.

3. When Step count is set as 2, the square will be cut 2 times at the same position and
then the triangle will be cut will be cut 2 times at the same position.
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Advanced Settings

Segmental Positioning

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x
and y distance when you are working on an extra long or large-size image to increase cutting
quality.

Follow the same steps in the 4-Point Positioning section to complete the contour line setting
and registration mark creation procedures. Adjust the size, object margin and line thickness of
your registration marks and the space between registration marks by changing X, Y distance in
the Setup-Jog Marks window and click OK.

M Press the Settings icon on the GreatCut toolbar.

m CorelDRAW X8 (64-Bit) - Untitled-1
File  Edit View Layout Object Effects Bitmaps Text Table Tools Window  Help

fBe-ad Eloz B L]0 er [s2% - W B selo » 3 [E] Leunch -
= 297.0 G : = = | B/50 =
Ad - E 310.0 ;$ i O O Byl lap  Units|millimeters = <8 0.0 mm | 5 q,‘: 50 xg arv S

NS 4P e O |l
¢, A Untitled-1 Settings

o I\‘U.

e

D | BIENe [l O ) Fie ] 508

» A
(-13.108,218.803) » ab

GreatCut Plug-In A-6



GCC.. Appendix
M Press the button on the right of Jog marks.
Settings X
Furosystems Software: | GreatCut 4 -
Jog marks: |GCC (AAS II) | O
Export Path: | |

Name of layer for Jog Marks: |Hegmark |

Mame of layer for Outline: |OL¢|“"E |

Output Parameters...

Show always contour and outline settings
During the cut process only transfer "Regmark” and "Outling” layer
Create new file while cutting [

Open output dialog while cutting []

==

MAdjust the size, object margin and line thickness of your registration marks in the
Setup-Jog Marks window and click OK.

Setup - Register Marks

Type |GCC (AASI)

@ Align to selection

O Align to working area

Size 25.00 | mm
Object Margin o

Line thickness

1.00

Wax. X distance EUD.DE R

ax. ¥ distance

mm

ped
Segmental Positioning
® Max. x Distance: The distance of
intermediate position on the X axis
- Range: 200-500 mm
Ja LS ® Max. y Distance: The distance of
Oulipck marks: (i By presswg Ci) intermediate position on the Y axis

v

- Range: 200-500 mm
Target layer |' ] v|

Cancel

GreatCut Plug-In
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m Ensure the three items below are selected and click OK.
Settings d

Eurosystems Software: | GreatCut 4 w

Jog marks: |GCC (AAS 1) |

Export Path: | |

Mame of layer for Jog Marks: |HEQ|T|E"'|‘I |

Mame of layer for Outiine: |0L¢"”E |

Output Parameters...

Show always contour and outline settings
During the cut process only transfer "Regmark” and "Outline” layer

Create new file while cutting [/]

Open output dialeg while cutting [ ]

Core

m Click the Set Jog Marks icon on the GreatCut toolbar.

2N CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

FrH-d g B o~ B LM [2x v m /8 2 swh- O FLunh -
Ad - %ﬁggm: :: O &0 B lep  Units: millimeters  ~ <@ 01mm | 2 % ggm: :: B
LY Y ORI E s s R

z 2 o mrre )
Set Jog Marks |

B,

e

> 000N GO

SR

SN BLOO
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The system will create the marks as shown in the picture below.

ﬂ CorelDRAW X8 (64-Bit) - DAGCC-Cutter\GreatCut 4\Untitled-1.cdr

File Edit View Layout Object FEffects Bitmaps Text Table Tools Window Help

e~ d 4 B 5~ B Q][O 2 7 ~ u R B
mental Positionin

- =l q Segmental Positioning

k, @ 4 M a”
A Untitled-1.cdr

e Bl i ] b B e R e e T et ] L

s

Y

G0

Y

tv,
I-'-
Q
)
A
)

i

L
QG

N

S
A00

)
A |
R, 5

w

Follow the same steps in the Output section to output your image to GCC Cutting Plotter.

Multi-Copy

m Follow the same steps in the 4-Point Positioning section to complete the contour line

setting and registration mark creation procedures.
Setup - Register Marks >

—

Type |GCC (AAS I v

@ Align to selection

Size

Outside corners.

Object Margin

Cutput marks (or by pressing Ctrl)

Max. X distance 600.00 | mm
Max. ¥ distance 600.00 | mm Target layer | 1. [N V|
Cancel

When you apply the “Multiple
Copies” function, the value that
has been set in this section will
still be applied.
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M Click on the Set Jog Marks icon on the GreatCut toolbar and 4 marks will be created as
shown in the picture below.

m CorelDRAW X8 (84-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

FrH-ada B - OO e v m LSBT sl & [ Lanen -
2970 = . z . =] | ®/50 =
Ad - 0 210.0&2 == |:| | |:|'_"J_-| Uu[l Units:| millimeters  ~  <0v| 0.1 mm = Q':S.Om: v E

k, Fl .
) Untitl_ﬁ:f-]

S e

sl

> o0O0ex Go4

BUg

N

b

g

E CorelDRAW X8 (64-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

(FH-d o 5 o5 O [ - m (S8 [ selor & [ Lenen -

4200 == : = & = | B[50 =
A3 hd 0 297.0 2: iy O = By leg Units millimeters = <& 01mm | 2 Q“Y'S‘Om: sz It
R, BRI e A4Re’ DD A

¢ A& Untitled-1
‘A 2 T

=
=
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> 000N GO
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S1G o Select both the entire object (including registration marks and the contour line) and press
the Cut icon on the GreatCut toolbar.

ﬂ CorelDRAW X8 (B4-Bit) - Untitled-1
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

- dd 7y & 5~ B[] [ B |s% ~ W S BE % sSnaplo» & [F]Launch =
%:[209.753 ven| 295,402 000 |% [ : S
H Sy §23?.405:: 1000 (% B O[00 © o E LBt ¢ [=] & = &

N B[R DD A
N A Untitled-1 B=
4l 250 2 5 | EES

koS

Gl A PR AT A

il

N BLOS | P 000 NG OH

m The system will activate GreatCut automatically and import the registration marks and
contour line to GreatCut.

o

o

o

1222999299992999999999939

-+ WW: 285 40 mm x H: 237.41 mm, Objecls: 1 +=+
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B Select Output under File.

—e—
== GreatCut 4 - [(untitled - 1) *]

MNew... Ct
Open... C
Save C
Save As... Shift+C
Send by Email...
Import...

Export... C
Print... i

m Select Mode as “Cut with AAS” and input the Number of outputs in X-direction and
Y-direction and Distance between copies, please don’t press output button.

Qutput to device GCC i

Device: [ GCC iCraft

- Number of cutputs:

I Mode: | Cut with ALS

Number of copies:

Output Profile: ’Fnil

[ Manage Profies ...

= Stack spacing:
l |:| Weed border:
w
Copies spacing:
] Segment spacing:

5.00 mm
2.00 mm
2.00 mm

0.00 mm

Parameter Value
AAZ Offset origin X [mm] 0.00
AAS Offzet origin % [mm] 0.00
Pressure [g] a0
Speed [cm/'s] 21
Material width [mm] 208 43
Length [mm] 32018
Number of cutputs in A-direction 2
Number of cutputs in Y-direction 2
Distance between copies [mm] 0.00

Step count

S o Back to CoreIDRAW, Click Multi-Copy on GreatCut under File.

N BE e P

1305 4

¢, A Untitlg Multi—Cop)ri
AT s h—

Output onh

Keep refer
[ Piot to file
Enable tool
|:| Disable ser
[T]wait after ¢

Sort before

Actual Setting

|:| Search for

L

Accuracy.

Qrrigin:

GreatCut Plug-In
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SiCTek:] Complete the Number in X/Y (the number of copies desired on the X/Y axis) and
Distance in X/Y (distance between each copy) settings then click OK. Confirm that the
value of Distance in X/Y must be the same with step 6.

Multi-Copy ot
Mumberin X |2 =
Mumberin ¥ |2 =
Distance in X |0.00 = mm
Distancein ¥ |0f =il mm
Distance to object
Conca

Note: The spacing of vertical & horizontal (Offset X & Y) should be = 20mm or = 0Omm; users are
advised to set the Distance in X/Y as 0 mm to remove the space between each copy to
avoid the waste of materials.

M The system will create several copies of the object with registration marks as shown in
the picture below.

ﬂ CorelDRAW X8 (64-Bit) - C:\Users\jim.you\DesktopUntitled-1.cdr
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help

Fo-dd m oo L s | S 8[E seb- O e -
=1.180.0 = o n — | B[50 =
AD - E AT mrr:m 0O o %l Units millimeters = <G 01mm |2 %: i :: = Hlbm

A HE =24 da OFD A4

Untitled-1.cd
Q“ ﬁ ntitle :._c r

U = SO S ... i H P vt e SR e et S bt T v e S st A et s

210

a0

Do E e b ERE 1k
1 ol

N BOO
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M Print the Multi-Copy images out, and put the printed media on the GCC cutting plotter.

oY corelDRAW X& (64-Bit) - Untitled
Edit View Layout Ob
@ New.. Ctrl+N
E® MNew from Template...

Open.. crl+0

]

Open Recent »

Close
Close All
Save... Ctri+5

Save As. Ctrl+5shift+5

RO %O

Save as Template...

Acguire Image 3
Search Content

Import... Ctrl+|
Export... Ctrl+E

EEA

Export For »
Send To 3

E°F publish to PDF

[y erint.. ctri+p
Print Merge ’

(4 Print Preview...
:: Collect For Output...

s= Document Properties,..

") Exit Alt+F4

M Go to GreatCut window, press Output button.

Ouput o cevice GCC ol ———

Output
] = =

Device: [GCC iCraft v] Number of cutputs: 1 Output onh
' Mumber of copies: 1 Keep refer

| Mode: [::ut with AAS v] i [ Piot to file

Stack spacing: 5.00 mm

Enable tool
Cutput Profile; ’Fnil vl D CERLITIES 200 |:| Disable ser

Copies spacing: 200 mm [ Watt after

[ Manage Profiles ... ] Segment spacing: 0.00 mm

Parameter Value Sort before
AAZ Offset origin X [mm] 0.00
AAS Offzet origin % [mm] 0.00 Actual Setting
Pressure [g] a0 ]
Speed [cmis] 2l D Search for
Material width [mm] 208 43
Length [mm] 32018 :
Number of cutputs in X-direction 2
Number of cutputs in Y-direction 2
Distance between copies [mm] 0.00
Step count 1

Accuracy.

Qrrigin:
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Edit your image in Adobe lllustrator

4-Point Positioning

m Create a new file in Adobe lllustrator.

File Edit ect Hep [ = 4

e . R oot e > o [l | Documert st || prferences |

greatcutd user manual photo.ai* @ 85.56% (CMYK/GPU Preview)

OHw Y

-

Edit

Mew from Ternplate...

Open...

Shift+ Ctrl+N

Ctrl+M

Ctrl+0

/GPU Preview) X

Swatches

L

Vs

[_ Open Recent Files
71 Browse in Bridge... Alt+Ctrl+0
4 Close Ctrl+W
T : Save Ctrl+5
Save As... Shift+Ctrl+5
|2
- Save a Copy... Al+ Ctrl+5
o py.
= Save as Template...
'-‘-q-\, Save Selected Slices...
X Revert F12
=E Search Adobe Stock...
Place.. Shift=Ctrl+P
Export
Export Selection...
GreatCut 4
Bockaoe. Alt+ Shift- Ctrl+P M ating
Contour
Scripts
Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mode 2
Outline
File Info... Alt+Shift+Ctrl+| Welding
Print... Ctrl+P Create Outline-Layer
Exit ctil+Q Epoe
Settings

e

B Fell

e

GreatCut Plug-In
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m Complete contour line settings (including contour offset value) and press Calculate to

confirm.
I Find Contour Color
b arimum gray scale 97 A .
1 [l *
B ackground = E
I recognition Tolerance |0 A
] P
Accuracy: [,\IEW I ,] Contour offset is the distance
between the object and the
[ ] keep interior ele *» contour line.
Digtance and Line Guidance E e
Contour offzet: il mm -

Contour line is now added to the object.

File  Edit £ Typ ffe Window Hep [ Bl B2~ 4

an (2]~ st i - ™ - ©

greatcutd user manual photo.ai* @ 85.56% (CMYK/GPU Preview) X
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Tips: Vector object to create round outline

In general for vector objects you will get better results with the outline function. You will
see the difference between "Normal" and "Round" in sharp corners. The picture is shown
as below:

&

Normal Round

1. Select the “Outline” in GreatCut option under File to create contours in a freely
definable distance around text objects.

Qutline ‘[ 0[]
Offset 200 mn) B ARy
[~ Delete original
Copies: 1
: [~ lgnore inner objects
GreatCut 4 ¥ Cut
: : ) ~
Package... Alt+Shift+ Ctrl+P Direct cutting " Outline Do not modify corners
Scripts 3 Centour + Inline (™ Cut corners
= = P Multi-Copy " Outling & Inline Ruund corners
ocument Setup... t+ Ctrl+ Set Jog Marks £ L
File Info... Alt+Shift+ Ctrl+| elele ohjecis
Welding smaller than: 2.00 mnI Tolerance E- 0 |_j
Print... Ctrl+P Create Qutline-Layer
Exit Crl+Q Export oK | cancel |
S

2. Select “Round corners” and set the value of “offset” and “tolerance.”
Offset is the value for the distance of the inline and outline from the original object.
The field tolerance indicates in which offset from the corner dot is cut respectively
rounded.

M Click Settings on GreatCut under File.

GreatCut Plug-In A-6
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File Edit Object Type
MNew... Ctrl+M
Mew from Template... Shift+ Ctrl+N
Open... [/ FYo N /GPU Preview)
Open Recent Files >
Browse in Bridge... Alt+Ctrl+ O
Close Cirl+W
Save Ctrl+S
Save As... Shift+ Ctrl+5
Save a Copy... Alt+Ctrl+5
Save as Template...
Save Selected Slices...
Revert
Search Adobe Stock...
Place... Shift+ Ctrl+P
Export
Export Selection...
GreatCut 4 >
Package.. Alt+Shift+ Ctrl+ P Hlicek s tiking
Scripts ¥ Contour
Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mode » -
i ) Outline
File Info... Alt+5Shift+ Ctrl+| Welding
Print... Ctrl+P Create Qutline-Layer
Exit Cti+Q e
Settings
M Press the button on the right of Jog marks.
Settings x

Eurosystems Software: | GreatCut 4

Jog marks: |GCC (AAS 1)

Export Path: |

Mame of layer for Jog Marks: |HEQ|T|3F|‘I

Name of layer for Outline: |0L¢|iI'IE

Output Parameters...

Show always contour and outline settings

During the cut process only transfer "Regmark” and "Outline” layer

Create new file while cutting [

Open output dialog while cutting [

Cancel

GreatCut Plug-In A-6



GCC..

Appendix

MAdjust the size, object margin and line thickness of your registration marks and click OK.

Setup - Register Marks

[
Type |GCC (AASI) p
@ Align to selection
([
O Align to working area
Size 25.00 [ mm
Object Margin mm Outzide corners
Line thickness 1.00 | mm Output marks (or by pressing Ctri) °
Max. X distance 800.00 | mm

Max. ¥ distance 600.00 | mm Target layer |_ v|

H

K Cancel

STl Ensure the three items below are selected and click OK.

Settings

Eurosystems Software: | GreatCut 4

X 4-Point Positioning

Size: The length of marks

- Range: 5mm~50mm

- Optimized Setting: 25mm
Object margin: The distance
between marks and images
- Range: Omm~50mm

- Optimized Setting: 5mm
Line thickness: the line thickness

of marks

- Range: 1Tmm~2mm

- Optimized Setting: 1mm

Jog marks: |GCC (AAS 1)

Export Path: |

Name of layer for Jog Marks: |HBEIITIE"1<

Name of layer for Outline: |Out|ine

Output Parameters...

Show always contour and outline settings
During the cut process only transfer "Regmark” and "Outline” layer

Create new file while cutting L]

Open output dialog while cutting [

Cancel

GreatCut Plug-In A-6
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S1GIK: Click Set Jog Marks on GreatCut under File.

Type Select . Vindow Hep [ B BE -

Ctrl+N

Mew from Template... Shift+Ctrl+N
Open... [a1/FYo I /GPU Preview) ¥

File | Edit

Object

MNew...

Open Recent Files »
Browse in Bridge... Alt+Ctrl+0

Close Ctrl+W

Save Ctrl+S

Save As... Shift+Ctrl+5S

Alt+Ctrl+S

Save a Copy...
Save as Template...

Save Selected Slices...

Revert

Search Adobe Stock...

Place... Shift+Ctrl+P

Export

Export Selection...
GreatCut 4 »
Package... Al Shift+ Ctrl+ P RiEch ditg
Sermit o Contour
Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mode 3 z
Outline
File Info... Alt+Shift+Ctrl+| Welding
Print... Ctrl+P Create Outline-Layer
Bxit ctrQ bupart
Settings

File Edit Object Type Effect Window [Br] = o

L BRI —— uniiors B @ ouch Calio.. K 100%

greatcut4 user manual photo.ai® @ 85.56% (CMYK/GPU Preview) X
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Output

M Select both the entire object (including registration marks and the contour line) then click

Cut on GreatCut under File.

File = Edit Object Type & ! V Wi Help ] | - ’4'

Ctrl+N
v P Opacty: 100%

New...

New from Template... Shift+Ctrl+N
Open... (a7 /GFU Preview) X
[_ Open Recent Files >

Browse in Bridge... Alt+Ctrl+0

Close Ctrl+W

Save Ctrl+5

Save As... Shift+Ctrl+5 WE—
Save a Copy... Alt+Ctrl+5

Save as Template...
Save Selected Slices...
Revert F12

Search Adobe Stock...

NEH¥IRDHN bV

Place... Shift+ Ctrl+P

Export >

Export Selection... :

GreatCut 4 2

Pactager, Alt+Shift+ Ctrls P BleEing,

Seripts 5 Contour
Multi-Copy

Document Setup... Alt+ Ctrl+P Set Jog Marks

Document Color Mode » =
Outline

File Info... Alt+Shift+ Ctrl+ Welding

Print... Ctrl+P Create Outline-Layer

Bt Cti+Q e l
Settings —

M The system will activate GreatCut automatically and import the registration marks and

contour line to GreatCut.

+++ W 295.40 mm x

H: 237.41 mm, Objects: 1 +++

GreatCut

Plug-In A-6
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Sl o] Select Output under File.

=t (GreatCut 4 - [(untitled - 1) *]

i

]

alru)

100 200

300

New... Ctrl+M
Open... Ctrl+L
Save Ctrl+5
Save As... Shift+Ctrl+5
Send by Email...

i Import... Crl+|
Export... Ctrl+E
Print... Ctrl+P
Output... 5
Quit Ctrl+Q

o1
=g
o :
s
g

itdel

e A

M Select Cut with AAS in Mode/Tool in the Output to device window.

Output to device GCC

Output

Device: GCC Jaguar V' LX 61

Mode: | Cut with AAS

Output Profile: | Foil

Manage Profiles ..

Number of outputs:
Number of copies:
Stack spacing:

Weed border:

Copies spacing:

Parameter Valug
AAS Offset origin X [mm] 0.00
AAS Offset origin ' [mm] 0.00
Pressure [g] 15
Speed [cv's] s
Material width [mm] 20843
Length [mm] 32018
Number of cutputs in X-direction 1
Number of cutputs in Y-direction 1
Distance between copies [mm] 10.00
Step count 1
Job wil be segmented!
Preview. .. Output Read material

Output only tool-azsigned layers
D Keep reference point
[ Piot to file
Enable tool tips

D Wait after segment

Save settings
Sort before output
Actual Setting: m
Sort Oﬁtinns
Accuracy: | Normal v
Origin:  Mew origin v|
Objects: | All obiects .
Test drive
Cancel

GreatCut Plug-In

A-6
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Output

Device: | GCC Jaguar V L} 61

Mode: | Cut with AAS

Output Profile: | Foil

Manage Profiles ..

Number of outputs:

Weed border:

Copies spacing: mm

MNumber of copies:

Stack spacing:

Parameter

AAS Offset origin X [mm]

AAS Offset origin ' [mm]
Pressure [g]

Speed [cmys]

Material width [mm]

Length [mm]

Number of cutputs in X-direction
Number of cutputs in Y-direction
Distance between copies [mm]
Step count

Valug
0.00
0.00

15
50
20843
32018

10.00

Preview...

Job wil be segmented!

Output

Read material

M Click output and the object will be sent to GCC Cutting Plotter

? X
Output only tool-azsigned layers
|:| Keep reference point
[ Piot to file
Enable tool tips
D Wait after segment
Save settings
Sort before output
Actual Setting: |rLI‘
LEE
Sort Options
Accuracy: | Normal ~
Origin: Mew origin |
Objects: | All obiects w
Test drive
Cancel

GreatCut Plug-In
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Note: The difference amount Number of outputs, Number of copies, and Step count in the
Output window.

Output
Device: | GCC Jaguar V LX 61 ~ Number of outputs: 1 Output only tool-azsigned layers
Number of copies: 1 D Keep reference point
Mode: | Cut with AAS ~ z [ Piot to file
Stack spacing: 0.00 | mm
| Enable tool tips.
Output Profile: | Foil £ Weed border: -
Copies spacing: mm [ Wait after segment
Manage Profiles ... Save settings
Parameter Value Sort before output
AAS Offset origin X [mm] 0.00 -
AAS Offset origin ¥ [mm] 0.00 Actual Seffing: rU‘
Pressure [g] 15 11 St
Speed [cmis] 50
Material width [mmj] 208.43 =T
Length [mm] 32018 Lol
Mumber of outputs in X-direction 1
Mumber of outputs in “-direction 1
j &N copies [mm] 10.00
[ Step count 1
Accuracy: | Mermal ~
Origin: | New origin ~
Objects: | All chiects e
Job will be segmented Test drive
Preview... Output Read material Cancel

1. When Number of outputs is set as 2, the square and the triangle will be cut 1 time
and then the square and the triangle will be cut 1 time at next position.

2. When Number of copies is set as 2, the square and the triangle will be cut 2 times at
the same position.

3. When Step count is set as 2, the square will be cut 2 times at the same position and
then the triangle will be cut will be cut 2 times at the same position.

GreatCut Plug-In A-6
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Advanced Settings

Segmental Positioning

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x
and y distance when you are working on an extra long or large-size image to increase cutting
quality.

Follow the same steps in the 4-Point Positioning section to complete the contour line setting
and registration mark creation procedures. Adjust the size, object margin and line thickness of
your registration marks and the space between registration marks by changing X, Y distance in
the Setup-Jog Marks window and click OK.

M Click Settings on GreatCut under File.

File = Edit

Object Type Select Effect View Window Help

Ctrl+N
MNew from Template... Shift+ Ctrl+N
Open... (@ (Fo N /GPU Preview) *

MNew...

Open Recent Files >

Browse in Bridge... Alt+Ctrl+0

Ctrl+W
Ctrl+5
Shift+Ctrl+5
Alt+Ctrl+5

Close

Save

Save As...

Save a Copy...

Save as Template...

Save Selected Slices...

Revert

Search Adobe Stock...

Place... Shift+Ctrl+P

Export

Export Selection...
GreatCut 4 b
Package... Alt+Shift Ctrl+ P Dlicek e ikt
Scripts > Contour
Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mode ] -
Cutline
File Info... Alt+Shift+ Ctrl+| Welding
Print... Ctrl+P Create Outline-Layer
Bxit Crl+Q Epd
Settings

GreatCut Plug-In A-6
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M Press the button on the right of Jog marks.

Settings

Eurosystems Software: | GreatCut 4

Jog marks: |GCC (AAS 1)

Export Path: |

Name of layer for Jog Marks: |HBEIITIE"1<

Mame of layer for Outline: |'3|-ft|iﬁE

Output Parameters...

Show always contour and outline settings

During the cut process only transfer "Regmark” and "Outline” layer

Create new file while cutting [

Open output dialog while cutting [ ]

MAdjust the size, object margin and line thickness of your registration marks and click OK.

Setup - Register Marks

Type |GCC (AASI) v

@ Align to selection

O Align to working area

Size 25.00 | mm
Object Margin 5.00 | mm

il

Line thickness 1.00 | mm

Outzide corners

Output marks (or by pressing Ctri)

*

Segmental Positioning

® Max. x Distance: The distance of
intermediate position on the X axis
- Range: 200-500 mm

ax. X distance

Max. ¥ distance

Target layer | ] v|

Cancel

v
([

Max. y Distance: The distance of
intermediate position on the Y axis

- Range: 200-500 mm

GreatCut Plug-In
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M Select the Set Jog Marks on GreatCut under File and 4 marks will be created as shown in
the picture below.

File | Edit

Type Select fiew Window Help B B = 4

Ctrl+ N

Mew from Template... Shift+ Ctrl+ M
Open... (67" /GPU Preview)

Object

New...

Open Recent Files >
Browse in Bridge... Alt+Ctrl+0

Ctrl+W
Ctrl+5S
Shift+Ctrl+5
Alt+Ctrl+5

Close

Save

Save As...

Save a Copy...

Save as Template...

Save Selected Slices...
Revert

Search Adobe Stock...

Place... Shift+Ctrl+P

Export

Export Selection...
GreatCut 4 >

Package... Alt+ Shift Ctrl+ P Hitees cuting
S . Contour

Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mode ? =

i Outline
File Info... Alt+Shift+Ctrl+| Welding
Print... Ctrl+P Create Qutline-Layer
Ctri+Q Hiport
Settings

Help

o — . Bllo i B

greatcut4 user manual photo.ai* @ 24.41% (CMYK/GPU Preview) X

I E 1

Q
FEFIESNNS DY

GreatCut Plug-In A-6
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Multi-Copy

m Follow the same steps in the 4-Point Positioning section to complete the contour line
setting and registration mark creation procedures.
Setup - Register Marks >

Type |GCC (AAS I v

@ Align to selection

O Align to working area

When you apply the “Multiple
Copies” function, the value that
has been set in this section will
still be applied.

ize

Outside corners.

Object Margin

Line K 2 g mm Cutput marks (or by pressing Ctrl)

Max. X distance 600.00 | mm

Max. ¥ distance 600.00 | mm Target layer |'_ v|

M Select the Set Jog Marks on GreatCut under File and 4 marks will be created as shown in
the picture below.

File | Edit

Object Type Select FEffect View Window Help [ |

Ctrl+M

Mew...

Mew from Template... Shift+ Ctrl+MN
Open... (a3 FYo N /GPU Preview) X
Open Recent Files >

Browse in Bridge... Alt+Ctrl+ O

Ctrl+W
Ctrl+5
Shift+Ctrl+S
Alt+Ctrl+5

Close
Save

Save As..

Save a Copy...

Save as Template...

Save Selected Slices...
Revert

Search Adobe Stock...

Place... Shift+ Ctrl+P

Export

Export Selection...
GreatCut 4 >
Eockar AltShifts Ctrl+ P RiEeE Liting
S . Contour
Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mode » 2
Outline
File Info... Alt+Shift+Ctrl+| Welding
Print... Ctrl+P Create Outline-Layer
Exit Ctrl+Q e
Settings

GreatCut Plug-In A-6
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File Edit t Type ew Wi o @ W

M Select both the entire object (including registration marks and the contour line) then click
Cut on GreatCut under File.

ject Typ

mied objecs | [7] [E]=

GreatCut Plug-In A-6
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Mew... Ctrl+M
MNew from Template... Shift+Ctrl+MN
Open... Ctrl+ O
Open Recent Files 3
Browse in Bridge... Alt+Ctrl+0
Close Ctrl+W
Save Ctrl+5
Save As... Shift+ Ctrl+5
Save a Copy... Alt+ Ctrl+5
Save as Template...

Save for Web... Alt+Shift+ Ctrl+5
Save Selected Slices...

Revert F12
Place...

Save for Microsoft Office...

Export...

I GreatCut 4 » Cut
Scripts » Direct cutt
Document Setup... Alt+Ctrl+P S

Multi-Cop

Dacument Color Mode

3

M The system will activate GreatCut automatically and import the registration marks and

300

398.24

mn[E

398.24

=200

contour line to GreatCut.
o GreatCut 4 - [(untitled - 4) *]

[ File

- , .
f - -
G' = - i
GreatCut Plug-In A-6
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B Select Output under File.

e e——
= GreatCut 4 - [(untitled - 1) 4]

E Design  View
MNew... Ct
Open... =
Save C
Save As... Shift+C
Send by Email...
Import...

Export... =
Print... Cl

m Select Mode as “Cut with AAS” and input the Number of outputs in X-direction and

Y-direction and Distance between copies, please don’t press output button.

Output to device GCC i

Device: [ GCC iCraft

i Mode: | Cut with ALS

Output Profik: ’Fnil

[ Manage Profies ...

Number of cutputs:
Number of copies:
Stack spacing:

|:| Weed border:

Copies spacing:

Segment spacing:

5.00 mm
2.00 mm
2.00 mm

0.00 mm

Parameter Value
AAZ Offset origin X [mm] 0.00
AAS Offzet origin % [mm] 0.00
Pressure [g] a0
Speed [cm/'s] 21
Material width [mm] 208 43
Length [mm] 32018
Number of cutputs in A-direction 2
Number of cutputs in Y-direction 2
Distance between copies [mm] 0.00

Step count

Output onh

Keep refer
[T Piot to file
Enable tool
|:| Disable ser
[T]wait after ¢

Sort before

Actual Setting

|:| Search for

L

Accuracy.

Qrrigin:

GreatCut Plug-In
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S1¢:1od Back to Adobe lllustrator, Click Multi-Copy on GreatCut under File.

File Edit Object Type ect . fiew Window Help BE B - «

Crl+N

Shift+Crl+ N
Open... [« PO /GPU Preview) X

New...

New from Template...

Open Recent Files >
Browse in Bridge... Alt+Ctrl+0

Ctrl+W
Ctrl+5
Shift+Ctrl+5
Alt+ Ctrl+5

Close

Save

Save As...

Save a Copy...

Save as Template...

Save Selected Slices...

Revert

Search Adobe Stock...

Shift+ Ctrl+P

Place...

Export >
5=" Export Selection...
L GreatCut 4 >
D 2 %
W Package.. AltShift Ctrl+P RiEcE it
Scripts ¥ LInl
Multi-Copy
Document Setup... Alt+Ctrl+P Set Jog Marks
Document Color Mede > 2
Outline
File Info... Alt+Shift+ Ctrl+| Welding
Print... Ctrl+P Create Qutline-Layer
Bxit culeQ bpars
—— Settings

S ks Complete the Number in X/Y (the number of copies desired on the X/Y axis) and
Distance in X/Y (distance between each copy) settings then click OK. Confirm that the
value of Distance in X/Y must be the same with step 6.

Multi-Copy ot
Mumberin X |2 =
Mumberin ¥ |2 =
Distance in X |0.00 = mm
Distancein ¥ |0f _:_ mm
Distance to ohject

Corc

Note: The spacing of vertical & horizontal (Offset X & Y) should be 2 20mm or = Omm; users are
advised to set the Distance in X/Y as 0 mm to remove the space between each copy to
avoid the waste of materials.

GreatCut Plug-In A-6
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M The system will create several copies of the object with registration marks as shown in
the picture below.

Window Help [ B W=~ 4
v v [ Opacty: 100% Style: Preferences | T ¥

greatcutd user manual photo.ai* @ 25% (CMYK/GPU Preview) X

IROHA™ Y

B, B

M Print the Multi-Copy images out, and put the printed media on the GCC cutting plotter.

GreatCut Plug-In A-6



GCC..

Appendix

File

M Go to GreatCut window, press Output button.

Edit Object Type

Mew...

Mew from Template...
Open...

Open Recent Files

Browse in Bridge...

Close

Save

Save As...

Save a Copy...

Save as Template...
Save for Web...

Save Selected Slices...

Revert
Place...

Save for Microsoft Office...

Export...

GreatCut 4
Scripts

Nocument Setun

Alt

Shift
Al

Alt+Shifi

Alt

GreatCut Plug-In
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Output to device GCC i
Output
| Device: | GCC i-Craft
i Mode: | Cut with AAS

Output Profile: anil

[ Manage Profies ...

Number of outputs:

Number of copies:
Stack spacing:

|:| Weed border:

Copies spacing:

Segment spacing:

5.00 mm
2.00 mm
2.00 mm

0.00 mm

Parameter

AAS Offzet origin X [mm]

AAS Offzet origin ¥ [mm]
Pressure [g]

Speed [cmis]

Material width [mm]

Length [mm]

Number of cutputs in X-direction
Number of cutputs in Y-direction
Distance between copies [mm]
Step count

Value
0.00
0.00

a0

21
208.43
32018

0.00

Output onh

Keep refer
[ Piot to file
Enable tool
|:| Disable ser
[] wait after ¢

Sort before

Actual Setting

|:| Search for

L

Accuracy:

Origin:

GreatCut Plug-In



GCC.. Appendix

SignPal Instruction

The SignPal Software is Windows System compatible and all versions support the AAS Il
contour cutting function.

SignPal Instruction Index:

[1] Installing the SignPal software

[2] Set up your GCC Cutter on Production Manager
[3] SignPal AAS Il Quick Start

[4] How to set Die Cut

[5] How to set Creasing

[6] SignPal Features List

[1] Installing the SignPal software

To install the software, you must have Administrator privileges. To use the software, you
must have Administrator or Power User privileges. See your Windows user guide for more
information.

1. Uninstall any previous version of the software.

2. Visit GCC website (https://www.gccworld.com/download.php?act=view&id=20) to
download the WinRAR file.

x‘ Company Applications Products Technology Support Contact Link ® = Qi
e

Tech Support
Download Area
Product Termination Policy

Out of Warranty Service

Download Area v

Download Area

enter keywords to search Q SEARCH

SignPal 12 Instruction A-7
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Or browse by machine model

Vinyl Cutter Laser Engraver Laser Cutter

Download Area v

I VinYI Cutter Vinyl Cutter v

ey A =" s Th

Expert Il A i-Craft™ 2.0 AR-24 Expert Il

Puma IV Jaguar V [ Jaguar V (PPF) RX Il / RX Il (Creasing)

SignPal 12 Instruction A-7



GCC.. Appendix

Title Size Downlocad
SignPal V19 817 MB Download
GreatCut 4 for Windows (V.17.0.20.21868) 294MB Download

3. Follow the installation and activation instruction for SignPal 12 below.

(1) Install and activate software on an online computer

1. Launch your browser and type https://www.saicloud.com in address bar and press
enter, then input your activation code, then click Activate, activation code can be
found in the code label in software package.

Activation Code

Please enter the activation code that accompanied your software purchase.

Activation Code | SHALALWCZHT TW3TYZDU |

=

2.In login section, click | am new to the SAi Cloud and input your email address,
then click Create Account, an email will be sent to your mailbox.

Create A Free SAi Cloud Account

) | am a returning customer

m new to the SAi Cloud

Enter your email address to get started.

Important: The email address you select for
this SAi Cloud account will be the owner of
the software. It will be used for all SAi
software services. Itis recommended you
use a permanent business email address.

784306662@0qq.com

Create Account

SignPal 12 Instruction A-7
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3. Check your mailbox and click website link in the email then complete the
information fields.

Create Account

PERTscT TR e SRR T ChErEse

s Terms And Conditions
e Terms and Conditions L
User Agreement
(= R e — L IMPORTANT—READ CAREFULLY
This Account User's Agreement is a legal contract between You (defined below)
Tima Do DAL O O] LI (15| and
2 Lirm SA International Inc_
BY USING YOUR SAI CLOUD ACCOUNT. YOU (AS THIS TERM IS DEFINED
[ )BELOW) AGREE BY CLICKING ON THE "ACCEPT” BUTTON TO BE BOUND
L L BY THE TERMS OF THIS AGREEMENT (AS THIS TERM IS DEFINED BELOW) ,
INCLUDING, BUT NOT LIMITED TO, ANY WARRANTY DISCLAIMERS,
= LIMITATIONS OF LIABILITY, JURISDICTION, AND TERMINATION
PROVISIONS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, DO NOT OPEN AN SAi CLOUD ACCOUNT AND EXIT NOW
S Trronce
Article I. Defined Terms:
IpToiE 1. Account means your account on the SAi Cloud
2. Agreement means this End-User Account Agreement.
3. Entity means any individual. partnership. joint venture. corporation. limited =
Craste Aot e i —————————
I I Accept the Terms and Conditions

!

Step 2. Add Software to your SAi Cloud Account

Add To SAi Cloud Account

This software license will be added to your SAi Cloud Account.

SignPal 12 Instruction A-7
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4. Open Autorun in the WIinRAR file. Then install software step by step by following
the wizard.

Select the language fior the installation from
the choices below.

Chinese [Simplified]
Chinese Traditionsl]
Dutch

SAi Production Suite Cloud [BES"  sai Production Suite Cloud %

Setup Status

PRODUCTION

‘Welcome to the InstallShield Wizard for SAi SUITE

Production Suite Cloud

54 Praduetion Suite Cloud is configuing your new software installation.

The InstallShield? Wizard wil install S4i Frodustion Suite e — e
Cloud on your computer. To cantinue, click Next SAi Production Suite - InstallShield Wizard =)

¥ the USE dongle is connected to the computer, please remove it now,
5o that the dongle driver can be installed

I

(o]

SAi Production Suite Cloud <

r o
B=S8 [ sai Production Suite Cloud a =

PRODUCTION Selunblotey PRODUCTION
SUITE SUITE

Select the features you want ta instal, and deselect the features you da not wank ta instal 54 Praduction Suite Claud is canfiguring yaur new software instalation

Select Features
Select the features setup wil install

Description

4i Production Suite Cloud
amples SafeNet Sentinel diiver

Instaling

DA A5AMNSA Production Suite Cloud\Program*AGresD ey di

[ |
704.70ME of space required on the D dive
30663 40 MB of space avaiable on the D diive
Instalshicid InstalShield
[ <Back_J[_new> ] [ Cancel ] ~
B}
$Ai Production Suite Cloud 1 I L B3 "4 production Suite Cloud d 3]
Vi AR PRODUCTION Choose Destination Location PRODUCTION

Please read the fallowing license ao Select folder where satup will install

SUITE

T Setup willinstall 54i Production Suite Cloud in the following folder.

Tavinstall to this folder, click Newt. To install to a different folder, click Browse and select
another folder.

IMPORTANT[READ CAREFULLY: This Agreement [as defined below] is a legal
contract between You [as defined below) and S4 Intemational Inc. for the Flexi and
{ PhatoPRINT Software [as defined below)

This gresment (s defined below) sets forth the terms and conditions for licensing of
the Software from 54 Intemational Inc. and Yo (as defined below), and instaling and
using the Software. This Agreement applies to any [I] single-user license; (i) multi-user
license:; and (i) original equipment manufacturer (OEM) or Special Edition (SE) versions of
the Software and other branded or customized versions unless otherwise agreed.

B OPEMING THE SEALED PACKAGE CONTAINING THE SOFTwWARE OR
DOMWMNLOADING THE SOFT'WARE FROM AN AUTHORIZED OM-LINE SITE. OR -

Destination Falder
| accept the tems of the license agreement | 0 | 7
g S rovise
|| T et sceent e e of Tie Teens mgmement | | D:A...\SANSAi Production Suite Cloud [—]l

Install

Id

[Ccgede [ memo> | [ cancel ] TR

SignPal 12 Instruction A-7
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5. Paste your code into activation code field.
© ==X
. - * e ——
Mlv;::n%j:atmn Code to get a license @ License

When you purchase new software it comes with an Activation Code. Enterthe
Activation Code below.

Activation Code: | SHALALWCZHTTWI7YZDU|

Success

Licensing Successful

< Back Nex > Close

< Back

Next >

Close

6.rSeIect_Ianguage you need, click OK and finish installation.

- Mot for resale | ——

Product: |PhotoPRINT SERVER-PRO Cloud

=]

Language: IEninsh

=]

1 [™ Clear Application's previous preferences
[ Instal to startup items

SignPal 12 Instruction
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(2) Install and activate software on an offline computer

1. Open Autorun in the WIinRAR file. Then install software step by step by following
the wizard.

Select the language for the inctallation fom
the choicas balow.

Engi
Chinese [Simpliied]

Chinese [Traditional]

Diutch

Engish |

)

SAi Production Suite Cloud

SAi Production Suite Cloud =

‘Welcome to the InstallShield Wizard for SAi
Production Suite Cloud

The Installshield? Wizard villinstall S Froduction Site
Clowed on your camputer. To eantinue, click Ne,

Setup Status

PRODUCTION
SUITE

54 Praduction Suite Cloud is eonfiguing your new software installation

S

SAi Production Suite - InstallShield Wizard

I the USE dongle is connected to the computer, please remove it now,
so that the dongle driver can be installed

oK

Irstall5 igld

Cancel

(|

PRODUCTION
SUITE

SAi Praduction Suite Cloud

o " |

Please read the fallowing lieense ag

License Agreement

Software License Agreement i

IMPORTANT(READ CAREFULLY: This Agreement (as defined belonlis alegal ~ —
cantiact between You [z defined below) and 54 Intenatianal Inc. for the Fleri and
PhotoPRINT Softwars [s defined belaw],

This Agrsement [ss defined below] sets forth the terms and conditions for lisensing of
the Software from 54 Intemational Inc. and You (= defined below), and instaling and
using the Software. This Agiesment applies ta any (1) shale-user icense: i) multuser
licenss; and (i original equipmert manutacturer (OEM) or Special E dition (SE) versions of
the Software and other branded or customized versions unless othenise aareed

B OFENING THE SEALED PACKAGE CONTAINING THE SOFTWARE OF
DOWNLOADING THE SOFTWARE FROM &N AUTHORIZED ON-LINE SITE, OR -

|¢ 1 accept the teims of the license agresment I it
T T 2o ot acoept the termns of the Tcense agreemert

InstallShield

[ cBack | Hew» |

Cancel |

===
PRODUCTION
SUITE

-
SAi Production Suite Cloud

Setup Status

54 Production Suite Cloud is configuring your new software instalation

Irstaling

D:\.A341S 4] Production Suite Cloud\Progiam'aGreyDev.dil

ImstallShigld

[

SAi Production Suite Cloud d

==

SAi Praduction Suite Cloud

Choose Destination Location

PRODUCTION
SUITE

Select folder where setup wil install il

Setup wil install SAi Production Suite Cloud in the following folder,

Toinstall to this folder, click Mext. To install to a different folder, click Browse and select
another folder.

Destination Folder

D4 ASAS AT Production Suite Cloud

Brovise. |

Select Features

PRODUCTION
SUITE

Select the features you want to install, and deselect the features you do not want to irstall

Select the features setup will install

i Production Suite Cloud Description

mplas SateNet Sentinel driver

704.70 MB of space required on the D drive
30888, 40 M of space avalable on the D dive

Install5 higld

Id

<Back [ Mewt> | [ Carcel

SignPal 12 |
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2. Record your computer ID in the dialog box below and look up your computer name,
You can find your computer name by right-click on My Computer and choose

Properties.

= =

(4]

S

License
Could not communicate with the SAi Cloud

License manager was unable to connect to the Cloud License Server. Possible
causes for this may include:

- The "SAi Cloud" website may be experiencing issues. Please open your
browser and try to log into your account on www saicloud com

- Your activation code has not yet been linked to your saicloud com account
Please go to www.saicloud.com, enter your activation code on the
"Activation Code” field, enter your email address and password, and click on
"Activate License.”

| - Your computer may not have access to the license server. Please verfy that
port 443 s open for both incoming and eutgeing connections in your firewall for
all SA applications

During the process you may be asked for a Computer 1D. f you require a
Computer |D, use the value below.

hitps ://www saicloud com/
| Computer ID: BE19DA26B331
You should retrieve a license file from the website. When you have a license file

imort it using the button below.

+ Import License File

System
Rating:
Processor
Installed memory (RAM):

| System type:
Pen and Touch:

Cornputer name:

a Windows Experience Index
Intel(R) Core(TM) i5-2450M CPU @ 2.50
.00 GB (7.90 GB usable)

64-bit Operating System

Mo Pen or Touch Input is available for t

Computer name, domain, and workgroup settings

Jeff-PC

(] Full computer narme:

Jeff-PC

| Computer description:

| “ Use Proxy Settings
|
< Back Next > Cl

Waorkgroup:

WORKGROUP

3. Launch your browser on another online computer and type
https://www.saicloud.com in the address bar and press enter, then input your
activation code and click Activate.
The Activation code can be found in the software package certificate.

Activation Code

Please enter the activation code that accompanied your software purchase.

Activation Code

SHALALWCZHT TW3TYZDU

=

SignPal 12 Instruction
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4.In login section, click | am new to the SAi Cloud and input your email address,
then click Create Account, an email will be sent to your mailbox.

Create A Free SAI Cloud Account

2 | am a returning customer

1 am new to the SAj Cloud

Enter your email address to get started.

Important: The email address you select for
this SAi Cloud account will be the owner of
the software. It will be used for all SAi
software services. Itis recommended you
use a permanent business email address.

784306662@09q9.com

Create Account

5. Check your mailbox and click website link in the email then complete the
information fields.

Step 2. Add Software to your SAI Cloud Account

Add To SAi Cloud Account

This software license will be added to your SAi Cloud Account.

=

SignPal 12 Instruction A-7
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6.Click “License Manager” can’t connect and input your computer ID and
computer name that you recorded for the offline computer before, then click
Create license Now and Download License, save license file to local.

Step 1 - Download

Clicking on the dewnload button below will download a small application. Run the application to do

Download Mow

Step 2 - Install

Once the download is complete, run the installer. The final step in the install process will run a "Lic
application.

Step 3 - License

The "License Manager” application will ask for an activation code. Use the activation code below tc

QTPSNDBSFXYUXGXHLTAG

"License Manager” can't connect?

!

Create License Current Install

Go Back Computer ID: 5E19DA26B331

Your software will be licensed to be used on the computer wit

Computer Name: JEFF-PC

|:> User Name: Administrator

Mar 21, 2014

Computer Name
Download License

License Remaoved?

Computer ID

Create License Now

Download MNow

SignPal 12 Instruction A-7
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7. Copy license file to offline computer via a removable disk device, then import it.

‘o

o)

License
Could nat communicate with the SAi Cloud

®

License manager was unable to connect to the Cloud License Server. Possible
causes for this may include

- The "SAi Cloud” website may be experiencing issues. Please open your
browser and try to log into your account on www.saicloud.com.

- Your activation code has not yet been linked to your saicloud.com account
Please go to www.saicloud.com, enter your activation code on the

“Activation Code” field, enter your email address and password, and click on
"Activate License.™

| - Your computer may not have access to the license server. Please verify that
port 443 is open for both incoming and outgeing connections in your firewall for
all 5Ai applications

During the process you may be asked for 2 Computer ID. f you require 3
Computer ID, use the value below.

| https://www saicloud.com/

Computer ID: SE19DA26B331

You should refrieve @ license file from the website. When you have a license file
imort it using the button below

= Use Proxy Settings

» Computer » Locel Dk (D) » Users » <l

Secrch Lveny

Foew lolder

Ouganuze =

i Ubnines
& apps
) Detuments
o Music
! Pictures

) H Videor

™ Computer
L Local Dusk (T}
o Lol Dk {0}
a New Yolume [E:)
o} €O Orve &) 05
B mzaseE

Filename: license-0077325 b

LSN File

- |Licenme e e

(owm ) o ]

— . .
o == ‘o g . - S
License @) License @)
License successfully imported I Software 1D 0077325

License Type: TRIAL

Expire Date: 20-04-2014

Licensed On This Computer

Computer |D: 5E19DA26B331

Click Next to continue:

= Check For License Updates

= Import A License File

=+ Remove License From This Computer

< Back Next >

Close

Close

8. Select language you need, then click OK and finish installation.
[ Not for resale:

Product: IPhotoPRINT SERVER-PRO Cloud

=]

Language: IEninSh

=]

v Install to desktop!

I Clear Application's previous preferences
[ Install to startup items

SignPal Instruction
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(3) Transfer license on an online computer

1.0pen License Manager from Start menu.

. SAi Production Suite Cloud
% Install Manager
% lob Monitor
License Manager
QI; PhotoPRIMT EDITOR-PRO Cloud
E PhotoPRINT SERVER-PRO Cloud

|2 Preference Manager

2.Click Remove License From This computer, Now you can install the software
on another computer.

-

o

|t

- ®

Software 1D: 0077325
License Type:  TRIAL

Expire Date: 20-04-2014
Licensed On:  This Computer
Computer |D: 5E13DA26B331

< Check For License Updates

< Import A License File

< Remove License From This Computerl

—

| S

License @
4

The license was successfully removed from this computer.

Software |D 0077325
Removal Code NLSK7RKC3R

2 License this computer again

SignPal Instruction
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(4)Transfer license on an offline computer
1.0pen License Manager from Start menu.

. SAi Production Suite Cloud
% Install Manager
IETE Job Monitor
9 License Manager
E PhotoPRINT SERVER-PRO Cloud
|75 Preference Manager

2.Click Remove License From This computer, then record removal code in license

dialog box.
©

=== o =R e - =)

License @) License @)

Software 1D: 0077325

License Type: ~ TRIAL
The licenss was successfully removed from this computer.
Bpire Date: 20042014

Licensed On:  This Computer
Software ID: 0077325

Computer 1D: 5E13DA26B331
Removal Code: GMYKCTIG45

< Check For License Updates |

= 2 ¥ & License this computer again
< Import A License File

= Remove License From This Cumputerl

‘ J

3.Launch your browser on another online computer, access
https://www.saicloud.com and login with your account. Click License Removed
then input removal code and click Remove. After this you can install software on

another computer.

SignPal Instruction A-6
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Current Install

Computer ID: 5E19DA26B331
Computer Mame: jeff-pc
User Name: Jeff

Mar 21, 2014

Download License

ILicense Remuued'?l

Download MNow

®) cloud

Software Removed?

When a software license is removed from your computer, it will attempt to
over the Intemnet. If your computer was unable to communicate over the Int

:> have displayed a removal code. Enter the removal code below.

Removal Code

GMYKCTIG45

Remove

Mo Removal Code?

Go Back

[2] Set up your GCC Cutter on Production Manager

1. Open Production Manager 12

2. Choose and set up your GCC cutter.
(Note that AAS Il System only works on RX Il, Jaguar V LX, Puma lll, Expert Il LX
models.)

Choose a device

What is the brand name of your vimd cutter?

(€S

What is the model name of your GCC?

|AR24

GRC-23

i-Craft

Jaguar I1I-101
Jaguar II-132
Jaguar II-183
Jaguar l1I-61
Jaguar lII-76
Jaguar IV-101
Jaguar IV-132
Jaguar IV-183
Jaguar [V-61
Jaguar [V-76
Jaguar JIF1015
Jaguar JI-1325
Jaguar JII-61
Jaguar JII-765
Jaguar JR-1015

SignPal Instruction
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What do you want to call your new setup?

Jaguar V-61 LX

How is your Jaguar V-61 L¥ connected to your computer?

GCC USB 000 ‘\ ~| | Brow:

E Preduction Manager

File Edit Setup View Help

Job ¥ Send Abort

GCC Jaguar V-61 LX@GCC USB 000 Setup lob Mame Status Tools

WI'FF Jaguar V-61 LX
-
Fa)

Files  Flexic

Resources
Printer  Sup
Profiles

B K

Youtube Face
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3. Select File > Print Setup in SignPal Software and select the printer.

SignPal Expert - [Untitled 1] - - - J

Ed[File] Edit View Arange Text Effects Bitmap Window Help

N Ctrl+N O RO g
Hie “t o o BEG A
pen... rl+ -
& 4 33 m/:hcsl
m Close Ctrl+F4 | 1 1 1 | 1 1 el 1 . |
H § Find File..
E Save Ctrl+5
Q : Tool:
Save As... Ctrl+Shift+5
O =y
B Import.
T Export... *
E| Files
Acquire Image 3 3
EX Document Setup... Ctrl+B
=l Resc¢
M T Cut/Plot... Ctrl+L
r 5 Cut Contour... g
| Print Setup.. Ctrl+Shift+P
= Print. Ctrl+P Printer
Profiles
-
Print Setup /

— Printer /

Mame: Pro
Status: Ready
Type: Microsoft enhanced Point and Print compatibility driver
Where:  4F 1735
Comment:

— Paper Crientation ——
Size: IM ;I «

Source:  |Automatically Select R4 e
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4. Select File > Document Setup in SignPal and select paper size .

SignPal Expert -
@ Edit View Arrange Text Effects Bitmap Window Help
™ Mew Ctrl+N O p Ly
[ e BEESG Qe e
3 Open.. Ctrl+O = 7
& 4 2 m/:hcsl
k Close Ctrl+F4 | 1 1 1 | 1 1 1 ] 1 . |
H § Find File..
@ Save Ctrl+S
2 . Tool:
& SaveAs.. Ctrl+Shift+5
L B Import.
T Export... -
E Files
Acquire Image 3 3
EX Document Setup... Ctrl+B I
- Resc¢
M T Cut/Plot... Ctrl+L
5; Cut Contour... g
Print Setup... Ctrl+Shift+P
@  Print.. Ctrl+P Printer
Profiles
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[3] SignPal AASII Quick Start

1. Use the Rectangle Tool to create a rectangle.

CEEABRRFFI L DR e BES

% B

File Ed"Ft ‘u"r Arrange Text Effects Bitmap Window Help
CEHBRRASTFI XN DR o [BEG
0 > 4 5 3 10

DesignCentral

++ |7 000in

ac I2.EDDin

¥ Fropartion
™ With holes

. )~

PLPH>POPY
{
|

Gl
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3. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark.

P — —
1 SignPal Expert - [Untitled 1]
L+ File Edit View Amange Text [Effects| Bitmap Window Help

D@ =Ry G Jﬁ Combine b '- @ (

Qutline...

T :HJ-|-J-I-J-|'EE-§ Contour Cut... -J""'I"""'r'
k‘ Q 1w—: i Contour Cut Mark...
Ir Q 3 D Shadow... \
Sa‘ @. j [1 Clear Contour Cut Desige
Ei Q Eu_.—_- ™ Separate Contour Cut I-H--
LK
8| ; .
NIV Ti
mil W ;
T @ |9 — el
. ] Iy
@ m

4. Select “GCC AASII" in SignPal DesignCentral window to create the AAS Il registration
marks (4-Point Positioning) and click ‘Apply’ in DesignCentral window.

ﬁ _‘ DesignCentr
|

& [T
ant l_

—
]
]

i N
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5. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental
Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please
select “GCC Segmentation” in DesignCentral window and then click ‘Apply’.

DesignCentral

4o
2y
hl r

r 1
~CC Seqme
\:EIJ_
@ |ﬂ.ﬂ3[ﬁn [
T ] f

A L

0.7 [0.000in L

6. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple
Copies’ function is only available under CorelDraw plug-in.

7. Select File > Print to print out the image.

™ Mew Ctrl+M
I
ﬂ Open.., Ctrl+ 0 s
D I Close CieFs [, O 04 @ l:
’_‘Tﬁh Find File... B e o e
k‘ Save Ctrl+5
I.II G Save As... Ctrl+5Shift+5
S@ E &= Import. |
|:i G @ Export..
$‘ é Acquire Image 3
@ E» Document Setup... Ctrl+B
@ @F CuvPlot. Ctrl+L
Ji'-i'? &: l_i Cut Contour...
i Print Setup... Ctrl+Shift+ P
mET =] 5 S e I
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-~

SignPal Expert

8. Set the Scale as 100% in Print page.

@=% Printer paper orientation does not match document. Adju
W automnatically?

P I

— Printer
M arrie: \\gpprinter2W4F 9 TEE HER R DDCLL! Froperties... |
Status: Ready
Type: ticrozoft enhanced Point and Print compatibility driver
FostScipt data: € Binary & ASCI
— Copies — Print Ophions
| Mumber of copies: |'| 3: I™ Selection arly
I ! 3 { 3 [~ Border
jﬂJ 1 2 ¥ Collate ™ wireframe
l [~ Substrate
|| Scalz )
™ Fit drawing to paper I Guides
l ™ Fit border bo paper I Giid
ol Bk [ Contour cut paths
I [~ Template
Select Template... |
— Tiling
[~ Print tled pages — Position
| Overlap: [0.000In = I Center Li

— Preview

. Load the printout vinyl on the plotter and select File > Cut Contour to send data. You
can preview the job and change cutter’s parameter settings in ‘Properties’ tab of Cut
Contour window. The Production Manager will be automatic activated to complete the

job.
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ntitled 1]

Arrange  Text Effects Bitmap Window

ARAT L LA

C
T
1
1

.

Select a Production Manager

& On thiz computer [Local)

" On another computer [Netwark]

 0n the intermet address:

Status

Properties. .. |ﬂ ’
%1% |

I — Material 24 22 20 8 16 14 12 10
I [24.000x 1962.000mn ~ &= ]
& paooon = #0 [isee000n = 8]
g—
E‘g_
5 : ®
end mode: ISend now _v] -
- Postion &
[« [1575n = = [1:575n - g
- !
—Size Fd—
- IZ.B-EB“-I 3: o |1DD.DD|}=.-'= 3: =]
=
3 I2.33¢in 3: I~ Fit to media =
—Copies ,,:
BB i e I T "
2
—I Repeat Job
m_
Send job |1 _I; limes .
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[4] How to set Die Cut
1. Open SignPal Expert

@ signPal Expert - [Untitled 1]
B File Edit View Arange Text Effects Bitmap Window Help

DAERE® R Moo= BESAMNe
ErT S e N e R e R R e
k i
T L)
% o] ==
O 1] =IZxl

mes
Z al
.

&7
e =
Q *#[
Q| Al
a1 =]
Q ] I~ Tra
R 7
a |
) |\
B |
Use the “Text” tool or other drawing tools to create an image.
@ signPal Expert - [Untitled 1]
B File Edit View Arrange  Text Effects Bitmap Window Help
DR Ra I XA EHES Qe

] 5 0 15 20 o 30 35 0
k, R | W P I P
T
'_J [m}]
A
2
iy
a

35
1 [ L

HPLPPLLH Duf

30
1
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3. Select “Contour Cut” tool to create contours of the image.

@ SignPal Expert - [Untitled 1]
File Edit View Arange Text Effects Bitmap Window Help

DA% RafILi BN
L) L 5 . WID R

45
I

Nw 8-,

£ e

35
T

30
|

SPP LS Pf

4. Select Fill/Stroke Editor and select Edit from dropdown menu.

Fill/Stroke Editor _ |G

/

5. Set Die Cut parameter in Customize Line Styles

Note : Dash: define the length of cutting line; Gap: define the interval between the dash lines

SignPal Instruction A-6
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Customize Line Styles

| 7 &

Dash Gap Dash

Gap Dash

G
[1m = [o.200mm =] [im = Jozoom—=] [m =] |
Add | pdate | Remove ]

Select Cut/plot icon to open the setting window

@ SignPal Expert - [Untitled 1]
[3 File Edit View Armange Text Effects Bitmap Window Help

oo BESQAEe®

15

Select the model you are using from the dropdown menu, and click Edit... to open the Driver
options setting window.

SignPal Instruction A-6
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E Cut/Plot

RX II61-CR@USE_Printer_|

] Status

Job
ﬁ Untitled.job
sz Untitled_2.job
a|m vl

Done
Done

W' Send all colors: Single panel, single job
~Weed ines \

I~ Weed border Panel margin: [0.254em =]

[~ Horizontal weed lines I Horizontal spit lines

[~ Verical weed lines

™ Vetical spit lines
71 Easyweed
(e Im El S
r— Driver options

Drawing Colors Pass #1 | Pass #2 [ Pause |

% B CutCont..Cut Fast  Skip ®

KIS,

[~ Use same driver options for all colors
[™ Use same driver options for all passes

Edit...
¥ Advance after plat Additional advance: |0.000u1l Eﬁ

Total size: 25 84cm x 35.97cm Passes: I2 5:

8. Set parameter in Before Job tab.

Note: Set Tool = 0 to perform cutting.

80 55 50

45

40

35

20

15 20 25 ,30 ,35 40 45 50 55 60 65 70 ,75;80_ 85 90 ,95
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9.

Before Job || After Job || Macro |

ECm Fast  ~|

1 Tool lﬂiéﬂ

1 Speed 72 :—| cmfs
1 Force 120 |2 g

i offset 0.275 3 mm
[ Acceleration 0.7 :i G
SPOVS72;FS120;TOD.275;

=l

Enter a value in Passes column to define the repeat times.

! Cut/Plot

10. The setting is complete.

'Rx I161-CR@USB._Printer_{ Job | status "
Propemes. ‘I Unt'.rlled.joh Done
— Untitled_2.job Done
a|mvls y
80 55 50 45 40 35 30
W Send all colors: Single panel, single job N
~Weedines \ i
[~ Weed border Panel margin: |0.254cm 3: &)
[~ Horzontal weed lines I™ Horizontal spit lines 8]
I Vertical weed lines [~ Vetical splt lines s
71 Easyweed ]
Weeding margin: ﬁm I Around growps and text 2]
~ Driver options 3‘
2]
Drawing Colors__| Pass #1_| Pass #2_| Pause | i
% B Cucont. CuFast  Skip ® 1| 8
3 %
'_
9] —
]
3 |
™ Use same driver options for all colors s 2.
™ Use same driver opions for all passes 7 s
Edit... ]
&
¥ Advance after plat Additional advance: IO.DOD\:m 32 i i
wr
Tolalsize:  25.84cmx 35.97cm Passes: [2 = =) M

SignPal Instruction
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[5] How to set Creasing

1. Create arectangle by Rectangle tool

@ signPal Expert - [Untitled 1]
File Edit View Amange Text Effects Bitmap Window Help

DR Te ¥ @A = o
o[ T D | R

Eesadlee

._]
9 Mﬁﬂf T

15
I

30
| B

3 PPLABHLPPL Pf

2. Use Bezier Path or Rectangle tool to create Creasing lines

b{;‘ 1

a =
a 5] & 7

@, x =
Qi A

Q &=+ _J_J
& 74 P Trncfom Do |
Q| ]

a,

e
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3. Select Cut/plot icon to open the setting window

@ SignPal Expert - [Untitled 1]
File Edit View Arange Text Effects Bitmap Window Help

N w08,

40
|

35

RPPABLPYPL P

-

4. Select RXII-CR@USB_Printer_0 from the dropdown menu, and click Edit... to open the Driver

options setting window

T Cut/Plot
|

=

||Rx I-61-CR@EUSB_Printer_

Status

Properties... ]

T i

- Untitled job
Iy

| Untitled_2,job

Done
Done

I¥ Send all colors:

Single panel. single job
Weed lines

I Weed border Panel margin: |0.254cm
I” Horizontal weed lines

[ Vertical weed lines [ Vertical spit lines

[~ Easyweed

Weeding margin: |0.254cm El r

Driver options

[T Horizortal split lines

Drawing Colors | Pass #1 | Pass #2 | Pause |
% - Red creasing  creasing (O]
7 I CutCont...Cut Fast  Skip (O]

Ll Joack  Sko  ske O |

1
Bl

™ Use same driver options for all colors

™ Use same driver options for all passes

¥ Advance after plot

Edit...
Additional advance: |0.000cm El:

Total size: 25.84em x 35.97cm Passes: ,ﬁ i |_|
SignPal Instruction A-6
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5. Set parameter in Before Job tab
Set Tool = 0 to perform Cutting
Set Tool =1 to perform Creasing
GCC RXI-61-CR GCC RX 11-61-CR
Before Job || After Job || Macro | 4 Before Job || After Job || Macro |
Cut Fast - K lcreasing w (
1 Tool 0 = | M Tool 1 'T
Speed i2 ?“ cmfs Speed |1 5 = cmys
Force 120 = g Force 400 = a
Offset 0.275 > mm Offset 0.000 |3 mm
[ Acceleration 0.7 3 G [ Acceleration 0.7 = G
|SP1]:VSTZ:FS'IZD:TOD.Z?5; |SF‘1:VS15: FS400;TOD.000;
| S | — [ I [ peteta | [ | [
6. Enter avaluein “Passes” column to define a number of times for cutting/creasing.
T Cut/Plot
[RX1161-CR@USB_Printer_0 - ﬁ Job Status I D
Properties... | Untitled.job Done
- — QI Untitled_2,jok Done
I ¥ %] !
60 55 B0 45 40 35 30
[V Send all colors: lSingIe panel, single job _LI o
(]
~Weed lines 7
[~ Weed border Panel margin: |0.234cm - &)
I Horizontal weed lines [~ Horizontal split lines ﬂ_
I Vertical weed lines [ Vertical split lines )
wy
1 Easyweed ™
Weeding margin: !D.Z&-k:rn 3: [T fround groups and test (=
B
— Driver options T
l
Drawing Colors | Pass #1 | Pass H2 | Pass #31 | Pause ﬂ_
%’ -Red creasing = @ 1 2
7 B CutCont.. Cut Fast  Skip Cut Fast » _:"_l 4
7 ek Skip Skip Skip 0] &
?_ ===
< > !
wy
8 |
[ Use same driver options for all colors 5 &
[ Use same driver options for all passes T ;)
Edt... | 5|
b5
¥ Advance after plot Additional advance: m i A
wy
Total size: 25.84cm x 35.97cm Passes: [B =] e W
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7. User can decide whether to perform cut/crease each pass. By right clicking on drawing color,
user can define which action to be taken for each pass.
For example, if user want to do creasing in the first pass and no need to do creasing in the second

and third pass, user can right-click and select “Skip this pass” to skip the process.

— Driver aptions -

[~ Use same driver options for all colors

[ Use same driver options for all passes

[v Advance after plot Additional advance: [D.ODOcn 3:
Total size: 25.84cm x 35.97cm Passes: [E 5:

Reset

— Diriver options

Drawing Colors I Pass #1 | Pass #2 l Pass H3 | Pause
¥ IRt e T
7 B CutCont..Cut Fast  Skip P
T Ik Skip Skip Cut Medium

Cut Slow
< creasing

[~ Use same driver options for all colors |' Skji’ this pass

[~ Use same driver options for all passes

Edit...

¥ Advance after plot Addttional advance: Iﬂ.DDDcm 3:

8. The setting is complete.
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[6] SignPal Features List

Text

Text Tool

Arc Text

Path Text
Vertical Text
Vertical Path Text
Kerning

Break Apart/ Join

Drawing
Bezier
Freehand Drawing

Shapes

Rectangle

Oval

Registration Mark Tool
Measure Tool

Path Editing

Select Point Tool
Remove Point

Add Point
Straighten Path
Round Corner
Sharpen Corner
Optimize by Curve
Optimize by Smooth
Arc

Optimize by 3point Arc
Make Arc

Reduce Points
Close Path

Change Start Point
Cleaver

Expert

Apprentice

SignPal Instruction
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Scissors

Make Right Angle
Break Path

Join Paths

Align Horizontal
Align Vertical
Align Points
Apply Length and
Angle

Remove Tiny Objects
Vector Eraser
Cleaver by Path

Working with Files
Job Info

Scanning

Achieve to Cloud
Workspaces

View
DesignCentral
Color Mixer
Snap

Arrange

Group
Compound

Mask

Guides

Contour Cut
Convert to Outlines
Convert Stroke to
Outlines

Convert Linked to
Native

Path Direction
Order

Cut Order

SignPal Instruction
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Align . °
Spacing . o
Rotate ° °
Resize ° .
Deskew ° .
Mirror ° °
Step and Repeat °

Effects

Combine °

Outline o

Contour Cut ° .
Contour Cut Mark ° .
Shadow °

Bitmap

Autotrace °

Color Mode °

Production

Cut/Plot ° .
Manual Split Lines ° °
Tile All Copies o o
Panel to Border ° °
Auto-weld ° °
Auto-trap . °
Overcut ° .
Optimize Cutting Order o .

SignPal Instruction A-6
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Sure Cuts A Lot

There are basic instructions of Sure Cut A Lot below. If you need detailed instruction, please
refer to Sure Cut A Lot Help.

1. Select the cutter you want to output and change the work area.

M Run Sure Cuts A Lot software.

P T 2O ] | ==

Orientati

 Virsicn 41006
Gopyaight © 2014 (g Bigerint =+ === 0.,
All Rights Restrid

Supe utc

Show
Gridl

Subdiv

Workspa

Library

BUAN|[ON[BRNSe |79

-_ | EIEE) 6
-
- =2 Library e
L {03 4rrows (18) Z \;> Sﬂar
20 Bas snue(anﬂ il W \TE

M Select “Cutter” and select “Manage Cutters” under My Cutter to change the work
area.

File Edit Object Path Layer Page Effects Text View [Cutter| Window Help
Mat Size

Mat Qrientation
Preview Ctrl+Shift+P

Cut with GCC i-Cral

Cutter Settings...
v Cutter

Sure Cuts A Lot A-8
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S1GIJ Select company / brand as GCC and select model you want to output and then click
the “<--Add to list” button.

Qf‘ Manage My Cutters

Cutters you currently have added are listed below. To add an
to add another Brand/Model,

Cutters you currently have added are listed below. To add ano

to add another Brand,Model. s, : Add a Cutte
C
Add a Cutter P——- ompany/
Cutter .|'E
Compan !
GCC i-Craft R
¥ <— Ade

< Add

4 (LI} 3

M Select GCC on the left and click “Done.”

Cutters you currently have added are listed below. To add an

to add another Brand/Model,
Add a Cutte
Cutter
Compan
GCCi-Craft pany/
GCC I
<-- Adc

m If you want to change the material size and orientation, you can fill a proper value in
the Document window.

DOCTURENT

Mat Size: [12' x 127 ']

Crientation: ['M'Erﬁml {Portrait) v]

Units: |Inches v]
Show Grid
Grid Lines:  ©8.00in il
ivision: |
Subdivision: & &
Workspace Alpha:

Sure Cuts A Lot A-8
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2. Insert Graphics from Library

m Select grap

| #i ety

VFrl\e £dit Objactpsth Layer Page Effects Text View Cutter Window Help
A o BB el B EE
S —

Fage 1 ]
=, 5 e
=) e s | *
% | Vi
T, Kl Nu
& He
o ®0® j
’ oWe o

3 W
- S0 ® :
= [ Library

B Shapes
Z .3 —
o aEEE

5] Heart 4
e B Library - o= =3 2
- e [N
=NIE Daasacshapes(wH = S <_J 5

L= Qe A A sV asY o Vel aa)l 2

3. Draw Text

Click on the T icon at left side to create the text and select the font you like at text window.

|~ SureCutsAlot
File Edit Object Path Layer Page Effects Text View Cutter Window Help

AELE R m=zEEE

k TEXT
@® || 7 l:, View:
?EN Font:
R /
gb = Alignm
& |+ op
& |4 A
o

b Librai IEl it
E 6_ S}\ape:y at
T EEE alll =
P G*i BD Library - s ! J_l/-‘ PN ,\\ é
5 e, ] [ LOED
D ] ) Fall (12) B
e | B Ol 3R] o[£35 00 | an | QD) e
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4. Import Design

If you have created your design in other design software, go to “import” or “place image”
under file to import it, SCA supports svg, scut, scal, pdf, ai. wpc eps, bmp, gif, jpg and png
files.

[J‘ Sure Cuts A Lot 4: Untitl_

Edit Object Path Layer Page Eff

MNew Project Ctrl+N
Open Project Ctrl+0
Save Project Ctrl+5
er—— N
Import... Ctrl+Shift+1
| Export.. Ctrlf Shift+E
Trace Image... Ctrl+Shift+T

Place Image...

Scan2Cut...

FCM Batch Convert...

Send to 3

eshape Store...
Share Project...
Sync My Library...

Thousands of SVG files designed specifically for Sure Cuts A Lot!

V' http://SVGCuts.com is the top of source for designer SVG files for Sure
Cuts A Lot. Thousands of high quality elements including: shapes for
card-making, scrapbooking, as well as gift bags, boxes and 3D flowers.

Sure Cuts A Lot A-8
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5. Convert Image to Cutting File

m Go to Trace Image under File, or select Trace Image button on the toolbar to open
the setting window.

n— Edit Object Path Layer Page Effects Text View Cutter

Mew Project Ctrl+M
Open Project Ctrl+0
Save Project Ctrl+5
Save Project As... Ctrl+Shift+5
Import... Ctrl+Shift+I
| Export.. Cirll-Shift+£
TraceImage... Ctrl+Shift+T R R R
Flace Image...

M Click on “Choose an image” to input the image, adjust Image Settings and Output
Settings, and click OK. Then the outline of the image will be outputted automatically.

i;‘f'; Trace Image
Input Output
? [ show Modes MNodes:
?;:,.‘ Cat_girl_kids_cartoon.jpg Show Source Image: -

IE' (1779 x 1118)

Image Settings o
Mode: [Monochrome vl _

Contrast (0-100): " {} 194 £

[ ]

Qutput Settings

Smooth (0-100): 80 -

Detail (0-100): 98 &

Single Line Threshold: 0 jcal
™| /
—_ .- - — A =1 ' .
Note

v" The contrast and pixels of import images will affect the trace
image result. High contract graphics are recommended.

Sure Cuts A Lot A-8
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6. Cut the Design

m Click on the “Cutter” button on the toolbar and Cut Settings window will appear.

:F Sure Cuts A Lot 4 Untitled
File Edit Object Path Layer

Page

Effects Text View Cutter Window

& o ke

M Click on “Settings...” to open GCC Cutter Settings window.

lutter  WWindow

General E
GCC K 3
Model: ’Jaguar v \ "] [ Settings... ] 1
Connection: [USB v] :

4

Paort: ’{Auto Detect> v] [TestConnecﬁon] :
Cut Settings :
= = “

Note
v The origin point is on the bottom right.

SICT R Adjust Registration Marks setting under GCC Cutter Settings window if needed

CE-}GCC Cutter Settings

Registration Marks

Mark type: [4(TL,TR,BLER)  ~

Mark offset: 0,50 cm am

Marksize: 1.50an om

" B ) B
| YD
%%

*Registration Marks: set the distance between the edge of the material
and the registration marks in Mark Offset; set the size of marks in Mark
Size; set the line thickness of marks in Mark Thickness.

Mark thickness: 1,00 mm i

Sure Cuts A Lot A-8
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MAdjust Blade Offset, Overcut Value, Multi-Cut and Quality under Cut Settings window
if needed.

lutt Wind
General

GCC

Model: [Jaguar v - [ setings... |
Connection:  [UsB -

Port: | <Auto Detect> +| (@] [restcomnecton]
Cut Settings

Cut Mode:
[#] Use Software Speed and Pressure [ClmrrorH - [ Mirror v
End Action:

Preset: | Copy Paper -

Holder: |Regular Blade (0.25 mrf) -
[Blade/Pen Prompt -

Blade Offset: Overcut: | 0.0 (None) g
Multi-Cut: Quality: |Small Letter -

—— . n

*Blade Offset: set the offset value according to different blade, for a
standard blade, set the offset value at 0.25mm, 0.5mm for an optional
advanced blade and Omm for an optional plotting pen.

*Quality: associated with the cutting result; please note the better
cutting quality, the slower cutting speed.

*Multi-Cut: to repeat the cutting job at same position which is suitable
for cutting thick material.

*Overcut: allows for easier weeding and makes up for incomplete cut
lines.

L

A i
(™ / /

Sure Cuts A Lot

>
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M Under “Cut Settings” section, there are some useful functions. After setting the
parameters, click on “Cut” to send the data to the GCC cutter and the GCC cutter will
start the cutting job.

utter  Wind
General

GCC

Model: [Jaguar v

Connection: USEB

1 1 12 Port: ’dluto Detect>

Cut Settings
CutMode: | wWySIWYG -

Usze Software Speeil and Pressure

End Action: |Rewind to origin - Cut Mode: [WYSIWYG b

|Ize Software Speed and Pressure

Preset: ’Copy Paper

Holder: |Regular Blade (0.25mm) |
Blade/Pen Prompt
Preset: [(_Cush:am Preset =

leie Ofi=t: |28 o Cardstock (120b.)
Multi-Cut: | OfF - Haolde Cardstock (250lb.)
\ Cardstock (3500b.)

s e

*Cut Mode: there are “WSIWYG” and “Origin Point” options, WSIWYG
means what you see is what you get, the cutter will output the graphic
at same position in preview window. While with Origin Point mode, the
cutter will cut the graphic from bottom right origin point of the material.

*Use Software Speed and Pressure: tick this section, and you can set
the values of speed and pressure manually.

*Preset: select a proper material to apply the preset speed and
pressure parameter automatically.

*Speed & Pressure: you may adjust values of speed and pressure
manually to get quality results.

Sure Cuts A Lot A-8
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7. Print and Cut Your Design

The Print and Cut function allows you to print the graphics from Sure Cuts A Lot to printer,
and then put the printed materials on the GCC cutter to cut out the contour of printed jobs
from Sure Cuts A Lot.

M Open an image file in Sure Cuts A Lot.
2 sure Cus A Lot 4 Uit

File Edit Object Path Layer Page Effects Text View C

[0S0 N % el

M Click on the Cutter icon on the toolbar, set the parameters and click on “Print+Cut” to
add the registration marks and print out the image.

Cut Settings
GCC
I Model: [Jaguar v '] [ Settings... ]
Port: | <Auto Detect> ~] (@] [test Connection]
Cut Settings
[¥] Use Software Speed and Pressure [CiMirror 1 [T Mirror v
Preset: [Cop'y Paper ']
Holder: [R.egular Blade (0.25 mm) ']
[Blade)'Pen Prompt - ]
Blade Offset: Overcut:
Speed: — 15cmis

Sure Cuts A Lot A-8
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Si1 o] Click on “Print...” to open printer setting window and click OK.
Bl m ae - WD s |

.+~ Sure Cuts A Lot 4: Untitled
File Edit

Cutter  Window Help

Object Path Layer Page Effects Text View

EnHY . Registration Marks
: ERY: [Mlcmsoft XP2 Document Writer v] [ HET)... ]
S AR AE: B
=Rl Microsoft PS Document Writer
o fIF:  HPSPort
i il 3
FIENEEE [h=t:4
@ ER) {R8C):
4 B e[l 3L o e
Vi OEEERE 112 53 UL Seinos
7 [ cmod |
[ Print outlines only Preset: | Copy Paper
Frint registration mauks Holder: |Regular Blade (.25 mn
E‘ [ Print selection only X .‘"he"
} 'I_"'J"'nes Blade/Pen Prompt
Z - Blade Offsct:
E " = Multi-Cut: | Off v

M Print your design with registration marks out.

DRY
A
M Load the printed media to the GCC cutter.

M Press “Next” and then press “Scan+Cut”, and then the GCC cutter will detect the
registration marks and cut the contour lines automatically.

PRt andCnt Print and Cut
= Registration Marks f “ Registration Marks
Print and Cut —— Reg Marl
Registration Marks
(Auto Scan) Reg Marl Reg Marl
L RegMarl | , pasition the Carriage so that Reg Marl
This will guide you thrnu_gh R e M Bk pumatind
th.e S s e s registration mark at the top-
Print and Cut R
» If you have not already leghck seanout o star the
printed your design, click the i
Print button balow to print
with your printar.
' You must print using the
Print button below in order Use Software Force & Speed Use Software Force & Speed
to print your artwork with the
required Registration Marks. Preset: [< Custom Preset > - Preset: [< Custom Preset > 1
v Place the printed paper onto
the Cutting Mat and load it
into the cutting machine. Speed: - 1 Speed: - {1
you are ready to continue

Sure Cuts A Lot
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Test Connection function can save your materials.
v Click on “Test Connection” to exam if set the connection properly.

Genera
o 0-12 345 B
|| wos famern = |
Connection: [USE i l ;
'
Port: [{Auto Detect> "l :
Cut Settings ;
Cut Mode: [MSIW‘FG - ] :
lUse Software Speed and Pressure [Clmirror H [ Mirror v

End Action: |Rewind to orign = |

Preset: [CDDH' Paper ']
Holder: [Regulaf Blade (0.25 mm) "]

[EJadE!Pen Prompt v]

Blade Offset: Overcut: 0.0 (Nong) -

Speed: [ ~  15cm/fs

This will attempt to move the rollers or blade a short distance bac

If you do not see the rollers ar blade move, double check the cor
| make sure the cable is not loose and the power is turned an.

This test will not lower the blade and wil not cut anything.

Sure Cuts A Lot A-8
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8. Cut by color (*only available in RXIl and RXIlI(Creasing) model)

Cut by color is a function to set multiple parameters with 16 different colors in stroke of
graphic that can help easily to identify different job.

M Select “Cutter” and select “GCC RXII” under My Cutter to change the work area.

View  Cutter Window Help

Mat Size ¥
] IMat Orientation >
Preview Ctrl+Shift+P

Cut with GCC RXII

Cutter Settings..

312 73 AR > Manage Cutters...
: Tablet Connection... CEE
GCCi-Craft
T

M Select graphics from library to insert the selected design.

File Edit Object Path Layer Page Effects Text View Cutter Window Help

m BN Ve e ] O

DOCUMENT =] i
E T AL LS N A M L s A ~ 73
atsz:  |12'x12 v D
13 g
fa Orientation: |Vertical (Portrait) a
T Units: Cm v h g
‘ &
: Libr
ibrary
4 Shopes
/ t —_ .
@ S [i=]m
Six petal flower
= Er{] Library ~
- {2 Arrows (18)
Vs {121 Basic Shapes (44)
8 | Createinspain Desi
0 1 Fal (12
= {23 Game (12)
A {1 MichelleMyBelle Cre
% {2 Music (10)
i A et 1)
< >
O]
@
v
o < -
&
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S1«k Click the area you want to design and select pen color to designate stroke color for
setting parameter in the next step then clicks “OK”.

) | o

o

if Choose Pen Color / *
QOpac

e

Pen Set: | Standard Rt -]
B s i 3
. Red Opac
. Orange Wic

Yellow
; Je
: Light Green

:= R Mit
. Blue EndC

@ Click the [Z] button to open the Edit Presents window which shows the default
values by different materials. You can adjust the parameter and click “OK” to save the

changes.

File Edit Object Path Layer Page Effects Text View Cutter Window Help

# Edit Presets

— - e T
e et [Copy Paper E ~ I
) Holder: |R.eguia( Blade {0.25 mm) V| Style: |Normal "| D
Ti ﬂ‘: Cut cut lines b 4 @
i K 3
T‘ z: Blade Offset: |0.25 v Overat: |0.0(None) V‘ Cweld
| MutiCut: |OFf e Quaity: |SmallLetter v | Clipping:  Flonz = =
’ ;: Pressure: ] % g Cut Line Type: |Cut T‘ ﬁ
‘90_ Speed: 1 l;‘ 15 amys ’
B = 4
d Up Speed: ] Static AA
& :3: Preset: | Copy Paper W E -
= e
E e [ ] N
12
B D O N
3
JA
o
@
®
e
o
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M Click on the “Cutter” button on the toolbar to open Cut Settings window.

5 Sure Cuts A Lot 4: Untitled
File Edit Object Path Layer Page Effects Text Wiew Cutter Window =

M Click on the “Cut By Color” then click” Cut “button and cutter will to work.

Cut Settings
General Layers| CutBy Color (O} | (O} | Qg |
- [0 123 456 78 8 10 AT ASENA S T2 OREDRM -y
Fill color ~ ;
cut all colors {Single job) ~ 35
» W[® :

v [ ]

[ checkfunched: Al

Print+Cut Save to file | Cancel G Cut
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9. Creasing (*only available in RXIl (Creasing) model)

Equipped with the dual tool holders with creasing tool and blade, RX 1I-61 (Creasing) model
offers perfect creasing line and cutting result at one time for short run production in package
or custom products.

(PS. It's suggested to use the cardstock weight range from 200 to 350 gsm. The paper
weight may vary according to the type and thickness of paper being used.)

m Go to “Cutter” and select “GCC RXII-CR” under My Cutter to change the work area.

View  Cutter Window Help
Mat Size »
Mat Orientation »

Preview Ctrl+Shift+P

Cut with GCC RXII-CR
Cutter Settings..

— My Cutter ¥ IManage Cutters...
Tablet Connection... GCC
GCCi-Craft
GCC RXII

~  GCCRXI-CR

M Import your design or insert a graphic from library.

fle Edit Object Path Layer Page Effects Text View Cutter Window Help

A /b BIn e LBl o A

Handles: | Basic v|

B DOCUMENT B
0123458789 01RNIKIGTERNNZNNARZ N8N = 73
T T e T e P M e M A

Matsize: | 12"x 12° ~|

Orientaton: |Verbical Portrait) | $

Pe
3
= v e ]
g
it
i
2
% Library
iz
10 imges .
E
i 4 @8 lel
10
-1 Library ~
= {21 Arrows (18)

+{1) Basic Shapes (44)
Createinspain Desi

S | Createinspain
{£a Fal (12)
£ Game (12)
{13 MichelleMyBelle Cre
+-{23 Music (10)
(3 Newborn (15)
Py

BEEEUREERR
O e e

28 SEUNON DN No -390
33

Sure Cuts A Lot A-8



GCC.. Appendix

S1G] R Select the outline you want to crease and set the cut line type as “Draw(Pen)’and tool

as “2(left-Creasing)” for creasing. Then click the [Z] button to open the “Edit Presents”
window which shows the default values for creasing. You can adjust the parameter and click

“OK” to save the changes.

& Edit Presets %
Style: | Mormal e D
Freset: | Creasing = i Cweld
Holder: |pen {0.00 ram) ~ Clpping: (RIS (==
=il Cut Line Type:| |Draw (Pen) ~ ﬁ
Draw draw lines
Tool:| | 2 (eft-Creasing) et A
: : AA
[+] Prompt for pen color change Preset: |Creasing “|[£]
Multi-Cut: | OFF v Quality: | Small Lett
Pressure: | : 200
Speed: | L= 30
Up Speed: | Stz v

m Select the outline you want to cut and set the cut line type as “Cut” and tool as

“1(right)” for cutting. Then click the [Z] button to open the “Edit Presents” window which
shows the default values by different materials. You can adjust the parameter and click “OK”

to save the changes.

4 Edit Presets X
STYLE
10 1112 13 14 15 16 17 Preset [ s il |t ~
Holder: Regﬁ\ar Blade (0.25 mm) s | Style: | Normal = D
Cut cut lines ) *
Blade Offset: |0.25 ~ Overcut: | 0.0 (Mone) ~
Mit-Cut: |Off V| Quaty: [smallLetter ~ [ weid
Pressure: i < g Clipping: |MNone
Speed: | = 15anfs : : 5
UpSpeed: ] e Cut Line Type: | Cut e
Tool: | 1 (right) ~ g
canc AA
Preset: | Cardstock (2500b.) v
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M Click on the “Cutter” button on the toolbar to open Cut Settings window.

| Sure Cuts A Lot 4: Untitled
File Edit Object Path Layer Page Effects Text View Cutter Window alg

M Click on the “Layers” then click “Cut” button and cutter will start to work.

Cut Settings

General Llayers Cut By Color @ a @

0 123456 78 9101 12345161 A4

Use Layer Presets
Single job ~ | | Order by location “

IR N E Ao s oo

Preset: | < Default = «//1

Print+Cut Save to file | Cancel i Cut
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